The ONELAN Publisher Content Management System simplifies the creation, publication, and management of digital signage content. It enables multiple users to create and release content concurrently and supports simultaneous publication of numerous channels. With a browser-based user interface, the system is fully multilingual, including all main European and other languages.
# Table of Contents

## Part 1: Welcome to ONELAN Digital Signage

1.1 Overview .................................................................................................................. 9  
   1.1.1 Standalone Display ......................................................................................... 10  
   1.1.2 Multiple Displays ......................................................................................... 11  
   1.1.3 Multiple Channels ......................................................................................... 11  
1.2 Terms You Need to Know ....................................................................................... 13  
1.3 Logging On ............................................................................................................. 14  
1.4 Using the Web Interface ......................................................................................... 15

## Part 2: Creating Digital Signage

2.1 Using Schedules .................................................................................................... 23  
   2.1.1 Creating a Schedule ...................................................................................... 24  
   2.1.2 Schedule Entries ......................................................................................... 24  
   2.1.3 Overriding the Schedule .............................................................................. 27  
2.2 Using Layouts ....................................................................................................... 27  
   2.2.1 Manage Layout Page .................................................................................... 28  
   2.2.2 Adding a New Layout .................................................................................. 28  
   2.2.3 Editing a Layout ......................................................................................... 29  
   2.2.4 Layout Properties ....................................................................................... 29  
   2.2.5 Interaction Properties .................................................................................. 29  
2.3 Using Zones ......................................................................................................... 29  
   2.3.1 The Layout Editor ....................................................................................... 29  
   2.3.2 Editing a Zone .............................................................................................. 31  
   2.3.3 Editing a Zone's Properties ......................................................................... 32  
2.4 Using Playlists ...................................................................................................... 32  
   2.4.1 Adding Media Item Files to a Playlist ......................................................... 33  
   2.4.2 Adding Special Items to a Playlist ............................................................... 34  
   2.4.3 Adding Folders to a Playlist ....................................................................... 34

## Part 3: Understanding Media Types

3.1 Media Directly Managed by the CMS ................................................................... 37  
   3.1.1 Text ............................................................................................................... 37  
   3.1.2 Newsfeeds .................................................................................................... 38  
   3.1.3 Clocks .......................................................................................................... 39  
   3.1.4 Tables ......................................................................................................... 39  
   3.1.5 RS-232 Items .............................................................................................. 41
3.1.6 QR Codes ........................................................................................................... 41

3.2 Media Run from the CMS Disk ............................................................................. 41
  3.2.1 Uploading Content Files .................................................................................. 42
  3.2.2 Video .............................................................................................................. 44
  3.2.3 Text Files ........................................................................................................ 45
  3.2.4 Images and Photos .......................................................................................... 45
  3.2.5 Audio .............................................................................................................. 46
  3.2.6 Presentations .................................................................................................. 46
  3.2.7 HTML Web Pages .......................................................................................... 47
  3.2.8 Adobe Flash .................................................................................................... 48
  3.2.9 Folder Play ..................................................................................................... 48

3.3 Media from External Sources ............................................................................... 48
  3.3.1 TV .................................................................................................................. 49
  3.3.2 Radio ............................................................................................................. 49
  3.3.3 Live Video ..................................................................................................... 50
  3.3.4 Multicast Video .............................................................................................. 50
  3.3.5 External Web Pages ....................................................................................... 50

3.4 Media Item Properties ........................................................................................... 52
  3.4.1 Movie Properties ............................................................................................ 53
  3.4.2 HTML Properties ........................................................................................... 54
  3.4.3 Image Properties ............................................................................................ 55
  3.4.4 Text Properties ............................................................................................... 56
  3.4.5 Soundtrack Properties ................................................................................... 56
  3.4.6 Newsfeed Properties ...................................................................................... 57
  3.4.7 Clock Properties ............................................................................................. 58
  3.4.8 Folder Play Properties .................................................................................... 59
  3.4.9 Common Advanced Properties ..................................................................... 60
  3.4.10 Ad Hoc Properties ....................................................................................... 62

3.5 Playlist Commands ............................................................................................... 63
  3.5.1 Rendezvous Points and the Advance To Command ......................................... 63
  3.5.2 Change Layout Command ............................................................................. 64

3.6 Colours .................................................................................................................. 64

3.7 Fonts ..................................................................................................................... 65

Part 4: Enhancing Your Displays .................................................................................. 69

4.1 Synchronising Playlist Displays Between Zones .................................................. 69
  4.1.1 Automatic Captioning .................................................................................... 69
  4.1.2 Displaying Video-On-Demand Using a Sub-Playlist ....................................... 70

4.2 Using Interactivity .................................................................................................. 71
Part 5: Ad Hoc Content

5.1 Enhanced Ad Hoc Access Control ........................................ 80
5.2 Remote Keypad Control ................................................... 82
5.3 Additional Ad Hoc ............................................................ 83
5.4 Ad Hoc from Centre .......................................................... 85
5.5 Managing Ad Hoc Items ..................................................... 85
5.6 Creating Ad Hoc User Accounts ........................................... 86
5.7 Ad Hoc Pages ................................................................... 87
  5.7.1 Managing Ad Hoc Pages ................................................ 87
  5.7.2 Editing Ad Hoc Pages .................................................... 88
5.8 Ad Hoc Folder Play ............................................................ 88
5.9 Ad Hoc Media Folder ......................................................... 89
5.10 Changing Ad Hoc Content ................................................ 89
5.11 Ad Hoc Theming .............................................................. 91

Part 6: Sharing Content Using Layout Packages ......................... 95

6.1 Layout Packages .............................................................. 95
6.2 Creating a Layout Package ................................................ 95
6.3 Uploading and Installing a Layout Package .......................... 96
6.4 Layout Package Conflicts .................................................. 96
6.5 Layout Package Information .............................................. 97

Part 7: Channels and Signage Networks .................................... 101

7.1 Publishing ....................................................................... 102
  7.1.1 Publishing Mode and Policy .......................................... 102
  7.1.2 Configuring the Channel ............................................. 103
  7.1.3 Publishing a Channel .................................................. 105
  7.1.4 Multichannel Publishing ............................................. 106
  7.1.5 Managing Channels .................................................. 107
Part I
Welcome to ONELAN Digital Signage
Part 1: Welcome to ONELAN Digital Signage

Welcome to the Content Management System (CMS) user guide. Here you will find comprehensive information about how to create digital signage with the CMS and how to manage the CMS unit.

Find the subject you are looking for in the table of contents or in the PDF bookmarks. Track down the location of specific topics with the index at the end of the guide or by using the Adobe® Reader® search facility.

If you are new to ONELAN digital signage, you will find it helpful to read the Overview for an introduction to the fundamental concepts and components involved. Also familiarise yourself with the Terms You Need to Know before beginning to create digital signage content with the CMS.

Following that, you will be ready to check through the steps for Logging On to the CMS and Using the Web Interface. However, the more experienced may wish to go straight to the information about creating and controlling digital displays:

- **Creating a Schedule** – Getting started with designing and implementing your display.
- **Understanding Media Types** – Understanding the different types of content you can display and how the CMS manages them.

You can also find background Information on setting up and managing the CMS:

- **System Status** – Keeping your CMS running smoothly.
- **Setup** – Performing configuration and maintenance tasks.

### 1.1 Overview

To understand the fundamental concepts and components of a digital signage configuration, it is useful to start by describing a very simple arrangement with a standalone display. Building on that, further illustrations will add the extra features, including the CMS, that become increasingly relevant as your network grows more distributed and more sophisticated.

Work through the description of these examples in turn:

- **Standalone Display**
- **Multiple Displays**
- **Multiple Channels**
1.1.1 Standalone Display

The following diagram illustrates the simplest situation with a single display controlled by an individual. You might conceive of this as a screen displaying information in the foyer of a school:

![Diagram of Standalone Display](image)

Note the significance of the highlighted features in that scenario:

- **User** – The person controlling the screen content and its operation (that is, you).
- **Browser** – You exercise control through a web browser (such as Mozilla® Firefox® or Microsoft® Internet Explorer®). This remains the case for even the largest digital signage network.
- **Local area network, Intranet, or Internet** – In principle, you do not need to be physically close to the screen’s location. This becomes more significant as the size of the network increases.
- **Player** – **Player** is the generic term for the appliance that runs the screen. Specifically, the player is the ONELAN Net-Top-Box. The player has to be physically attached to the screen.
- **Display Screen** – The equipment that displays the content you have defined. You configure the player to display various media on selected areas of the screen at chosen times.

As you might expect, additional features are needed to support a network that includes Multiple Displays.
1.1.2 Multiple Displays

The following diagram illustrates a more fully-featured situation where a user controls several players and their screens. You might conceive of this as a set of screens displaying sales information on the floors of a shop. In practice, the number of players would be much higher, which is why it is desirable – and soon necessary – to add further components to the network:

You can see that certain features are the same: the user, the browser, and the network. Note now the significance of the additional features, discussed clockwise as they appear:

- **Publisher** – A Publisher is a system you configure to provide content to multiple players. This enables you to display consistent content on several screens and means you only need update it in one place. Although some player models can perform this role, in our context the publisher is specifically the ONELAN Content Management System.

- **Channel** – A Channel refers to both the content it contains and its originating publisher. The Channel Name (in this case 'Channel 1') identifies the channel and is often just the name of the publisher.

- **Subscriber** – A Subscriber is a player that you configure to accept content from a publisher. In the diagram, Channel 1 provides the content for all the subscriber players and their screens. Subscriber and Publisher are referred to as Roles (the only other role is Standalone, which is the role of the player in the first diagram).

You can build on the parts already described to create a network not only of multiple displays but also of Multiple Channels.

1.1.3 Multiple Channels

When your signage network grows to a large number of players and their screens, the quantity and variety of content you need to manage and distribute grows accordingly.

Once again, it is useful to envision the key components in a condensed and summarised form.
The following diagram shows how the individual network features we have discussed so far combine to provide a network infrastructure of multiple displays and multiple channels. You might conceive of this as a multisite business with sites in different cities, maintaining a resilient network of players displaying various streams of content, and all under centralised control:

Notice how the by-now familiar components operate in combination:

- At the centre, you create and manage the flow of content for the network through your web browser.
- The CMS publishes content over multiple channels. You configure as many as you need to serve the needs of the business, up to a maximum of 50.
- Multiple subscriber players display content from whichever channel you designate appropriate to their function. For example, the content could be subject-based if the display is for a particular department or could be locale-based if the display is for a particular city.
- How you group the subscriber players is up to you: you can have numerous players displaying common content.

That picture is deliberately simplified to illustrate the essential components of a large network. Therefore, it is worth emphasising that the CMS can readily scale up to manage the content for even complex digital signage networks. For example, the CMS allows you to set a bandwidth limit on a per-port basis, thereby prioritising quality of service for different purposes (see the HTTP service settings description in Firewall for more details).

This is not to say the CMS alone can provide everything required for more specialist configurations. You may need to add a Channel Content Server (CCS) to assist content processing if you have specific network topology requirements (see Channel Content Servers for more details).
Having now considered the background terms and concepts of the digital signage network, the next step is to understand how to compose the content that you will publish through the CMS. Begin by reading the Terms You Need to Know.

### 1.2 Terms You Need to Know

The CMS provides powerful facilities to help you to design, structure, and control sophisticated and effective content display.

To understand how you use the CMS to manage display of content, it is important to understand how certain key features relate to each other.

The following diagram illustrates the critical relationships between Schedules, Layouts, Zones, and Playlists:

- A **Schedule**: ![Diagram](image1.png)
  - ...shows a **Layout**: ![Diagram](image2.png)
  - ...made of **Zones**: ![Diagram](image3.png)
  - ...each running a **Playlist**: ![Diagram](image4.png)

To flesh out how those relationships work, consider each of those key features in turn.

**Schedule**

The player is designed to run continuously. You control which **Layouts** are displayed on what days and at which times by creating a **Schedule**. The schedule may be something like this:

- Layout A runs from 4.00 pm to 6.00 pm, Mondays to Fridays.
- Layout B runs from 2.00 pm to 8.00 pm, Saturdays and Sundays.
- Layout C runs at all other times, throughout the week.

**Layout**

A **Layout** is the arrangement of individual display areas, known as **Zones**, that you use to compose your on-screen display. Your layout might display video in one zone, scrolling text in another, a sequence of still images in a third zone, with a full-screen zone behind the others showing a background colour or image.
Zones

Zones are rectangular areas, each of which can display various forms of content (known as media items). You can design layouts with any number of zones, of any size, in any location, either separate or overlapping. You specify which zones display which media types (for example, one for a promotional video, one for scrolling text, another for your organisation's name or logo, and so on). You can also have zones display a mix of media types. You arrange the media items for each zone in a Playlist.

Playlist

A Playlist contains one or several media items that you choose to display in a zone. Media items include fixed and scrolling text, movies, images, Adobe® Flash® animations, web pages, and newsfeeds. To display a media item, you add it to the playlist. Each zone has its own favourite playlist, which runs continuously. You can also synchronise the display between two playlists (for example, to run a scrolling text message at the same time as a related promotional video or image.

That examination of the key features gives a flavour of how you put together your signage display content for a single player. However, as we have seen, using the CMS you can also easily provide the same content for groups of players by publishing through one or more channels.

You can also allow people local to the subscriber players to have a degree of control over the content the player displays. The material and features that you allow local users to modify is called Ad Hoc content and they are called Ad Hoc Users.

That brief survey of the key terms provides the foundation to start using the CMS. Other sections introduce and describe additional terms and concepts as needed. An extensive Glossary provides definitions of the core CMS terminology.

But now, to consider further how to use schedules, layouts, zones, and playlists to create your digital signage, refer to Creating Digital Signage.

1.3 Logging On

During the login process, you will need to provide the IP address of your CMS. Make a note of this before you begin. If you do not know the IP address, restart the CMS: it displays its IP address above the progress bar towards the end of the boot sequence.

Follow these steps to log in to your CMS:

1. Ensure that the CMS is connected to the network.
2. Open a web browser (such as Mozilla® Firefox® or Microsoft® Internet Explorer®) on a computer on the same network as the CMS.
3. In your browser's address bar, type in the IP address of your CMS and click the 'go to' arrow or press the Enter key.
4. When prompted, enter the username and password. The factory-set defaults for these are remote and 9999 respectively. Your CMS displays its Home page

Security: It is strongly recommended that you change the remote account password from the factory default as soon as possible. Also change the CMS master password and check that the security services configuration matches your requirements (see Security – General Settings for details).
That connection is secured by HTTP digest authentication, which encrypts the password. However, you should consider adopting form-based authentication as it can be configured to give stronger security. Form-based authentication also provides an explicit sign out when you want to end your session on the CMS.

**Important:** If you use form-based authentication, you will need to provide a valid SSL certificate (as described below). It is possible to access the CMS without a valid certificate, but your browser will at first block you and warn that the connection is untrustworthy or that there is a problem with security.

To configure form-based authentication, follow these steps:

1. On the menu bar, click **Setup** and select **System** and **Security**.
2. Click the **Firewall** tab.
3. In the **HTTP Service Settings** panel, from the **Authentication** drop-down menu, select **Form-based Authentication**.
4. From the **Supported Protocols** drop-down menu, select **HTTPS**.
5. Click the **Save Security Settings** button (ignore the prompt to reboot the CMS).
6. Click the **SSL Certificates** tab.
7. Select **Use Custom SSL Certificates for Web Server**.
8. Complete the certificate details and click the **Save Changes** button.
9. Click the prompt to reboot the CMS.

When you next access the CMS, you will need to do so using the HTTPS protocol. Your username and password will be as before. To sign out of your session, click the **Sign out** prompt at the top right of the CMS display.

For the future, you might want to bookmark the **Home** page or add it to your favourites for easier access. If your network is set up to provide DHCP and DNS support, you can also access the CMS using its name rather than its IP address: the name is automatically generated in the format **CMSserial**, where **serial** is the serial number of your CMS (for example, CMS123456).

The CMS comes ready-installed with a number of sample displays and you might find those useful to illustrate the kinds of features you can implement.

If you need assistance at any time, click **Help** on the menu bar to access page-specific help or to navigate to any other help page.

You can now begin to become familiar with the CMS user interface.

### 1.4 Using the Web Interface

You control and manage the CMS through your browser using the web-style pages of the CMS user interface.

You should familiarise yourself with the essential features of the user interface before beginning to use the CMS. Most important is the main **Home** page but you should also be aware of the generic navigation and command features employed on other pages. What follows is a tour of the **Home** page followed by descriptions of those generic features.
The Home Page

This is the first page you see after logging onto the CMS. At its heart is this view of the current state of the CMS, showing a summary of its operational status:

That summary is made up of **Status Bars**.

**Status Bars**

These indicate the status of key CMS operational components. Each status bar has this general appearance:

The features to note are:

- Open/close arrow – Click the ▶ arrow to reveal more details. Click the ▼ arrow to reduce the detail.
- Name – The subject of the status report (in the above case the subject is the **Network**).
- Status summary – The colour of the status bar icon indicates the current status (in the above case, the network status is good).

Here are status bars that respectively indicate attention needed and problem detected:

If you click the open arrow on an attention or problem status bar, the CMS provides a description of the problem in the information revealed. To take corrective action, click on the appropriate button to open the relevant page in the interface.
In general, opening a status bar provides you with additional information about the subject area, with a selection of buttons to take you to the relevant pages in the user interface. For example, opening the **System** status bar reveals details about the CMS system state:

Most pertinently for your use of the CMS, opening the **Channels** status bar reveals a summary of the channels you have published:

As you can see, because of its importance, the CMS allocates half of the **Home** page display to the **Channels** status summary. The CMS displays this information:

- **Name** – The name of the channel.
- **Status** – The latest publication status of the channel. When a channel starts publishing, the CMS highlights this with ![publishing...](#) and then with ![publishing...](#) as the process progresses.
- **Version** – Indicates the minimum software version the player needs to display the channel's content.

To access detailed information on the channels, click the ![Status:](#) button to open the **Manage Channels** page.

**Generic Features: The Menu Bar**

The menu bar appears on every page of the user interface. It allows you to navigate to the page you need to perform detailed actions. Broadly speaking, each page corresponds to a particular feature such as:

- Layout design
- Playlist creation
- Channel publishing
- Managing user accounts
Part 1: Welcome to ONELAN Digital Signage

The menu bar offers these top-level options (you may see fewer options depending on your configuration):

<table>
<thead>
<tr>
<th>Home</th>
<th>Media</th>
<th>Playlist</th>
<th>Layouts</th>
<th>Schedules</th>
<th>Channels</th>
<th>Ad hoc Entry</th>
<th>Status</th>
<th>Setup</th>
<th>Help</th>
</tr>
</thead>
</table>

The relevant explanatory sections describe those options in detail. You can also change how you interact with the menu bar on the Help > UI Options page. Some CMS features are only available if you enable the Detailed or Expert option on the UI Options page. Restrictions may also apply if your CMS hardware components and capabilities do not support certain functions or if you do not have the requisite software licenses.

To speed your access to important pages and information, the right-hand side of the menu bar includes a selection of icons. Click the icon to access the following:

- The Home page.
- The Manage Channels page.
- The Manage Layouts page.
- The Setup icons page.

An additional icon indicates the system status and can be one of:

- Confirms there are no known issues.
- Brief description of an attention item (only shown if one is active).
- Brief description of a problem item (only shown if one is active).

**Note:** The CMS does not display the quick access icons if your PC screen is too small or you have restricted the size of the browser window.

**Generic Features: Tabbed Pages**

Many options in the CMS user interface are split across tabbed pages:

To access the options on the tabbed page, click the tab label (for example, Add Schedule).

**Generic Features: Action Buttons**

Numerous actions are common across different CMS pages. The user interface indicates these with icon action buttons. Click the button to perform the indicated action:

- Delete
- Rename
- Copy
- Edit
- Drag to reorder
Generic Features: Command Buttons

Some commands are common across different CMS pages. The user interface provides command buttons for these. To execute the command, click the button. The label on the button describes the command, such as [Save Changes] or [Edit].
Part II

Creating Digital Signage
Part 2: Creating Digital Signage

This section describes how to create your digital signs. If you are new to the CMS see Terms You Need to Know before you begin.

Click on the links below for more information on:

Using Schedules
Using Layouts
Using Zones
Using Playlists
Understanding Media Types
Enhancing Your Displays

2.1 Using Schedules

The player units are designed to run continuously. You control which layouts are displayed on what days and at what times by creating a Schedule for each channel. A schedule always contains at least one Schedule Entry, which defines at least one player action (often, which layout to display). A schedule entry does not necessarily specify a layout change, it could specify some other action (for example, switching the audio to mute).

The schedule entries define periods of time during which actions occur. The programme of schedule entries is based on a one-week cycle. The Default Schedule Entry defines the layout that appears, or the actions that occur, when no other schedule entry is active.

The player always displays the schedule with the most recent start time. Once a schedule starts running it continues until another schedule is set to begin. If there is only one schedule it runs indefinitely.

An example schedule might contain schedule entries taking these actions:

- Playing layout X from 4:00 pm to 6:00 pm, Mondays to Fridays.
- Playing layout Y from 2:00 pm to 8:00 pm on Saturdays and Sundays.
- The default schedule entry, playing layout Z at all other times.

You can temporarily interrupt a schedule by using a Schedule Override.

To access the schedules configured for a channel on the CMS:

1. On the menu bar, click Schedules.
2. Select the relevant channel from the drop-down list.
3. Click Manage Schedules.

There are these action buttons for each schedule:

- Delete the schedule (does not delete the associated layouts).
- Copy the schedule.
- Edit the schedule.

To create a new schedule, click the Add Schedule tab.
2.1.1 Creating a Schedule

To display content on your player units, you need to create at least one channel with its associated schedule. You add schedule entries to a schedule to fine tune how the player runs it.

To create a new schedule:
1. On the menu bar, click Schedules.
2. Select the channel from the drop-down list.
3. Click Manage Schedules.
4. Click the Add Schedule tab.

To create the new schedule, complete the following details and click the Add Schedule button:

<table>
<thead>
<tr>
<th>Schedule Name</th>
<th>Enter a unique name for the schedule.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid From</td>
<td>Select the date and time when the player starts running the schedule (the default is in 24 hours time).</td>
</tr>
<tr>
<td>Valid Until</td>
<td>Select the option that matches your requirement:</td>
</tr>
<tr>
<td></td>
<td>• Superseded – The player keeps playing this schedule until a more eligible schedule becomes available.</td>
</tr>
<tr>
<td></td>
<td>• Date – The player keeps playing this schedule until the date and time you choose. It then plays the next eligible schedule. If the player cannot find an eligible schedule, it continues to play this one.</td>
</tr>
<tr>
<td>Show Layout</td>
<td>Select the layout to display.</td>
</tr>
<tr>
<td>Conditional Play</td>
<td>This is only enabled when you have added Player Local Information (PLI) to the player (see Player Local Information for details).</td>
</tr>
<tr>
<td></td>
<td>If it is enabled, you have two options:</td>
</tr>
<tr>
<td></td>
<td>• Play Always – Default. The player always plays the schedule.</td>
</tr>
<tr>
<td></td>
<td>• Play if Player Local Information Item – The player only plays the schedule if certain conditions are met.</td>
</tr>
<tr>
<td></td>
<td>If you select Play if Player Local Information Item, complete these steps:</td>
</tr>
<tr>
<td></td>
<td>1. Select the name of the relevant player local information from the first drop-down list.</td>
</tr>
<tr>
<td></td>
<td>2. Select the test to apply from the second drop-down list.</td>
</tr>
<tr>
<td></td>
<td>3. Enter the value to test for in the final field (add further values by clicking the button or delete values by clicking the button).</td>
</tr>
</tbody>
</table>

2.1.2 Schedule Entries

A schedule entry is a set of one or more actions for the player to perform at specified times. Schedule entries repeat over a weekly cycle and a programme of schedule entries make up a schedule.

Use schedule entries to specify these actions:
• Displaying a layout.
• Switching a screen on or off.
Switching audio on or off.
Performing Advance To commands.

Whenever you create a new schedule, the CMS automatically includes a **Default Schedule Entry**. The default schedule entry has no start and end time and defines the default states when no other entry is active.

Schedule entries allow you to direct your player to perform simple or highly sophisticated sequences of actions. You can have the player display different layouts at different times of the day and different days of the week, switch the display on and off, or repeat actions at specified intervals.

To illustrate the use of schedule entries in more detail, here is a worked example.

With the following schedule, made up of three schedule entries, the player will:
- Turn the screen on to show the **Showroom** layout from 08:45 until 18:00 on Mondays to Fridays.
- Display the **Active** layout (carrying a news broadcast) for 10 minutes every hour.
- Turn the screen off at all other times.

Looking at the respective settings on the **Add Schedule Entry** tab reveals how you would go about specifying each of those schedule entries.

The first schedule entry causes the player to turn the screen off and mute the audio soundtrack (note that the **Showroom** layout plays even though the screen is off):
Part 2: Creating Digital Signage

The second schedule entry causes the player to turn the screen on and play the **Showroom** layout:

![Schedule Entry](image)

The third schedule entry causes the player to change to the **Active** layout for 10 minutes every hour:

![Schedule Entry](image)

To create a new schedule entry, click the **Add Schedule Entry** tab, complete the following details, and click the **Save Changes** button:

| **From** | Select the time range during which you want the player to apply the schedule entry. 00:00:00 means midnight. Set both From and Until to midnight for the player to run the schedule entry all day. For a period that runs through midnight, add separate schedule entries: one ending at midnight, one commencing from midnight. |
| **On** | Check the boxes for the days you want the player to play the schedule entry. |
| **Repeat** | Choose the option that matches your requirement:  
  - **Perform actions for the entire period** – The player performs the actions all of the time.  
  - **During the period, only perform actions** – The player performs the actions only when and for as long as you specify. Specify the regularity with the Every options and the duration with the for options. The Every setting must be at least 30 seconds longer than the for setting. The minimum for setting is 30 seconds. |
Ad hoc

This is only enabled when you have added ad hoc schedule items to the CMS (see Managing Ad Hoc Pages for details).

Check the User can override From, On and Repeat settings using Ad hoc Schedule Item box to allow ad hoc users to alter those time settings.

<table>
<thead>
<tr>
<th>Actions</th>
<th>Check the boxes and select the required action you want the player to perform:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Audio – Unmute or mute the display's sound.</td>
</tr>
<tr>
<td></td>
<td>• Screen – Turn the screen on or off.</td>
</tr>
<tr>
<td></td>
<td>• Layout – Display the selected layout.</td>
</tr>
<tr>
<td></td>
<td>• Advance To – Play the next item in the zones containing the selected rendezvous point.</td>
</tr>
</tbody>
</table>

Modify a schedule entry by clicking the button next to it on the Schedule tab.

2.1.3 Overriding the Schedule

You may need to override the current schedule at certain times (for example, to show a special event from a TV broadcast feed). You can create a Schedule Override which temporarily replaces the current schedule. The player stops playing the current schedule and displays a different layout.

To create a schedule override, follow these steps.
1. On the menu bar, click Schedules.
2. Select the channel from the drop-down list.
3. Click Manage Overrides.
4. Click the Add Override tab.
5. Enter a name for the override. Use a descriptive name (for example, 'Emergency Instructions').
6. Select what you want the player to do with audio and the screen.
7. Choose a layout for the player to display.
8. Click the button.

2.2 Using Layouts

A layout is an arrangement of various display areas, called zones. Your layout may include video in one zone, scrolling text in another zone, and a sequence of still images in a third zone. You may also have a zone that is the same size as the layout and contains a background image on which all the other zones are superimposed. Your audience sees everything in your layout, so you need to take care to design layouts that are appealing and effective.

By default, the CMS names the zones for each layout on the screen in the order in which they were created – zone A, B, C and so on. To help manage the zones, you can change the names to make them more descriptive (for example, 'Background' or 'Main Video'). You can change the relative display positions of the zones in a layout.

Each zone can display media items of different types, according to the media player or players you enable for the zone.

The CMS screen background is visible in any part of the layout that is not covered by a zone. You can define the colour or image for the screen background independently of any layout.
2.2.1 Manage Layout Page

The **Layouts > Manage Layouts** page shows all the layouts available on this CMS.

For each layout, the CMS displays:
- A diagram of the layout’s zones.
- The name and description of the layout.
- If applicable, the names of the schedules and channels that use the layout.
- The canvas size required for the layout.
- The names of any rendezvous points or **Change Layout** commands.
- A link to the layout’s Ad hoc Page.

Additionally, the CMS displays an audio icon if you enable a soundtrack and a touch-screen icon if you enable interactivity. Click on the icon to edit those properties.

Click the layout name (or the thumbnail) to open the graphical layout editor or to access the layout's properties. Click a zone in the layout diagram to open the zone's playlist.

The CMS provides the following action buttons for each layout:
- ![Delete](image) – Delete the layout (you cannot delete a layout referenced by a schedule, even if inactive).
- ![Rename](image) – Rename the layout.
- ![Copy](image) – Copy the layout.
- ![Edit](image) – Edit the playlists for the layout’s zones or edit the layout itself.

To reduce the number of layouts displayed, follow these steps:
1. Click the ![Filter](image) button.
2. Enter all or part of the layout’s name.
3. Click the ![Apply](image) button.

To clear a filter, click the ![Show All](image) button.

2.2.2 Adding a New Layout

To add a new layout, follow these steps:
1. On the menu bar, select **Layouts** then **Manage Layouts**.
2. Click the **Add Layout** tab.
3. Enter a name for the new layout and its overall width and height.
4. Click the **Add** button
5. Click the **Edit** button next to your new layout in the layouts list to open the graphical layout editor.
6. Add and set the properties for the zones you require.
7. When done, click **Save** and **Save all changes**.
You can return to and edit your layout whenever you wish.

### 2.2.3 Editing a Layout

To edit a layout, click on its name or thumbnail on the **Layouts > Manage Layouts** page.

The layout's page has these tabs:

- **Zones** – Displays the graphical layout editor for you to add or modify zones and their properties.
- **Layout Properties** – Displays the Ad Hoc Page and Soundtrack options for you to enable or disable.
- **Interaction** – Displays the interactivity options for you to configure.

### 2.2.4 Layout Properties

The **Layout Properties** tab allows you to configure the following details (when complete, click the ![Save all changes](button):

<table>
<thead>
<tr>
<th>Description</th>
<th>Optional. Enter a description of the layout. The CMS displays this on the Layout pages underneath the layout's name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout Ad hoc Page</td>
<td>Check this box and the CMS will automatically create an ad hoc page if you add ad hoc items to this layout. If you add or remove ad hoc items, the CMS will add or remove them from that ad hoc page. If you delete all ad hoc items, the CMS deletes the ad hoc page.</td>
</tr>
<tr>
<td>Soundtrack</td>
<td>Check the Include Soundtrack box to enable a soundtrack for this layout. By default, the CMS checks the Add default media to Soundtrack’s Playlist box. This means that the CMS will play the default soundtrack media. If you uncheck that box, you will need to add a media file by opening the Soundtrack item in the layout's Playlist menu.</td>
</tr>
</tbody>
</table>

### 2.2.5 Interaction Properties

The **Interaction** tab allows you to define how the layout responds to touch screen and general purpose input/output events.

**Note:** The player may require a license to use these options.

See **Using Interactivity** for details on designing and implementing interactive responses.

### 2.3 Using Zones

You compose layouts from defined rectangular areas called zones. Each zone can display various types of media content. The number of zones in your layout, their size, and location is up to you.

It is common to use different zones to display different types of content (for example, one for scrolling text, one for a promotional video, and so on). However, any zone can display any media type: you just have to enable the zone with the appropriate media player. You can have a zone display a single item or a sequence of items. You define the items that a zone displays in a playlist.

#### 2.3.1 The Layout Editor

To create and manage the zones in a layout, you use the graphical layout editor. To edit a layout, click on its name or thumbnail on the **Layouts > Manage Layouts** page.
The Zones tab provides the graphical editor that you use to adjust the position and size of each zone in your layout:

![Graphical Editor](image)

By default, the editor displays the layout at 75% of the currently defined screen resolution (not the monitor of your PC). You can change this by using the drop-down list at the top of the page.

The editor displays each zone in a colour indicating the media player enabled for the zone:

- Red – Movie player (zone B)
- Light green – HTML player (zone E).
- Light blue – Image player (zone D).
- Yellow – Text player (zone C).

**Note:** The display shows the zones with a slight transparency (for example, to aid in aligning with background images). This does not indicate how the zone appears when displayed on screen.

To select a zone, click it. The editor shows the selected zone with handles (as seen for zone E). To move the zone, drag-and-drop it. To resize the zone, drag one of the handles.
You can also right-click a zone to open a context menu containing common functions:

<table>
<thead>
<tr>
<th>Move to Front</th>
<th>Move to Back</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make Full Screen</td>
<td>Delete</td>
</tr>
<tr>
<td>Save all changes</td>
<td>Edit overlapping</td>
</tr>
</tbody>
</table>

When you have finished making changes to your zones, click the ▼ Save ▼ button. This offers these options:

- ▼ Save all changes ▼ – Simply saves your layout changes.
- ▼ Save all changes and edit Playlist ▼ – Saves your layout changes and opens the playlist for you to edit it.

### 2.3.2 Editing a Zone

The Zones tab includes these buttons:

- ☰ Add Zone ▼ – Click to add a zone to the layout. The CMS adds the zone for you to start sizing and positioning it.
- ☰ SelectZone ▼ – Click to display a list of all zones in the current layout.
- ☰ Zone Properties ▼ – Click to toggle the Zone Properties dialog off and on. The CMS displays the toolbar for the currently selected zone.
- ☰ Save ▼ – Click to select the Save options.

The ▼ SelectZone ▼ and ▼ Zone Properties ▼ buttons provide the detailed editing features. Click the ▼ SelectZone ▼ button to open a list like this:

The list highlights the currently selected zone (in this case, zone B).

Perform the following actions with the Select Zone features:

- Click the ▼ button to delete a zone.
- Click the ▼ Edit ▼ button to select the zone you want to size and position. This includes zones hidden by other zones.
Part 2: Creating Digital Signage

- Change the zone order by dragging-and-dropping the icon. This is the zone order in layers (for example, moving the 'Background' image to the back of the layout).

Close the Select Zone list by clicking its button again or clicking elsewhere on the page.

2.3.3 Editing a Zone’s Properties

Click the button to open its dialog:

You can move the dialog around the screen by dragging it by its title bar. Close the dialog by clicking its button or by clicking the button again.

You can access and configure the properties by selecting the appropriate tab and entering the values required:

<table>
<thead>
<tr>
<th>Zone</th>
<th>Choose from the following options:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Zone Name – Optional. Enter a descriptive name for the zone. The CMS shows this name when you are on a zone-specific page (such as in its playlist).</td>
</tr>
<tr>
<td></td>
<td>• Media – Check the relevant box or boxes to enable the zone to play that media type.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Size &amp; Position</th>
<th>Size and position the zone by entering specific values.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Top, Bottom, Left, and Right Edge Offsets – The CMS offsets the position of the zone relative to the edge of the screen.</td>
</tr>
<tr>
<td></td>
<td>• Width – Exact width for the zone.</td>
</tr>
<tr>
<td></td>
<td>• Height – Exact height for the zone.</td>
</tr>
<tr>
<td></td>
<td>• Aspect Ratio – Use to automatically size the zone depending on the aspect ratio of its content. Only available if you use pixels for Width and Height and do not select the Specify custom width and height option. First, select the type of aspect ratio needed from the drop-down list. Second, select whether the CMS calculates the required zone size keyed to the height or to the width.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Properties</th>
<th>Check the box or boxes to enable the options required:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image</td>
<td>• Image – If you have enabled the zone to show images, check this box to see the first item in the playlist in the layout editor (instead of the standard coloured area). This helps preview the image and align other zones to it.</td>
</tr>
<tr>
<td>Design Visibility</td>
<td>• Design Visibility – Uncheck this box so that the zone is not shown in thumbnail views. This helps to edit other zones that are overlapped by this zone.</td>
</tr>
<tr>
<td>Media Audit</td>
<td>• Media Audit – Check this box to enable media audit reporting for the zone. You can override this on an item-by-item basis in the playlist. See Reporting for more details on reporting.</td>
</tr>
</tbody>
</table>

2.4 Using Playlists

A playlist is a sequence of media items that you choose for display in a zone. Each zone has its own playlist and runs independently of other playlists. A soundtrack also has its own playlist.
Playlists play their content in a continuous loop. After the player plays the last item, it starts again with the first.

You can include the following in a playlist:

- Individual content files (such as images, movies, or text).
- Folders containing multiple items.
- Special Items (such as newsfeeds, TV stations, and tables).
- Ad hoc Items (controlled by your local users).

To add or modify items in a playlist, you need to access its specific page. Use one of these methods to access a playlist’s page:

- On the menu bar, click **Playlists** and select the zone from the relevant layout.
- On the menu bar, click **Layouts > Manage Layouts** and click on the zone in the relevant layout diagram.

The playlist page has these tabs:

- **Playlist** – Lists the items in the playlist (displays their type, media details, and play duration).
- **Files & Folders** – Lists the folders containing media items you can add to the playlist (also use to navigate between folders and move files between folders). You can also add a whole folder to a playlist. See Media Run from the CMS Disk for more information.
- **Upload Files** – Use to copy files onto the CMS and to create new folders. See Uploading Content Files for more information.
- **Specials** – Use to add special items to the playlist (items other than files and folders). See Adding Special Items to a Playlist for more information.
- **Defaults** – Use to set the default properties for media items when you first add them to the playlist. Changing a default value does not affect items already in the playlist.

The CMS provides the following action buttons for each item in a playlist:

- ![Trashcan](image) – Move the item (by drag-and-drop).
- ![Trashcan](image) – Delete an item.
- ![Edit](image) – Edit an item’s properties.

### 2.4.1 Adding Media Item Files to a Playlist

Before you can add a media item file to a playlist, you need to upload it to the CMS. You must have enabled the zone to play the type of media you want to add to the playlist.

To add a file to a playlist, open the playlist page and follow these steps:

1. Click the **Files & Folders** tab.
2. Click the name of the folder containing the file.
3. Click the **Add** button alongside the file you want to add.
4. Click the **Playlist** tab to view the updated playlist.
5. Perform any other required actions (for example, adjusting the play order or modifying the item properties).
2.4.2 Adding Special Items to a Playlist

You can add special items to a playlist if supported by your CMS and the media you have enabled the zone to play.

There are two groups of special items:
- Those you need to set up in advance.
- Those you do not need to set up in advance.

The special items you need to set up in advance are:
- Video (including TV stations).
- Newsfeeds.
- Tables.

The special items you do not need to set up in advance are:
- Clocks.
- Direct text.
- External web pages.
- QR Codes.
- Interactivity actions.
- The Wait, Rendezvous Point, Advance To, and Change Layout commands.

To add a special item to a playlist, open the playlist page and follow these steps:
1. Click the Specials tab.
2. Click the button alongside the item you want to add. (Depending on the item, you may need to enter text or select properties first.)
3. Click the Playlist tab to view the updated playlist.
4. Perform any other required actions (for example, adjusting the play order or modifying the item properties).

2.4.3 Adding Folders to a Playlist

You can add a whole folder to a playlist. The player treats the folder as a single playlist item but plays the files within it individually.

Before you add it, ensure that the folder contains the media items you want to use.

To add a folder to a playlist, open the playlist page and follow these steps:
1. Click the Files & Folders tab.
2. Click the button alongside the folder you want to add.
3. Click the Playlist tab to view the updated playlist.
4. Perform any other required actions (see Folder Play Properties for information on customising how the player plays the folder items).
Part III

Understanding Media Types
Part 3: Understanding Media Types

Your player units can display a great many types of digital content (also referred to as media).

When creating a layout, you must specify the type of media each zone will display. This enables the zone to 'play' the media concerned. You can configure zones to support one or more of these players:

- **Movie** player – For media such as video and TV.
- **HTML** player – For media such as web pages and tables.
- **Image** player – For media such as graphics and photographs.
- **Text** player – For media such as text and newsfeeds.

In addition to those media types, you can add audio to a layout using the Soundtrack feature (see Audio and Radio for more details).

The CMS provides many features for setting up and managing the media items you want to use. It is important to understand how the CMS handles groups of media differently depending on their types and characteristics:

- **Media Directly Managed by the CMS** (includes text, newsfeeds, clocks, tables, RS-232 outputs, and QR Codes).
- **Media Run from the CMS Disk** (includes video, text files, images and photos, audio, presentations, HTML web pages, Adobe Flash files, and folder play).
- **Media from External Sources** (includes TV, radio, live video, multicast video, and external web pages).

3.1 Media Directly Managed by the CMS

Some types of media are managed directly by the CMS. These include:

- Text
- Newsfeeds
- Clocks
- Tables
- RS-232 Items
- QR Codes

You can include a wide variety of media items as ad hoc content and they are also directly managed by the CMS. Using ad hoc content is described separately (see Ad Hoc Content for details).

3.1.1 Text

You can display text you directly enter on the CMS. (You can also display text files: see Text Files for more details.)

Zone player type to enable: Text.

Playlist tab containing the item: Special.
Additional notes:

<table>
<thead>
<tr>
<th>Supported Format</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMS text editorial formats</td>
<td>The text editor offers formatting features (for example, use of bold, italic, font size, and colour).</td>
</tr>
</tbody>
</table>

3.1.2 Newsfeeds

You can display newsfeeds from external sources on the player.

Broadcasters or news agencies (for example, the BBC or Reuters) provide newsfeeds containing headline news or sports reports. Providers often do not charge and usually do not require usernames or passwords. However, some providers do define terms restricting display of their newsfeeds in digital signage networks and you must check on this before using newsfeed content.

Zone player type to enable: **Text**.

Playlist tab containing the item: **Special**.

Additional notes:

<table>
<thead>
<tr>
<th>Supported Format</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>RSS 0.91 and 2.0 (must say ‘RSS’ or ‘XML’).</td>
<td>Compatible newsfeeds are normally indicated by the symbol.</td>
</tr>
</tbody>
</table>

To subscribe to a newsfeed, follow these steps:

1. Find the newsfeed using your browser.
2. Click the link to the newsfeed or click the RSS button.
3. Copy the newsfeed's web address from the browser's address bar.
4. On the CMS, on the menu bar, click **Media** and **Newsfeeds**.
5. Click the **Add Newsfeed** tab, complete the newsfeed properties, and click the button.

The newsfeed properties are:

<table>
<thead>
<tr>
<th>Name</th>
<th>Enter a unique name for the newsfeed.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>RSS Newsfeed URL</strong></td>
<td>Enter or paste in the newsfeed web address. You must include the protocol (for example, <a href="http://www.bbc.co.uk/travelnews/tpeg/en/pli/pli_rss.xml">http://www.bbc.co.uk/travelnews/tpeg/en/pli/pli_rss.xml</a>).</td>
</tr>
<tr>
<td><strong>Refresh Interval</strong></td>
<td>Specify how often the CMS checks for updates.</td>
</tr>
<tr>
<td><strong>Maximum Age</strong></td>
<td>Specify how long the CMS will continue to display existing items if there is no connection to the newsfeed to obtain new ones.</td>
</tr>
</tbody>
</table>
### Authentication

Select the required authentication style:
- **No authentication required** – The newsfeed does not require a username and password.
- **Login with** – The newsfeed requires a username and password. Enter them in the fields provided.

### Proxy

Select the required proxy configuration:
- **No proxy required** – The CMS connects directly to the internet.
- **Use proxy if configured** – The CMS accesses the internet through the configured proxy. You must first configure the proxy (on the Setup > System > HTTP Proxy page).

### 3.1.3 Clocks

You can display a digital clock on the player showing the date and time in any one of a variety of formats.

Zone player type to enable: Text.

Playlist tab containing the item: Special.

### 3.1.4 Tables

You can create and format tables for display on the player. Before you can add a table to a playlist, you have to create it.

Tables are a convenient way of displaying static data. You can also use tables to hold ad hoc entries that local users control (for example, a table showing conference centre room allocations). The CMS creates tables using HTML.

Zone player type to enable: HTML.

Playlist tab containing the item: Special.

**Adding and Editing an Ordinary Table:**

To add a table, follow these steps:

1. On the menu bar, click Media and Tables.
2. Click the Add Table tab.
3. Enter a descriptive name for the table.
4. Enter the number of rows and columns. The maximum size is 19 rows by 39 columns. You cannot change the size of a table after you create it.
5. Click the button.

The CMS displays the Tables tab with your table added to the list. Click the button next to a table to take these actions:

- Delete the table. You cannot delete a table that is in use. Check the right-hand column to see the items using the table.
- Rename the table. Enter the new name in the field and click the Rename Table button. If you decide not to rename the table, click the Cancel Rename button.
You need to set up your new table by following these steps:

1. Click the table's [Edit] button.
2. Click the **Style** tab.
3. Take whichever of these formatting steps are needed to get the effect you want:
   - Click the [Edit Border] button to change the width and colour of the border.
   - Click the [Edit Column] button for each column you want to size manually.
   - Click the [Edit] button for each cell whose text font and size you want to adjust. [Text Properties](#) describes the formatting options. You can edit one cell and specify that the CMS also applies those changes to other cells.
4. Click the **Values** tab.
5. Edit the default text in each cell as required.
6. Click the [Save all changes] button.

**Adding and Editing Ad Hoc Tables:**

To create an ad hoc table, follow these steps:

1. Create a table as described above.
2. On the menu bar, click **Media** and **Manage Ad hoc Items**.
3. Click the **Add Item** tab.
4. Add a new Ad hoc Table Item that references the table.
   
   **Note:** If you copy an ad hoc table, the copied table is not an ad hoc table.

To edit an ad hoc table, open the **Tables** page and click the table's [Edit]. Make changes on the **Style** and **Default Values** tabs as described for the **Style** and **Values** tabs above. Click the **Ad Hoc** tab to specify the ad hoc features.

Click the [Edit Cell] button for the cell you want to change and select the option required:

- **Default Value** – The ad hoc user cannot change the cell value.
- **Override with any value** – The ad hoc user can enter any value in the cell.

If you set the **User Interface Policy** to **Detailed**, the CMS also offers these options:

- **Override with Integer between** – The ad hoc user can only enter values between the lower limit and upper limit you specify (both inclusive).
- **Override with text of maximum length** – The ad hoc user can only enter text up to the number of characters you specify.
- **Override value with text matching** – The ad hoc user can only enter text that matches the regular expression you specify. In the **Feedback Message** field, enter the message you want the player to display to the ad hoc user.
if what they enter does not match the regular expression. Information about using regular expressions is readily available (for example, at http://www.regular-expressions.info/).

3.1.5 RS-232 Items

You can add an RS-232 output item to a playlist. When the item is reached in a playlist, the player sends a character string to an external device through its RS-232 port (for example, to switch on a light at the start of the day). See RS-232 Outputs for how to set up RS-232 items.

Zone player type to enable: any player type.

Playlist tab containing the item: Special.

To add an RS-232 output item to a playlist, follow these steps:

1. On the menu bar, click Playlists and select the layout and zone where you want to add the RS-232 item.
2. Click the Specials tab.
3. Check the Send RS-232 Item.
4. Click the Add button.
5. In the playlist, drag the icon to adjust the position of the RS-232 item in the playlist, as necessary.
6. If required, click the button to change the RS-232 item on the Media tab or to set conditional play on the Advanced tab.

3.1.6 QR Codes

You can create and display QR Codes using the CMS.

QR Codes (Quick Response Codes) are two-dimensional barcodes carrying content that can be read by a suitable device. For example, a QR Code can contain a web site URL or an email address: a user scans the QR Code with a smartphone to open that web site or to compose an email to that address.

Zone player type to enable: Image.

Playlist tab containing the item: Special.

Additional notes:

<table>
<thead>
<tr>
<th>Supported Format</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>QR Code</td>
<td>The CMS creates QR Codes with Level H error correction (30%) and uses byte encoding.</td>
</tr>
</tbody>
</table>

3.2 Media Run from the CMS Disk

Use the Media > Files & Folders option to manage media content files on the CMS disk.

Note: You cannot create or edit files on the CMS. Create or edit files elsewhere and upload the result to the CMS.
The File & Folders tab provides these file management features:

- List – Displays all the files and folders in the current location.
- Navigate – Move between folders (click on a folder name or on a link in the Folder field to open it).
- ACT – Delete, move, and rename files and folders and also copy files.

Click the button next to a folder to take these actions:

- Delete the folder
- Move or rename the folder.

Click the button next to a file to take these actions:

- Delete the file.
- Move or rename the file.
- Copy the file.

Note: You cannot take any folder or file actions in the CMS system folders.

The Upload Files tab provides the means to bring files onto the CMS and to create new folders (as described in Uploading Content Files).

Refer to the media-specific information to see which zone player type to enable and for additional notes on the formats supported by the CMS:

Video
Text Files
Images and Photos
Audio
Presentations
HTML Web Pages
Adobe Flash
Folder Play

3.2.1 Uploading Content Files

You can upload content files to the CMS in several ways:

- Using the Upload Files Tab – The CMS offers an Upload Files tab on the Media > Files & Folders page or when you open a specific playlist.
- Using FTP
- Using Drag and Drop – If supported by your browser.

Note: Always add your content files to the Media folder or to sub-folders of the Media folder.
Using the Upload Files Tab:
You use both the Files & Folders and playlist Upload Files tabs in the same way:
1. Navigate to the folder where you want to add the file.
2. Click the Upload Files tab.
3. If required, create a sub-folder:
   a. Type a name for the sub-folder in the Folder name field.
   b. Click the Create Folder button.
   c. Click the sub-folder name to enter it.
   d. Click the Upload Files tab.
4. Click the Browse button and navigate to the file you want to upload.
5. Click the Upload File button.
6. Repeat those steps for each file.

Using FTP:
Before using FTP, make a note of the IP address of your CMS. If you do not know the IP address, consult the person who administers your network or reboot the CMS: it displays its IP address during the process.

Note: You need to have the FTP Read/Write permission on the CMS to upload using FTP. FTP may also be disabled on your network for security reasons. If you have difficulty using FTP, check with the person who administers your CMS or network.

You can upload using a dedicated FTP program. A quick alternative is to use Windows Explorer (or similar file-management program):
1. Open two copies of Windows Explorer.
2. In the first copy, navigate to the folder with the content you want to upload.
3. In the second copy, type ftp:// and the IP address of your CMS in the address bar (for example, ftp://192.168.0.254) and press the Enter key.
4. When prompted, enter your CMS username and password. Windows Explorer now displays your default CMS folder location.
5. Navigate to the Media folder. Do not add or modify files in any other folder as this may render the CMS unusable.
6. As required, create further folders under the Media folder. It is good practice to create separate folders for each layout and sub-folders for each zone (for example, media/Layout_reception/Zone_A).
7. To upload content to the CMS, drag-and-drop or copy-and-paste folders and files from the first copy of Windows Explorer to the second copy of Windows Explorer.

Note: If the FTP page does not refresh, press the F5 key or click Refresh to update it.

When you have connected Windows Explorer to your CMS with FTP, you can also:
- Rename and delete files on the CMS.
- Download files from the CMS to your PC using drag-and-drop or copy-and-paste.

You cannot move files from one folder to another using FTP. Instead, download the file to your PC and then upload it to the other CMS folder. Alternatively, move files using the Media > Files & Folders page.
Part 3: Understanding Media Types

Using Drag and Drop:
Some browsers allow you to drag files off of your PC desktop and drop them directly into a playlist or a folder on the CMS. The following browsers support drag and drop:

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Browser and Minimum Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows.</td>
<td>Microsoft Internet Explorer 9, Mozilla Firefox 6.0.2, Google Chrome 14</td>
</tr>
<tr>
<td>Mac OS X</td>
<td>Mozilla Firefox 3.6.19, Google Chrome 14, Apple® Safari® 5.0.6</td>
</tr>
<tr>
<td>Linux</td>
<td>Mozilla Firefox 6.0.2</td>
</tr>
</tbody>
</table>

Note these limitations of drag and drop:
- You cannot upload folders, only individual or groups of files.
- If you upload a file to a place containing a file with the same name, the CMS overwrites the existing file.
- If the file is for a media type not enabled for the zone, you can upload the file but it will not appear in the playlist until you enable its media type.

You can drag and drop a file into these locations using the method indicated:
- Playlist – Hover over the preferred position on the Playlist tab.
- Folder within a playlist – Hover over the folder on the Playlist tab.
- Folder – Hover over the preferred location on the Files & Folders tab.
- Folder within a folder – Hover over the folder on the Files & Folders tab.

To perform an upload using drag and drop, follow these steps:
1. Open the page on the CMS that is the location for the upload (either a playlist or a folder).
2. On your PC desktop, select the file or files you want to upload.
3. Hold down the left mouse button.
4. Move your mouse until the cursor is over the upload location.
5. Release the mouse button. The CMS displays a green progress bar as the upload proceeds (you might not see this for small files). When the upload completes, the CMS confirms the file's name and location in that progress bar.

3.2.2 Video
You can play various video formats with the player.

Zone player type to enable: Movie.

Note: For best performance, only enable one movie zone per layout on less powerful player models.

Playlist tab containing the item: Files & Folders.

To help you identify a particular video, the CMS displays a thumbnail image from it. That appears in the Filename column of the Files & Folders display (and in the Media column when you add the video to the playlist). The CMS displays the icon if it cannot render a thumbnail.
Additional notes:

<table>
<thead>
<tr>
<th>Supported Codecs</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>H.264</td>
<td>Recommended. Small file size but higher CPU load. However, supports high definition.</td>
</tr>
<tr>
<td>MPEG-1</td>
<td>Poor resolution.</td>
</tr>
<tr>
<td>MPEG-2</td>
<td>Good combination of CPU load and resolution but large file size.</td>
</tr>
<tr>
<td>MPEG-4 (ASP and AVC)</td>
<td>Small file size but higher CPU load. However, supports high definition.</td>
</tr>
<tr>
<td>VOB</td>
<td>Same as MPEG-2.</td>
</tr>
<tr>
<td>WMV 9</td>
<td>Windows Media Video.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Supported Containers</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>AVI</td>
<td>Microsoft® format. Can contain a wide-range of codecs. CPU load and resolution depends on the codecs within (see table above for guidance).</td>
</tr>
<tr>
<td>MOV</td>
<td>Apple® QuickTime® format. Can contain a wide-range of codecs. CPU load and resolution depends on the codecs within (see table above for guidance).</td>
</tr>
<tr>
<td>MPG</td>
<td>MPEG transport stream.</td>
</tr>
<tr>
<td>MP4</td>
<td>ISO MPEG-4 container (subset of MOV).</td>
</tr>
</tbody>
</table>

3.2.3 Text Files

You can display text files on the player. (You can also display text you enter directly: see Text for more details.)

Zone player type to enable: Text.

Playlist tab containing the item: Files & Folders.

Additional notes:

<table>
<thead>
<tr>
<th>Supported Format</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXT</td>
<td>Plain text only. The player does not support the display of files formatted by word-processor (for example, DOC or DOCX files from Microsoft® Word or PDF files from Adobe® Acrobat®).</td>
</tr>
</tbody>
</table>

3.2.4 Images and Photos

You can display several image formats with the player.

Zone player type to enable: Image.
Note: Large images may take several seconds to appear and may slow down the performance of the player. Always resize an image to match the size of the zone before uploading it.

Playlist tab containing the item: Files & Folders.

Additional notes:

<table>
<thead>
<tr>
<th>Supported Format</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>PNG</td>
<td>Recommended. Good quality and supports transparency.</td>
</tr>
<tr>
<td>JPG</td>
<td>Recommended. Edges can blur and does not look good when shown on a large screen.</td>
</tr>
<tr>
<td>GIF</td>
<td>Can look very grainy. Only supports 256 colours but does support transparency. The player does not support animated GIFs. To use an animated GIF, first embed it into an HTML page.</td>
</tr>
<tr>
<td>BMP</td>
<td>Large file size but no loss of quality.</td>
</tr>
</tbody>
</table>

3.2.5 Audio

You can play various audio formats with the player.

You add audio files to a whole layout and not to an individual zone. Layout property to enable: Soundtrack.

Playlist tab containing the item: Files & Folders.

Additional notes:

<table>
<thead>
<tr>
<th>Supported Format</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>MPEG-1 (layers 1, 2, and 3)</td>
<td>Performs acceptably on all player models.</td>
</tr>
<tr>
<td>MPEG-2 (AAC)</td>
<td>Performs acceptably on all player models.</td>
</tr>
<tr>
<td>MP3</td>
<td>Recommended. Good performance.</td>
</tr>
<tr>
<td>Uncompressed PCM (WAV)</td>
<td>Container. High quality but much larger file size than MP3.</td>
</tr>
<tr>
<td>WMA V1-3</td>
<td>Performs acceptably on all player models.</td>
</tr>
<tr>
<td>AC3</td>
<td>Performs acceptably on all player models.</td>
</tr>
</tbody>
</table>

3.2.6 Presentations

Presentations often have complex animations, timings, and graphics. To ensure the player displays a presentation correctly, save it in the best format to ensure faithful reproduction.

Zone player type to enable:

- If saved as video – Movie.
- If saved as Adobe Flash – HTML.
If saved as image slide show – **Image**.

Playlist tab containing the item: **Files & Folders**.

Additional notes:

<table>
<thead>
<tr>
<th>Supported Format</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft® PowerPoint® 2010 (PPT, PPTX)</td>
<td>Save as WMV video – Best option for high quality and complex animations and transitions but files can be large.</td>
</tr>
<tr>
<td></td>
<td>Save as Adobe Flash – Supports animations and transitions but complex and fast animation may appear choppy. Creates small files.</td>
</tr>
<tr>
<td></td>
<td>Save as image slide show – Use if animations and transitions are not important.</td>
</tr>
<tr>
<td>Apple® Keynote®</td>
<td>Save as MOV video – Best option for high quality and complex animations and transitions but files can be large.</td>
</tr>
</tbody>
</table>

**Save as a Video:**

To save a PowerPoint 2010 presentation as a video:

1. Select **File > Save & Send > Create a Video**.
2. Select the **Computer & HD displays** profile as this is likely to be the best for the player.
3. When prompted, choose where to save the video.

There are also third-party products specifically for converting PowerPoint 2010 presentations to video. Other products are more general screen capture applications, which can be useful if you want to include mouse movement or provide a voice-over.

**Save as Adobe Flash:**

There are third-party products for converting PowerPoint 2010 presentations to an Adobe Flash animation with varying degrees of complexity. For example, you can use the free OpenOffice suite to open a PowerPoint 2010 presentation and export it to an Adobe Flash file but without slide transitions or animations.

**Save as Image Slide Show:**

To save a PowerPoint 2010 presentation as an image slide show:

1. Select **File > Save & Send > Change file type**.
2. Choose a supported image file type (PNG is recommended, but the player also supports JPG, TIF, and BMP).
3. When prompted, choose where to save the files and select **Every Slide**.

**3.2.7 HTML Web Pages**

You can display local HTML files on the player. (You can also display whole or part pages from a remote web site: see [External Web Pages](#) for details.)

Zone player type to enable: **HTML**.

Playlist tab containing the item: **Files & Folders**.
Additional notes:

<table>
<thead>
<tr>
<th>Supported Format</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTML</td>
<td>The player displays HTML using the WebKit browser engine for Linux. (The Apple Safari and Google Chrome browsers also use the WebKit engine.) WebKit supports web pages including JavaScript® and Adobe Flash but not ActiveX®.</td>
</tr>
</tbody>
</table>

### 3.2.8 Adobe Flash

You can display Adobe Flash files with the player.

**Note:** Complex Adobe Flash files may not run smoothly on less powerful player models.

Zone player type to enable: **HTML**.

Playlist tab containing the item: **Files & Folders**.

Additional notes:

<table>
<thead>
<tr>
<th>Supported Format</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SWF</td>
<td>The player supports Adobe Flash Player version 11. Flash files give no indication to the player that they are finished. You need to set a maximum duration when you add the file to a playlist to force the player to move on to the next item.</td>
</tr>
</tbody>
</table>

### 3.2.9 Folder Play

Rather than adding a number of files individually to a playlist, you can add and play an entire folder from the CMS disk. This is known as **Folder Play**.

Zone player type to enable: as required by the media types in the files.

Playlist tab containing the item: **Files & Folders**.

You can configure folder play properties to control how the player plays the files:

- In sequence – Files play in file name order. Numbers come before letters and uppercase characters before lowercase (for example, ‘1’ comes before ‘A’ which comes before ‘a’).
- In random order – Files play in a random order (shuffle play).

Coupled with the order of play, you can also configure these properties:

- How many of the files to play.
- The number of files to jump before playing the next file.

See **Folder Play Properties** for more details about how to configure folder play.

### 3.3 Media from External Sources

You can display media running directly from external sources with the player.
Refer to the media-specific Information to see which zone player type to enable and for additional notes on the formats supported:

**TV**
**Radio**
**Live Video**
**Multicast Video**
**External Web Pages**

### 3.3.1 TV

You can play output from external digital TV stations with the player.

Zone player type to enable: **Movie**.

Playlist tab containing the item: **Specials**.

Additional notes:

<table>
<thead>
<tr>
<th>Supported Format</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital TV</td>
<td>Broadcast DVB-T digital TV, where available.</td>
</tr>
</tbody>
</table>

The player must be set up with:

- TV antenna connected to its TV socket.
- TV tuner card tuned to the digital transmitter.

See **TV & Radio** for more details of tuning and setting up digital TV.

### 3.3.2 Radio

You can play output from external digital radio stations with the player.

You add audio to a whole layout and not to an individual zone. Layout property to enable: **Soundtrack**.

Playlist tab containing the item: **Specials**.

Additional notes:

<table>
<thead>
<tr>
<th>Supported Format</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital radio</td>
<td>Digital radio stations, where available.</td>
</tr>
</tbody>
</table>

The player must be set up with:

- A TV antenna connected to its TV socket.
- A tuner card for tuning in to the stations (see **TV & Radio** for more details).

See **TV & Radio** for more details of tuning and setting up digital radio.
### 3.3.3 Live Video
You can output live video from various devices with the player.

Zone player type to enable: **Movie**.

Playlist tab containing the item: **Specials**.

Additional notes:

<table>
<thead>
<tr>
<th>Supported Formats</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDMI capture</td>
<td>Includes output from video cameras, DVD players, set-top boxes, and so on.</td>
</tr>
<tr>
<td>HDMI capture (analogue audio)</td>
<td></td>
</tr>
<tr>
<td>Component video</td>
<td></td>
</tr>
<tr>
<td>S-Video</td>
<td></td>
</tr>
<tr>
<td>Composite video</td>
<td></td>
</tr>
</tbody>
</table>

Before the player can display the video, configure it to recognise the video source as a TV input (as described in the **TV & Radio** section of the *Net-Top-Box User Guide*).

#### 3.3.4 Multicast Video
As an alternative to receiving TV broadcasts directly, the player can receive multicast video (also known as Internet Protocol Television (IPTV)) over the local network.

*Note:* Using multicast video requires an additional license.

Zone player type to enable: **Movie**.

Playlist tab containing the item: **Specials**.

Additional notes:

<table>
<thead>
<tr>
<th>Supported Format</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>MPEG-2 Transport Stream in UDP</td>
<td>Your player set up needs to include:</td>
</tr>
<tr>
<td></td>
<td>• An Internet Group Management Protocol (IGMP) network infrastructure to support multicast streaming.</td>
</tr>
<tr>
<td></td>
<td>• A device to stream video onto the network.</td>
</tr>
</tbody>
</table>

Before the player can display the video, configure it to recognise the video source as a TV input (as described in the **TV & Radio** section of the *Net-Top-Box User Guide*).

#### 3.3.5 External Web Pages
You can display whole or parts of pages from an external web site with the player. See Displaying Part of a Movie or Web Page for details of how to display only a part of a web page. See HTML Web Pages for how to display HTML files held locally on the player.

Zone player type to enable: **HTML**.
Playlist tab containing the item: **Specials**.

Additional notes:

<table>
<thead>
<tr>
<th>Supported Format</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTML</td>
<td>The player displays HTML using the WebKit browser engine for Linux. (The Apple Safari and Google Chrome browsers also use the WebKit engine.) WebKit supports web pages including JavaScript and Adobe Flash but not ActiveX. To display a web page, the player must have live access to it at the time. If the web page requires a username and password to log in, include those in the URL in the format: <code>protocol://username:password@site</code>.</td>
</tr>
</tbody>
</table>

**Adding External Web Pages to a Playlist:**

To add an external web page to a playlist, follow these steps:

1. Open the web page you want to link to and copy its whole URL address. (You can also sometimes use the URL to link to a specific frame or image to display.)
2. On the CMS menu bar, click **Playlists** and select the zone in the layout you want to add the page to.
3. Select the **Specials** tab.
4. Paste the web site URL into the **External Web Page** field.
5. Click the **Add** button.
6. In the playlist, you can drag the icon to adjust the item's position or click its **Edit** button to modify its properties.

**Notes:**

- HTML pages always have a white, non-transparent background.
- Auto-refresh web pages direct the player browser to reload the page at regular intervals. Add auto-refresh pages to a playlist with an indefinite duration to be sure that they always show the latest information. Determine whether a page auto-refreshes by searching for the `<meta http-equiv=refresh>` tag in its HTML code:
- To keep non-auto-refresh pages current, you need to reload them periodically. To do so, add the pages to a playlist with a fixed duration, as this forces the player to reload the page.

**Saving Web Pages to Disk and Adding to a Playlist:**

As an alternative to displaying a web page directly from an external source, you can save it on the CMS. This removes the connection to the source and your files will not be updated if the source changes.

To save the HTML files, use your browser's **Save** function. For example, with Internet Explorer, follow these steps:

1. From the **File** menu select **Save as**.
2. Navigate to the location where you want to save the files.
3. From the **Save as type** drop-down list, select **Web page, complete**. This saves the page as well as all its associated files (such as images). Internet Explorer saves the associated files in a folder called `pagename_files`, where `pagename` is the name of the HTML page.
When you have saved the HTML page and its files, add to a playlist by following these steps:

1. Upload the HTML page file and the _files folder with all its files onto the CMS as described in Uploading Content Files. If you need to include other files (for example, a JavaScript file implementing additional features) add them to the _files folder.

2. Add to a playlist as described in Adding Media Item Files to a Playlist.

### 3.4 Media Item Properties

There are different playlist properties for each type of media item. To edit the properties for a playlist item, click the button alongside the item.

The CMS displays the properties on three tabs:

1. **Media** – Location and name of the media. Can also contain ad hoc, touch screen, and item-specific properties (for example, for clocks, newsfeeds, and folder play).

2. **Style** – Properties specific to the media type (this tab is not shown for folder play items).

3. **Advanced** – Advanced properties that apply to all media items (position and size, time validity, conditional play, and media audit). (See Common Advanced Properties for details.)

The following table lists the generic properties you will find on the Media and Style tabs for each of the zone media players:

<table>
<thead>
<tr>
<th></th>
<th>Movie</th>
<th>HTML</th>
<th>Image</th>
<th>Text</th>
<th>Soundtrack</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>Deinterlace</td>
<td>O</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mode</td>
<td>O</td>
<td>O</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Letterbox Colour</td>
<td>O</td>
<td>O</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subtitles</td>
<td>O</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Volume</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>Opacity</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>Movie Size</td>
<td>O</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Web Page Size</td>
<td>O</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom</td>
<td>O</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page Background</td>
<td>O</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fade In</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>O</td>
</tr>
<tr>
<td>Fade Out</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>O</td>
</tr>
<tr>
<td>Text Style</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>O</td>
</tr>
<tr>
<td>Font</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>Movie</td>
<td>HTML</td>
<td>Image</td>
<td>Text</td>
<td>Soundtrack</td>
</tr>
<tr>
<td>---------------</td>
<td>-------</td>
<td>------</td>
<td>-------</td>
<td>------</td>
<td>------------</td>
</tr>
<tr>
<td>Text Colour</td>
<td>O</td>
<td>O</td>
<td></td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>Background Colour</td>
<td>O</td>
<td>O</td>
<td></td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>Horizontal Alignment</td>
<td>O</td>
<td>O</td>
<td></td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>Vertical Alignment</td>
<td>O</td>
<td>O</td>
<td></td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>Margins</td>
<td>O</td>
<td>O</td>
<td></td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>White Space</td>
<td>O</td>
<td>O</td>
<td></td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>Character Set</td>
<td>O</td>
<td>O</td>
<td></td>
<td>O</td>
<td></td>
</tr>
</tbody>
</table>

For details of those generic properties, see the information specific to each type of media player:

- **Movie Properties**
- **HTML Properties**
- **Image Properties**
- **Text Properties**
- **Soundtrack Properties**

Some playlist items have properties additional to the generic properties. For details of those item-specific properties, see the information for each item:

- **Newsfeed Properties**
- **Clock Properties**
- **Folder Play Properties**
- **Ad Hoc Properties**

### 3.4.1 Movie Properties

The following properties apply to a zone enabled as a Movie player:

<table>
<thead>
<tr>
<th>Duration</th>
<th>Select the duration you require:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Play all of the movie – The movie plays continuously.</td>
</tr>
<tr>
<td></td>
<td>• Play the movie for – The movie plays for the period you specify.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Deinterlace</th>
<th>The player automatically performs deinterlacing if required. To explicitly enable or disable deinterlacing, select Yes or No from the drop-down list.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Mode</th>
<th>You can set the display mode to one of these options:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Fit to Zone – Stretches the movie to fill the zone. This will distort the movie if the zone does not have the same aspect ratio as the movie.</td>
</tr>
<tr>
<td></td>
<td>• Letterbox – Shows the entire movie and preserves its aspect ratio. The player displays the letterbox colour in any space in the zone not covered by the movie.</td>
</tr>
<tr>
<td></td>
<td>• Crop – Preserves the movie aspect ratio but cuts off its edges if it is larger than the zone.</td>
</tr>
</tbody>
</table>
**Part 3: Understanding Media Types**

<table>
<thead>
<tr>
<th><strong>Letterbox Colour</strong></th>
<th>If you select Letterbox as the display mode, some space may be left in the zone outside of the movie. Use this option to select the colour the player displays in that space.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Subtitles</strong></td>
<td>Check the Display subtitles box to enable subtitles for the video (if available).</td>
</tr>
<tr>
<td><strong>Volume</strong></td>
<td>Enter the volume as a percentage of the maximum volume.</td>
</tr>
<tr>
<td><strong>Opacity</strong></td>
<td>To allow background items to be visible, enter a percentage to match the opacity required. 100% is completely opaque and 1% is almost completely transparent.</td>
</tr>
<tr>
<td><strong>Movie Size</strong></td>
<td>Choose the option you require:</td>
</tr>
<tr>
<td></td>
<td>- Use Zone Size – Display whole movie in the zone.</td>
</tr>
<tr>
<td></td>
<td>- Show Part of Movie – Display only a 'window' view of the movie in the zone:</td>
</tr>
<tr>
<td></td>
<td>- Left edge offset – Amount to indent the window relative to the movie’s left edge.</td>
</tr>
<tr>
<td></td>
<td>- Top edge offset – Amount to indent the window relative to the movie’s top edge.</td>
</tr>
<tr>
<td></td>
<td>- Movie width – Full width of movie.</td>
</tr>
<tr>
<td></td>
<td>- Movie height – Full height of movie.</td>
</tr>
<tr>
<td></td>
<td><em>Note:</em> This is only available if you set the User Interface Policy to Detailed or Expert on the UI Options page.</td>
</tr>
</tbody>
</table>

### 3.4.2 HTML Properties

The following properties apply to a zone enabled as an HTML player:

<table>
<thead>
<tr>
<th><strong>Duration</strong></th>
<th>Select the duration you require:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- Show the web page indefinitely – The player shows the web page always.</td>
</tr>
<tr>
<td></td>
<td>- Show the web page for – The player shows the web page for the period you specify.</td>
</tr>
<tr>
<td><strong>Web Page Size</strong></td>
<td>Choose the option you require:</td>
</tr>
<tr>
<td></td>
<td>- Use Zone Size – Display whole movie in the zone.</td>
</tr>
<tr>
<td></td>
<td>- Show Part of Web Page – Display only a 'window' view of the movie in the zone:</td>
</tr>
<tr>
<td></td>
<td>- Left edge offset – Amount to indent the window relative to the page’s left edge.</td>
</tr>
<tr>
<td></td>
<td>- Top edge offset – Amount to indent the window relative to the page’s top edge.</td>
</tr>
<tr>
<td></td>
<td>- Web Page width – Full width of page.</td>
</tr>
<tr>
<td></td>
<td>- Web Page height – Full height of page.</td>
</tr>
<tr>
<td></td>
<td><em>Note:</em> This is only available if you set the User Interface Policy to Detailed or Expert on the UI Options page.</td>
</tr>
<tr>
<td><strong>Volume</strong></td>
<td>Enter the volume as a percentage of the maximum volume.</td>
</tr>
<tr>
<td><strong>Opacity</strong></td>
<td>To allow background items to be visible, enter a percentage to match the opacity required. 100% is completely opaque and 1% is almost completely transparent.</td>
</tr>
</tbody>
</table>
### Zoom
Enables the Zone to zoom in on the HTML content. Smaller than 100% zooms out (to get the whole web page in a small zone for example) or larger than 100% zoom in, to fill the zone with part of a web page.

### Page Background
Check the **HTML Page allows transparent backgrounds** box to enable a transparent background (for example, to allow view of a background zone).

**Note:** Enabling this prevents Adobe Flash playing correctly in the HTML zone.

### 3.4.3 Image Properties

The following properties apply to zones enabled as an **Image** player:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fade In</strong></td>
<td>You can set the image to fade in with one of these options:</td>
</tr>
<tr>
<td></td>
<td>- <strong>No Fade in</strong> – Image appears immediately without fading in.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Fade In n.n seconds</strong> – Image fades in from the background. Specify the number of seconds for the fade-in to last (default is 1.5 seconds).</td>
</tr>
<tr>
<td></td>
<td>- <strong>Cross fade from previous image</strong> – Image fades in as the previous image fades out. You must also set the previous image's <strong>Fade Out</strong> option to <strong>Cross fade to next image</strong>. If no previous image is set to cross fade, this image fades in from the background in the number of seconds you specify (default is 1.5 seconds).</td>
</tr>
<tr>
<td><strong>Duration</strong></td>
<td>Select the duration you require:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Show image indefinitely</strong> – The player shows the image always.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Show the image for</strong> – The player shows the image for the period you specify.</td>
</tr>
<tr>
<td><strong>Fade Out</strong></td>
<td>You can set the image to fade out with one of these options:</td>
</tr>
<tr>
<td></td>
<td>- <strong>No Fade out</strong> – Image disappears immediately without fading out.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Fade out in n.n seconds</strong> – Image fades out to the background. Specify the number of seconds for the fade-out to last (default is 1.5 seconds).</td>
</tr>
<tr>
<td></td>
<td>- <strong>Cross fade to next image in n.n seconds</strong> – Image fades out as the next image fades in. You must also set the next image's <strong>Fade In</strong> option to <strong>Cross fade from previous image</strong>. If no next image is set to cross fade, this image fades out to the background in the number of seconds you specify (default is 1.5 seconds).</td>
</tr>
<tr>
<td><strong>Mode</strong></td>
<td>You can set the display mode to one of these options:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Fit to Zone</strong> – Stretches the image to fill the zone. This will distort the image if the zone does not have the same aspect ratio as the image.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Letterbox</strong> – Shows the entire image and preserves its aspect ratio. The player displays the letterbox colour in any space in the zone not covered by the image.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Crop</strong> – Preserves the image aspect ratio but cuts off its edges if it is larger than the zone.</td>
</tr>
<tr>
<td><strong>Letterbox Colour</strong></td>
<td>If you select <strong>Letterbox</strong> as the display mode, some space may be left in the zone outside of the image. Use this option to select the colour the player displays in that space.</td>
</tr>
<tr>
<td><strong>Opacity</strong></td>
<td>To allow background items to be visible, enter a percentage to match the opacity required. 100% is completely opaque and 1% is almost completely transparent.</td>
</tr>
</tbody>
</table>
3.4.4  Text Properties

The following properties apply to a zone enabled as a Text player:

<table>
<thead>
<tr>
<th>Text Style</th>
<th>Choose the option for how you want the text displayed:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show text indefinitely</td>
<td>Displays always.</td>
</tr>
<tr>
<td>Show text for</td>
<td>Displays for the period you specify.</td>
</tr>
<tr>
<td>Text moving from right to left at speed</td>
<td>Scrolls right-to-left at the speed you specify.</td>
</tr>
<tr>
<td>Text moving from left to right at speed</td>
<td>Scrolls left-to-right at the speed you specify.</td>
</tr>
<tr>
<td>Text moving from bottom to top at speed</td>
<td>Scrolls bottom-to-top at the speed you specify.</td>
</tr>
<tr>
<td>Text moving from top to bottom at speed</td>
<td>Scrolls top-to-bottom at the speed you specify.</td>
</tr>
</tbody>
</table>

For best results, set the scrolling speed in multiples of 60 (for example, 60 or 120).

<table>
<thead>
<tr>
<th>Font</th>
<th>Select the font family you want and the size and style to apply.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Colour</td>
<td>If you want text in a different colour than the default, click the [Pick] button to select an alternative.</td>
</tr>
<tr>
<td>Background Colour</td>
<td>If you want the background in a different colour than the default, click the [Pick] button to select an alternative.</td>
</tr>
<tr>
<td>Horizontal Alignment</td>
<td>Select the text horizontal position (only enabled for stationary and vertically-scrolling text).</td>
</tr>
<tr>
<td>Vertical Alignment</td>
<td>Select the text vertical position (only enabled for stationary and horizontally-scrolling text).</td>
</tr>
<tr>
<td>Margins</td>
<td>Set values to add blank space at each margin (in pixels).</td>
</tr>
<tr>
<td>White Space</td>
<td>Choose the option for how you want extra spaces, tabs, and new lines handled (collectively termed ‘whitespace’):</td>
</tr>
<tr>
<td>Display spaces and new lines as entered</td>
<td>Display all whitespace as entered (default).</td>
</tr>
<tr>
<td>Display multiple spaces as single space and multiple new lines as a single new line – Ignore extra whitespace.</td>
<td></td>
</tr>
<tr>
<td>Note: This property is for text files only.</td>
<td></td>
</tr>
<tr>
<td>Character Set</td>
<td>If necessary, select an alternative text-encoding standard.</td>
</tr>
<tr>
<td>Note: This property is for text files only.</td>
<td></td>
</tr>
<tr>
<td>Opacity</td>
<td>To allow background items to be visible, enter a percentage to match the opacity required. 100% is completely opaque and 1% is almost completely transparent.</td>
</tr>
</tbody>
</table>

3.4.5  Soundtrack Properties

The following properties apply to the audio playlist for layouts enabled with the Soundtrack option:

<table>
<thead>
<tr>
<th>Duration</th>
<th>Select the duration you require:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play all of the audio file</td>
<td>The soundtrack plays continuously.</td>
</tr>
<tr>
<td>Play audio file for</td>
<td>The soundtrack plays for the period you specify.</td>
</tr>
</tbody>
</table>

| Volume                    | Enter the volume as a percentage of the maximum volume. |
3.4.6 Newsfeed Properties

The CMS holds a newsfeed's properties in a number of locations. Access each group of properties by:

- Clicking the button for the newsfeed on the Media > Newsfeeds page (see Newsfeeds for a description of those properties).
- Clicking the button for the newsfeed in the playlist. The CMS displays some properties on the Media tab and some on the Style tab.

The newsfeed properties on the playlist Media tab are:

<table>
<thead>
<tr>
<th>Item Type</th>
<th>Indicates who can make changes to the set up on this page (click the Save Changes and change Item Type button to alter this).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ad Hoc Entry Label</td>
<td>Enter a reference label for the CMS to use in the playlist Media column.</td>
</tr>
<tr>
<td>Allowed Choices</td>
<td>Select which newsfeeds the ad hoc user can choose:</td>
</tr>
<tr>
<td></td>
<td>- All Available Newsfeeds – User can choose from any of the newsfeeds you have added.</td>
</tr>
<tr>
<td></td>
<td>- Only Selected Newsfeeds – User can choose only from the newsfeeds you check.</td>
</tr>
<tr>
<td>Default Newsfeed</td>
<td>Select the default newsfeed from the drop-down list.</td>
</tr>
<tr>
<td>Fields</td>
<td>Select whether to display components of the newsfeed other than the content:</td>
</tr>
<tr>
<td></td>
<td>- Title – Newsfeed title.</td>
</tr>
<tr>
<td></td>
<td>- Description – Newsfeed summary description.</td>
</tr>
<tr>
<td>Customisation Status</td>
<td>Indicates the newsfeed selection status.</td>
</tr>
</tbody>
</table>

The newsfeed properties on the playlist Style tab are:

<table>
<thead>
<tr>
<th>Item Selection</th>
<th>Choose the properties that specify how you want the CMS to choose from and sequence the newsfeed articles:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- Play all Items – Play all of the articles.</td>
</tr>
<tr>
<td></td>
<td>- Play only the first n items – Play just this number of articles.</td>
</tr>
<tr>
<td></td>
<td>- Play all Items in groups of n items – Jump this number of articles before playing the next article.</td>
</tr>
<tr>
<td></td>
<td>- Select items sequentially – Play articles in title order. Numbers come before letters and uppercase characters before lowercase (for example, '1' comes before 'A' which comes before 'a').</td>
</tr>
<tr>
<td></td>
<td>- Select items at random – Play articles at random (shuffle play).</td>
</tr>
<tr>
<td>Item Synchronisation</td>
<td>If you need to synchronise between zones, select the appropriate option for your synchronisation strategy:</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>- Slave - track changes to Master – The media shown in this zone is controlled from a master zone.</td>
</tr>
<tr>
<td></td>
<td>- Master – This zone controls the media shown in a slave zone.</td>
</tr>
</tbody>
</table>

You may want to show the headline in one zone and the details in another zone: see Synchronising Playlist Displays Between Zones for how to keep the displays aligned.
Part 3: Understanding Media Types

### Text Style
Choose the option for how you want the text displayed:
- **Show first Newsfeed item indefinitely** – Displays always.
- **Show each Newsfeed Item for** – Displays for the period you specify.
- **Text moving from right to left at speed** – Scrolls right-to-left at the speed you specify.
- **Text moving from left to right at speed** – Scrolls left-to-right at the speed you specify.
- **Text moving from bottom to top at speed** – Scrolls bottom-to-top at the speed you specify.
- **Text moving from top to bottom at speed** – Scrolls top-to-bottom at the speed you specify.
For best results, set the scrolling speed in multiples of 60 (for example, 60 or 120).

### Font
Select the font family you want and the size and style to apply.

### Text Colour
If you want text in a different colour than the default, click the [Pick Colour] button to select an alternative.

### Background Colour
If you want the background in a different colour than the default, click the [Pick Colour] button to select an alternative.

### Horizontal Alignment
Select the text horizontal position (only enabled for stationary and vertically-scrolling text).

### Vertical Alignment
Select the text vertical position (only enabled for stationary and horizontally-scrolling text).

### Margins
Set values to add blank space at each margin (in pixels).

### Opacity
To allow background items to be visible, enter a percentage to match the opacity required. 100% is completely opaque and 1% is almost completely transparent.

### 3.4.7 Clock Properties
The CMS holds a clock’s properties in the playlist’s Media and Style tabs.

The clock properties on the Media tab are:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Content</td>
<td>Select the overall date and time format.</td>
</tr>
<tr>
<td>Day of Week Format</td>
<td>Select the positioning and format of the day.</td>
</tr>
<tr>
<td>Date Format</td>
<td>Select the sequence of date components.</td>
</tr>
<tr>
<td>Year Format</td>
<td>Select a 2 or 4 digit year display.</td>
</tr>
<tr>
<td>Month Format</td>
<td>Select a month name or number display.</td>
</tr>
<tr>
<td>Time Format</td>
<td>Select whether to use the time format for the locale (defined on the player Setup &gt; Player &gt; International page) or the one you specify here.</td>
</tr>
<tr>
<td>Hour Format</td>
<td>Select whether to use 12 hour or 24 hour clock.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Select the required time zone from the drop-down list.</td>
</tr>
</tbody>
</table>
The clock properties on the **Style** tab are:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration</td>
<td>Select the duration you require:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Show Clock indefinitely</strong> – The player displays the clock all the time.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Show Clock for</strong> – The player displays the clock for the period you specify</td>
</tr>
<tr>
<td>Font</td>
<td>Select the font family you want and the size and style to apply.</td>
</tr>
<tr>
<td>Text Colour</td>
<td>If you want text in a different colour than the default, click the <strong>Pick Colour</strong> button to select an alternative.</td>
</tr>
<tr>
<td>Background Colour</td>
<td>If you want the background in a different colour than the default, click the <strong>Pick Colour</strong> button to select an alternative.</td>
</tr>
<tr>
<td>Horizontal Alignment</td>
<td>Select the clock's horizontal position.</td>
</tr>
<tr>
<td>Vertical Alignment</td>
<td>Select the clock's vertical position.</td>
</tr>
<tr>
<td>Margins</td>
<td>Set values to add blank space at each margin (in pixels).</td>
</tr>
<tr>
<td>Opacity</td>
<td>To allow background items to be visible, enter a percentage to match the opacity required. 100% is completely opaque and 1% is almost completely transparent.</td>
</tr>
</tbody>
</table>

### 3.4.8 Folder Play Properties

The CMS displays folder play properties on the **Media** tab. Besides the folder play properties, this contains properties for all of the player types enabled for the zone.

You can customise how long the player plays movie, HTML, and SWF (Adobe Flash) files. Specify the length of play by adding the string `duration-x` just before the file extension (where `x` is the duration in seconds). For example, the player would play the file `logo-intro-duration-17.swf` for 17 seconds. This customisation has no effect if you add the file into a playlist individually.

The following specific properties apply to folders in a playlist:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Media</td>
<td>Check the box to enable the relevant media player for the zone.</td>
</tr>
<tr>
<td>Management</td>
<td>Check the <strong>Management</strong> box to enable ad hoc management of this folder.</td>
</tr>
<tr>
<td></td>
<td>If the ad hoc user places files in the indicated ad hoc media folder, the player plays them instead of those in the current folder. If there are no suitable files in the ad hoc media folder, the player plays the files in the current folder.</td>
</tr>
</tbody>
</table>
**Part 3: Understanding Media Types**

### Item Selection
<table>
<thead>
<tr>
<th><strong>Item Selection</strong></th>
<th>Choose the properties that specify how you want the player to choose from and sequence the files:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Play all Items</strong> – Play all of the files.</td>
</tr>
<tr>
<td></td>
<td><strong>Play only the first n items</strong> – Play just this number of files.</td>
</tr>
<tr>
<td></td>
<td><strong>Play all Items in groups of n items</strong> – Jump this number of files before playing the next file.</td>
</tr>
<tr>
<td></td>
<td><strong>Select items sequentially</strong> – Play files in file name order. Numbers come before letters and uppercase characters before lowercase (for example, '1' comes before 'A' which comes before 'a').</td>
</tr>
<tr>
<td></td>
<td><strong>Select items at random</strong> – Play files at random (shuffle play).</td>
</tr>
</tbody>
</table>

### Item Synchronisation
<table>
<thead>
<tr>
<th><strong>Item Synchronisation</strong></th>
<th>If you need to synchronise between zones, select the appropriate option for your synchronisation strategy:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Slave - track changes to Master</strong> – The media shown in this zone is controlled from a master zone.</td>
</tr>
<tr>
<td></td>
<td><strong>Master</strong> – This zone controls the media shown in a slave zone.</td>
</tr>
<tr>
<td></td>
<td>See <a href="#">Synchronising Playlist Displays Between Zones</a> for more details.</td>
</tr>
</tbody>
</table>

You can combine folder play properties to create complex sequences to meet specific requirements. For example, you may wish to set up a playlist that showed a sequence of music videos in a fixed order, and between each video show two randomly selected advertisements followed by a corporate logo for a fixed time.

To create this sequence of folders, follow these steps:

1. Create three folders on the CMS as follows:
   - Music
   - Advertisements
   - Logo
2. Upload videos into the **Music** folder. Rename the video files as necessary to create the play order you want (for example, 'A Summer in the city.mpg, B Be my girl.mpg', and so on).
3. Upload the advertisements into the **Advertisements** folder.
4. Upload the logo into the **Logo** folder.
5. Create a playlist as follows:
   - Add the **Music** folder to the playlist (set to play all items sequentially).
   - Add the **Advertisements** folder to the playlist (set to play only the first two items randomly).
   - Add the logo image as an individual file (set duration 10 seconds).

### 3.4.9 Common Advanced Properties

All media items have in common the set of properties present on the **Advanced** tab.

Other than the **Media Audit** property, the CMS only displays the **Advanced** properties if:

- You have set the **User Interface Policy** to **Detailed** or **Expert** on the **UI Options** page.
- You have previously enabled the property.
The following properties apply to any zone:

| Position and Size | To override the position and size of a zone, select the Use custom position and size radio button and set the values you require:
| --- | --- |
|  | • **Top edge offset** – Amount to move the zone relative to the screen's top edge.
|  | • **Left edge offset** – Amount to move the zone relative to the screen's left edge
|  | • **Width** – Width for the zone.
|  | • **Height** – Height for the zone.
|  | This property is not applicable to soundtrack items.

| Time Validity | To control when the player shows an item in a playlist, check the relevant boxes and set the times you require:
| --- | --- |
|  | • **Date Range** – Select the dates during which you want these settings to apply (for a single day, set both dates the same).
|  | • **Days** – Select the days you want the item to appear.
|  | • **Time Period** – Select the period during which you want the item to appear.
|  | Examples when you might choose to use this property:
|  | • To play adverts only on certain days of the week.
|  | • To show a traffic report only after 5.00 pm.
|  | Points to note:
|  | • Outside the times you specify, the player skips the item when its turn comes in the playlist.
|  | • The player continues to play the item even if the valid time expires before the item ends.

| Conditional Play | This is only enabled when you have added player local information to the player (see [Player Local Information](#) for details). If it is enabled, you have two options:
| --- | --- |
|  | • **Play Always** – Default. The player always plays the schedule.
|  | • **Play if Player Local Information Item** – The player only plays the schedule if certain conditions are met.
|  | If you select **Play if Player Local Information Item**, complete these steps:
|  | 1. Select the name of the relevant player local information from the first drop-down list.
|  | 2. Select the test to apply from the second drop-down list.
|  | 3. Enter the value to test for in the final field (add further values by clicking the ![button](#) or delete values by clicking the ![button](#)).
|  | 4. Click the ![button](#) button.

| Media Audit | To change whether the player collects media audit data to send in its reports, check the relevant radio button:
| --- | --- |
|  | • **Inherit the zone’s media audit setting** – The player collects or does not collect the data depending on the setting in the zone's properties.
|  | • **Disable media auditing** – Disables data collection even if it is enabled in the zone's properties.
|  | • **Enable media auditing** – Enables data collection even if it is not enabled in the zone's properties.
### 3.4.10 Ad Hoc Properties

The CMS displays ad hoc properties on the **Media** tab.

You can apply the following properties to directly entered text, newsfeeds, radio, TV, and tables that you have set to be customisable or ad hoc:

<table>
<thead>
<tr>
<th>Item Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Click the button to save any existing changes to the item and to open the page to select the item's type:</strong></td>
<td>![Save Changes and change Item Type] button</td>
</tr>
<tr>
<td></td>
<td>• <strong>Content of this item is controlled by the Layout Designer</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Content of this item can be customised using this Layout's Ad hoc Entry Page</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Use an existing Ad hoc Item</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Create and use a new Ad hoc Item</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Ad Hoc Entry Label</th>
<th>The label used to refer to this item on the layout's <strong>Ad hoc Page.</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Ad Hoc Item Name</td>
<td>Unique identifier for the ad hoc item on the CMS. (Only for ad hoc items that you cannot customise.)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Properties dependent on media type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>The CMS displays some properties that are dependent on the type of ad hoc item:</strong></td>
<td>![Table] Name link to the <strong>Ad Hoc</strong> tab of the <strong>Media &gt; Tables</strong> page for configuring the table.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Directly entered text:</strong></td>
</tr>
<tr>
<td></td>
<td>  o <strong>Ad Hoc Input</strong> – Options to format the text and specify allowable ad hoc user input.</td>
</tr>
<tr>
<td></td>
<td>  o <strong>Default Text</strong> – Enter default text to display.</td>
</tr>
<tr>
<td></td>
<td>  o <strong>Customisation Scope</strong> – Either <strong>Local</strong> (customised text displays only on the ad hoc user's local CMS) or <strong>Remote</strong> (customised text displays on players that are subscribers to the ad hoc user's CMS).</td>
</tr>
<tr>
<td></td>
<td>• <strong>Newsfeed:</strong></td>
</tr>
<tr>
<td></td>
<td>  o <strong>Allowed Choices</strong> – Whether you allow the ad hoc user to select all or a subset of the available newsfeeds on the player.</td>
</tr>
<tr>
<td></td>
<td>  o <strong>Default Newsfeed</strong> – Select the default newsfeed to display.</td>
</tr>
<tr>
<td></td>
<td>  o <strong>Fields</strong> – Whether to display newsfeed with or without title or description.</td>
</tr>
<tr>
<td></td>
<td>• <strong>TV and radio:</strong></td>
</tr>
<tr>
<td></td>
<td>  o <strong>Allowed Choices</strong> – Whether you allow the ad hoc user to select all or a subset of the available stations on the player.</td>
</tr>
<tr>
<td></td>
<td>  o <strong>Default Station</strong> – Select the default station to play.</td>
</tr>
<tr>
<td></td>
<td>  o <strong>Subtitles</strong> – Whether or not to display subtitles (if available).</td>
</tr>
<tr>
<td></td>
<td>• <strong>Tables:</strong></td>
</tr>
<tr>
<td></td>
<td>  o <strong>Table</strong> – Name link to the <strong>Ad Hoc</strong> tab of the <strong>Media &gt; Tables</strong> page for configuring the table.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Customisation Status</th>
<th>Indicates if this item is currently displaying its default value or if it has been overridden by an ad hoc user.</th>
</tr>
</thead>
</table>

| Used By Layouts | Lists the layouts that use this ad hoc Item. (Only for ad hoc items that you cannot customise.) |
3.5 Playlist Commands

You can use the following playlist features to alter the display sequence and appearance:

- Rendezvous Points and the Advance To Command
- Change Layout Command

3.5.1 Rendezvous Points and the Advance To Command

Each playlist displays a sequence of items that operate independently. Even if two playlists contain items of exactly equal lengths, you cannot rely on their display being completely synchronized. Instead, if you want to achieve synchronization between playlists, you need to use a combination of Advance To commands and Rendezvous Points.

An Advance To command in a playlist causes the player to start displaying an item in another playlist. You specify the item to display by placing a matching rendezvous point at an appropriate place in the other playlist. If the receiving zone's playlist contains the rendezvous point, the player immediately starts playing the playlist item after the rendezvous point.

To link the two together, the Advance To command refers to the rendezvous point by name. You can select whether the player passes the Advance To command to a single zone or to all zones in the current layout. Therefore, by placing the same rendezvous point in several zones, you can trigger actions in all of them with a single Advance To command.

You can also use the Advance To mechanism to initiate player actions as a result of user interactions, such as motion sensor, pressure mat, or touch screen events (see Using Interactivity for more details).

To add a rendezvous point to a playlist, follow these steps:

1. Click the Specials tab.
2. In the Rendezvous Point field, enter a name. You can enter any text for the name (but not starting with the string auto_) and names are not case-sensitive.
3. Click the Add button.
4. Make sure the rendezvous point appears immediately before the item you want the player to synchronize with the other playlist.
5. If required, repeat to create additional rendezvous points in other playlists.
6. Add the Advance To command.

To add an Advance To command to a playlist, follow these steps:

1. Click the Specials tab.
2. From the Advance To Rendezvous Point drop-down list, select the relevant rendezvous point name.
3. Click the Add button.
4. Make sure the Advance To command appears immediately before the item you want the player to synchronize with the other playlist.
5. If you want the Advance To command to target only a specific zone:
   a. Click the Edit button.
   b. Select the zone from the drop-down list.
3.5.2 Change Layout Command

Unlike the **Advance To** command, the **Change Layout** command launches a different screen layout with its own arrangement of zones.

If you want to implement a simple change of the layout, then the **Advance To** command brings a quick result. However, it is difficult to implement a complex change using the **Advance To** command. The **Change Layout** command displays a different layout entirely, but it does take longer to refresh the screen.

To add a **Change Layout** command to a playlist, follow these steps:

1. Click the **Specials** tab.
2. From the **Change Layout** drop-down list, select the new layout you want to use.
3. Click the **Add** button.
4. Make sure the **Change Layout** command appears in the right place in the playlist.

**Note:** If you want to change the **Change Layout** command to point to a different layout, click the **Edit** button and alter your selection.

### 3.6 Colours

Use the **Media > Colours** page to set the colours the CMS applies to fonts, backgrounds, and other items.

When you create a new layout or a new table, the CMS automatically creates new colour items:

- For layouts, the colour items are for the text foreground, the text background, and the letterbox background.
- For tables, the colour items are for the text foreground and text background.

The CMS names colour items in the format **Layout name: Colour item**. For example, if you create a new layout named 'Holidays', the CMS creates the following colour items for it:

- Text foreground – Holidays: Text
- Text background – Holidays: Background
- Letterbox – Holidays: Letterbox

You can modify the properties for these colour items as needed.

You define a **Colour Item** by a unique name, a colour value, and an opacity setting. If you change the colour value or opacity setting, the CMS updates all the items that use the colour. Click the button to apply your changes. You can define more than one colour item with the same colour values.

Click the tab for the option you require:

- **Colours** – Listing the colour items and their characteristics. Click the **Delete** button to delete a colour (you cannot delete it if it is in use). Click the **Edit** button to:
  - Modify a colour – The settings are as described for the **Add Colour** tab. Click the **Save Changes** button to enable your modifications.
• Access the Used By tab – Lists which layouts are using the colour.

• Add Colour – Adding a new colour manually.

To add a new colour, complete the following information and click the button:

<table>
<thead>
<tr>
<th>Name</th>
<th>Enter a unique and meaningful name for the colour. This does not have to be in Layout name: Colour item format followed by the CMS.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colour Value</td>
<td>Specify the colour using either separate RGB values or a single hexadecimal value. On a Windows PC, you can find the RGB values for a colour you want to use by following these steps:</td>
</tr>
<tr>
<td></td>
<td>1. Click Start and select All Programs &gt; Accessories &gt; Paint.</td>
</tr>
<tr>
<td></td>
<td>2. Open a file containing an image that uses the target colour.</td>
</tr>
<tr>
<td></td>
<td>3. Use the Colour Picker tool to select a pixel of the target colour.</td>
</tr>
<tr>
<td></td>
<td>4. Click the Edit Colours tool.</td>
</tr>
<tr>
<td></td>
<td>5. Read off the RGB values at the bottom right of the Edit Colours display.</td>
</tr>
<tr>
<td>Opacity</td>
<td>To allow background items to be visible, enter a percentage to match the opacity required. 100% is completely opaque and 1% is almost completely transparent.</td>
</tr>
</tbody>
</table>

### 3.7 Fonts

The CMS offers a collection of standard fonts that are suitable for most purposes.

To view the installed fonts:

1. On the menu bar, click Media and Fonts.
2. Click the Font Families tab.

The Font Families tab shows details of all the fonts available on the CMS (including those you install). The Font Files tab lists the files for any fonts you install.

If you want to use a font that is not available on the CMS, you must add your own font files. The CMS supports TrueType® (TTF or TTC) and OpenType® (OTF) format font files. You must also install that additional font on every subscriber player.

To add a font file, follow these steps:

1. On the menu bar, select Media and Fonts.
2. Click the Add Font File tab.
3. Click the Browse... button and navigate to the font file you wish to add.
4. Click the Open button.
5. Click the Upload Font button.
6. After you add a font file, you must restart the CMS.
Part IV

Enhancing Your Displays
Part 4: Enhancing Your Displays

You can enhance your digital sign display in various ways:

**Synchronising Playlist Displays Between Zones**

**Using Interactivity**

**Using the RS-232 Interface Port**

**Displaying Part of a Movie or Web Page**

**Changing the Screen Background**

### 4.1 Synchronising Playlist Displays Between Zones

You can synchronise the display between playlists in useful and sophisticated ways using rendezvous points and **Advance To** commands.

Examples include:

- Displaying video or images in one zone and related text captions in another zone (for a method to achieve this, see [Automatic Captioning](#)).
- Displaying a selection of videos or images in response to ad hoc user input (for a method to achieve this, see [Displaying Video-On-Demand Using a Sub-Playlist](#)).

You can achieve further complex and powerful results with other of the rendezvous point and **Advance To** command mechanisms:

- An **Advance To** command executed in any currently playing playlist (including in the same playlist).
- An **Advance To** command delivered over the player's Ethernet port in the form of an XML message posted to the HTML TCP port.
- An **Advance To** command in a schedule entry or in an ad hoc page.
- A change in binary input lines on the RS-232 port initiating an **Advance To** command.
- An event on an attached touch-sensitive screen initiating an **Advance To** command.

#### 4.1.1 Automatic Captioning

To implement synchronisation between zones, you need to designate one playlist as the **Master Playlist** and one or more other playlists as **Slave Playlists**. You add rendezvous points to each slave playlist and the identically named **Advance To** command in the master playlist. When the master playlist reaches the **Advance To** command, the player forces the slave playlists to start playing the first item after the rendezvous point.

To have the player perform automatic captioning, you have to use files with corresponding file names. For example, to display captioning for a video file called `Marketing_Highlights_01.mpg`, you would need to create a file called `Marketing_Highlights_01.txt` containing the text captions.

To set up automatic captioning between the zone playing the video and the zone playing the captions, first set up the video zone:

1. Upload all the videos into one folder on the CMS.
2. Open the video zone’s playlist page.
3. Click the **Files & Folders** tab and navigate to the video folder location.
Part 4: Enhancing Your Displays

4. Click the folder’s Add button.
5. Click the Playlist tab.
6. Click the folder’s Edit button.
7. From the Item Synchronisation drop-down list, select Master.
8. In Movie properties, select the Duration option Play the Movie File Indefinitely.
9. Click the button.

Second, set up the captioning zone:

1. Upload all of the text files into one folder on the CMS. (This can be the same folder that contains the videos.)
2. Open the captioning zone’s playlist page.
3. Click the Files & Folders tab and navigate to the text folder location.
4. Click the folder’s Add button.
5. Click the Playlist tab.
6. Click the folder’s Edit button.
7. From the Item Synchronisation drop-down list, select Slave - Track Changes to Master.
8. In Text properties, select the Text Style option to Show Text File Indefinitely.
9. Click the button.

4.1.2 Displaying Video-On-Demand Using a Sub-Playlist

You can use the Ad hoc mechanism to configure the player to show videos on-demand (in response to a button-click) by using a series of Advance To commands. The same mechanism can also be used to set up images or any other media type to be displayed on-demand. You do this using sub-playlists.

You can create a loop, or sub-playlist, by inserting both a rendezvous point at the beginning of a sequence of items and an Advance To command at the end of the sequence in the same playlist. This means that the player displays the items in the sequence in a continuous loop until another Advance To command breaks out of the loop.

To illustrate that mechanism, here is a sequence of items in a playlist:

Rendezvous Point: Start
  ○ Default Movie item
  ○ Advance To: Start

Rendezvous Point: Option1
  ○ Option1 Movie Item
  ○ Advance To: Start

Rendezvous Point: Option2
  ○ Option2 Movie item
  ○ Advance To: Start
That playlist sequence might run like this:

1. The player plays **Default Movie item** in a continuous loop created by the **Advance To** command and rendezvous point **Start**.
2. An **Advance To** command **Option1** arrives from an ad hoc page.
3. The player starts playing the item after rendezvous point **Option1** and this is **Option1 Movie Item**.
4. At the end of **Option1 Movie item**, the player processes the **Advance To** command **Start**.
5. The player therefore returns to rendezvous point **Start** and plays the **Default Movie Item** again in a continuous loop.

To create a sub-playlist loop, follow these steps:

1. Click on a zone to edit its playlist.
2. Click on the **Specials** tab.
3. Type the name of the loop into the **Rendezvous Point** text box (use as descriptive a name as possible).
4. Click the **Add** button to add the rendezvous point to the playlist.
5. Add the items that must appear in the sub-playlist in the usual manner. If you want a sub-playlist to play just once, insert an image at the end with an indefinite duration.
6. In the **Specials** tab, select the rendezvous point by name from the **Advance To Rendezvous Point** list and click the **Add** button.
7. Make the layout live by adding to a schedule and clicking the button.

You are now able to switch between playlists by adding **Advance To** commands to an ad hoc page:

1. Select **Media > Manage Ad hoc items**, and click the **Add Item** tab.
2. Select the **Advance To** type, enter a name, and click the **Add** button. Repeat to add an **Advance To** command for each rendezvous point.
3. Select **Media > Design Pages > Manage Ad hoc pages**, and click the **Add Pages** tab.
4. Create a new page with a name such as 'Movie control'.
5. Click the **Edit** button and add the ad hoc items for each rendezvous point to the ad hoc page.
6. In the **Properties** tab, select the users who are allowed to call the commands.
7. Click the **Save Changes** button.

### 4.2 Using Interactivity

You can configure the player to respond to inputs from an external source. External inputs are known as **Events** and they may be caused by:

- Someone pressing or releasing a defined area on a USB touch screen.
- Someone passing a detector or stepping on a pressure mat that generates a general purpose input/output (GPIO) signal (received through the player unit’s RS-232 port or adapter).
- Someone pressing a button on a remote keypad (infrared controller).
The way you configure the player to respond may include:

- Executing a **Change Layout** command.
- Executing an **Advance To** command.

Those responses are known as **Actions** and you can configure the player to take them immediately or after a timeout. Together, the combination of an event and an action is known as an **Interaction**.

For all events (or timeouts), you can have the player take one of these actions:

- Change to a specified layout.
- Advance to a rendezvous point.
- Ignore the event for this zone or layout and pass it to another zone or layout.

Additionally, for touch and GPIO events, you can have the player take one of these actions:

- Touch and GPIO events – Take no action.
- Touch event – Pass to a web page. If the zone supports HTML, the player can pass a touch event to the currently showing web page. If there is no web page, the player takes no action.

**Playlist and Layout Interaction:**

To provide detailed control, you can specify behaviour that differs at the playlist and at the layout level:

- **Playlist:**
  - Process the interaction if someone touches the currently playing item.
  - Keep the interaction process active awaiting other events. You can implement complex behaviour by defining multiple interaction actions in the same playlist.

- **Layout:**
  - Process the interaction if there is no playlist action (that is, the layout action is a default).
  - Process the interaction if someone touches anywhere on the screen.

You will find it easier to review layout interaction behaviour because the CMS displays all layout components at once.

To configure touch actions for a playlist, you must either:

- Include an **On Touch Advance To** command in the playlist.
- Include an **On Touch Change Layout** command in the playlist.
- Play an HTML page in the zone.

To add items, click on the playlist's **Specials** tab and select those required. You can include more than one **On Touch Advance To** or **On Touch Change Layout** commands in the playlist. Each **On Touch** command overrides the previous one. This allows you to have the player change its response to touch events throughout the playlist.

If you enable touch for a zone that is displaying an HTML page, the player passes touch events to the HTML player for handling. You can use this to allow a user to navigate through web pages using links embedded in the displayed HTML page.

**Note:** To use HTML navigation, either omit **On Touch** playlist items or use **Interact Clear** (found on the playlist's **Specials** tab) to deactivate existing **On Touch** items. Otherwise, **On Touch** items will take precedence over the HTML player. Then, the player only passes **Left Mouse Button Up** and **Down** events to the HTML player.
To configure touch actions for a layout, on the menu bar click **Layouts** and select the layout you want to configure. Click the **Interaction** tab and select the touch screen actions in response to a touch screen event. The settings include:

- Whether a touch response is required for this layout at the layout level or not.
- Whether the touch response is a **Change Layout** or **Advance To** command.
- Whether it is the touch or release operation that causes the action.
- The period after which the layout will revert to another layout in the absence of a touch event.

**Interaction Processing:**

The way the player processes an event depends upon:

- The source (touch screen, GPIO, or remote keypad).
- The currently active interactions.

The player processes interactions for touch screen events as follows:

1. Creates a list of zones showing items directly underneath the touched screen location.
2. Processes that list in depth order, starting with the top zone.
3. If a zone has an active touch action, and that is not to pass the event to another zone, the player performs the specified action and stops processing.
4. If no zone has an active touch action, the player performs the touch action defined for the layout.

The player processes interactions for RS-232 input events as follows:

1. Creates a list of all zones showing items coincident to the RS-232 input.
2. Processes that list in depth order, starting with the top zone.
3. If a zone has an active RS-232 input action, and that is not to pass the event to another zone, the player performs the specified action and stops processing.
4. If no zone has an active RS-232 input action, the player performs the RS-232 action defined for the layout.

The player processes a remote keypad button event as follows:

1. Creates a list of all zones showing items coincident to the remote keypad button event.
2. Processes that list in depth order, starting with the top zone.
3. If a zone has an active remote keypad button action, and that is not to pass the event to another zone, the player performs the specified action and stops processing.
4. If no zone has an active remote keypad button action, the player performs the remote keypad action defined for the layout.

**Passing Touch Events to HTML Pages:**

If the current zone supports HTML, the player can pass touch events directly to the currently showing HTML page. Using this technique, you can build rich interactive applications using stored HTML content. However, you cannot create interactions with external web sites.
Part 4: Enhancing Your Displays

When developing such HTML applications, you will likely require a large number of files. In order for the CMS to keep track of these files during channel publishing and layout package creation, follow these rules:

- Initiate the application from a single HTML file (you can redirect from here to other files as required). Add that file to the playlist.
- Place all additional files in a single subdirectory named [pagename]_files, where [pagename] is the name of the initiating HTML file (without its extension). Locate that subdirectory in the directory containing the initiating HTML file.

### 4.2.1 Designing Interactive Layouts

You can design layouts that respond to user input in various ways:

- Send an **Advance To** command to play a specific item or start a playlist.
- Change the current layout.
- Change the size and position of a zone.
- Display hidden zones.
- Send a signal to another device through the RS-232 port or adapter.

You might find the following general guidance helpful when developing interactive layouts.

**Develop a Storyboard:**

Advance planning is particularly important when designing a layout that smoothly offers choices and options to users. A storyboard is a plan based on a series of sketches of individual scenes. Storyboarding is very effective technique when designing interaction sequences. You can create a storyboard with sketches of screen layouts or simply with a flowchart. The important point is to detail all possible outcomes at each stage of interaction.

**Provide Material for Optional Actions:**

You must make sure that you have collected and uploaded all the media files you require for any possible scenarios controlled by interaction events. Before you start implementing your interaction events, create playlists for zones that include all the necessary **Advance To** commands and rendezvous points.

**Trade-Offs Between Display Change Methods:**

You can change the display in response to an interaction either by changing the size and show/hide properties of a zone or by using a **Change Layout** command. Each method has advantages and disadvantages:

<table>
<thead>
<tr>
<th>Method</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change zone size and show/hide</td>
<td>Very fast transition</td>
<td>Continues using existing media players</td>
</tr>
<tr>
<td>properties</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Use <strong>Change Layout</strong> command</td>
<td>Resets all media players</td>
<td>Slower, visible transition</td>
</tr>
</tbody>
</table>

### 4.2.2 General Purpose Input/Output

The player can respond to changes in voltages generated by a GPIO device such as a motion sensor or a pressure mat. The player receives those inputs through its RS-232 port or adapter. It can also send output signals. For more details see the [RS-232 Technical Reference](#).
Control-Line Inputs:
The player RS-232 interface has four input lines that can receive binary events such as contact closure or signals from other devices. The available lines are:

- Clear To Send (CTS).
- Data Carrier Detect (DCD).
- Data Set Ready (DSR).
- Ring Indicator (RI).

The lines do not affect the operation of the RS-232 Send and Receive strings.

Include an RS-232 input item in a playlist and configure it to issue an Advance To or Change Layout command. Use those commands to change the media played by the player. This is triggered when the player detects a line transition generated by a user action.

Control Line Outputs:
The player can control the output state of the RS-232 DTR and RTS lines. Create RS-232 output items to change one or both RS-232 outputs and optionally transmit a string of characters. Give the RS-232 output items unique names to clarify their purpose.

4.2.3 Touch Screens
The player includes support for touch screen input from users. These features allow you to configure the player to respond to those user inputs (for example, by executing Advance To or Change Layout commands). Connect an overlay touch-screen panel to the player through its USB port.

4.2.4 Click On Touch
You can configure the player to play an audio file when someone touches an interactive screen.

To play an audio file, click the layout’s Interaction tab and enable Click on Touch. The player does not play a sound when the setting is No Click on Touch.

Specify these items:

- **Volume** – Express volume as a percentage of the Master Volume level. (You can specify the Master Volume level on the Audio page in the Setup menu.) If this entry is blank, the player uses 75% of the Master Volume level.
- **Actions** – Check the audio file’s Use sound button. If necessary, navigate to the location of the file using the folder display.

4.3 Using the RS-232 Interface Port
If you require the player to control equipment through an RS-232 interface, use its built-in RS-232 port or the USB to RS-232 adapter, whichever is appropriate for the player model.

Considerations for sending RS-232 strings at specific events or playlist positions:

- Define the strings by expressing their byte values as separated hexadecimal pairs (for example, 3A 3B 3C 0D 0A).
Part 4: Enhancing Your Displays

- Create the strings in accordance with the needs of the attached device.
- The state of the RS-232 control lines does not affect transmission of RS-232 strings.

Considerations for receiving RS-232 strings:
- The player reports the most recently received string in the Items tab on its Setup > Player > RS-232 Outputs page.
- The state of the RS-232 control lines does not affect reception of RS-232 strings.

4.4 Displaying Part of a Movie or Web Page

You can configure a movie or HTML item in a playlist to display only a part of its output.

This is useful if you want to:
- Show a specific area of a movie or web page without resizing it.
- Crop a movie designed for a 16:9 (widescreen) format to a 4:3 (standard) format. This avoids resizing the zone, which would alter the aspect ratio and distort the image.

To display only part of a movie item, modify the values for its Movie Size property (see Movie Properties for details).
To display only part of an HTML item, modify the values for its Web Page Size property (see HTML Properties for details).

4.5 Changing the Screen Background

When switching between layouts, you can have the player display a coloured background or image. It can also display this background in any areas of a layout that are not covered by zones.

**Note:** Setting the colour to black is not recommended because it makes fault-finding more difficult.

To change the screen background, follow these steps:

1. On the menu bar, click Media and Screen Background.
2. Select either Solid colour or Image:
   - If you select Solid Colour, then click the Pick Colour button to select a colour.
   - If you select Image, then browse the file system for an image. If you want a splash screen effect, set the Layout Activation option to Activate new Layout after and select the delay from the drop-down list.
3. Click the Save Changes button.
Part V
Ad Hoc Content
Part 5: Ad Hoc Content

The Ad hoc feature allows you to delegate limited control of content to staff local to the display. This is particularly useful where several players share the same channel but also need some customised content. The people at each location can make those changes with a quick and easy, browser-based operation.

Local control of content is important in a wide range of application areas:

- In an office, a secretary or office administrator can display welcome messages for visitors or display staff information.
- On a university campus with multiple displays, different information may need to be delivered to different faculties about upcoming events, room allocations, and so on.
- In the retail sector, store information and special offer details will vary from branch to branch.
- In health care, patient information and other details will vary in different hospitals or GP practices in the same health authority area.

As the content designer, you delimit how much access is allowed at each site. You retain control of the key display elements to maintain a consistent appearance and uniform identity for your organisation.

The ad hoc environment consists of these components:

- **Ad hoc user** – The person, usually at the display location, who has limited access and can update or change only the content items you specify.
- **Ad hoc entry** – Is where ad hoc users log in through their browser, access pages that are available to them, and make their changes.
- **Ad hoc media folders** – Contain all the media files that the ad hoc user can use when updating or changing content.

You can delegate local responsibility for several different types of content:

- Text
- Tables
- Newsfeeds
- TV channels, radio stations, and streaming TV
- Folders

You can allow ad hoc users to update customisable content you have added to a playlist or update content they create in the layouts you have allowed them to access.

As well as giving such access to content, you can also allow ad hoc users to:

- Change complete layouts.
- Change display schedules.
- Perform schedule overrides.
- Synchronise content.

You can also delegate control of a channel to an ad hoc user. In this case, you designate certain items as Ad hoc from Centre. This allows the ad hoc user to update those items on the CMS and in turn that updates each subscribing player.
Part 5: Ad Hoc Content

The ad hoc system is secure: no ad hoc user can make changes unless you specify the customisable item and give the user permission to access it.

5.1 Enhanced Ad Hoc Access Control

Generating ad hoc content is quick and easy. As the content designer, you can build-in ad hoc content during implementation of your design. Alternatively, you can work with an existing design and allocate ad hoc content as required. Whichever route you choose, the overall time taken for generating display content is minimised. Ad hoc users can be working with the system productively with minimum delay.

Automatic Ad Hoc:

By default, the CMS enables automatic ad hoc for all newly-created layouts. You can control whether it is disabled or enabled with the Layout Ad hoc Page setting on the layout's Layout Properties tab.

Automatic ad hoc makes creating content easier, as it eliminates many of the configuration and setup tasks. The layout automatically creates a single ad hoc page, which contains all ad hoc playlist Items in the layout. As you add or remove ad hoc items, the CMS automatically adds or removes them from the layout ad hoc page.

You have full control over ad hoc pages, including specifying which users are or are not authorised to make changes. However, you cannot add or remove existing ad hoc Items or reference ad hoc Items in other layouts. Therefore, automatic ad hoc is unsuitable if you want multiple layouts to use the same ad hoc item.

Manual Ad Hoc:

Manual ad hoc gives you complete responsibility for creating and managing all ad hoc pages and the items within them. You need to add ad hoc Items to one or more playlists and one or more ad hoc pages, as required.

You must create an ad hoc item before you can add it to a playlist. Similarly, you must create an ad hoc page and add one or more ad hoc items to it before it can be used by ad hoc users.

In manual ad hoc mode, you can create ad hoc pages that contain ad hoc items added to multiple layout playlists. For example, this is useful if you want to show the same ad hoc welcome message on multiple layouts.

Creating Ad Hoc Content as You Build Your Design:

Create your layout in the normal way:

1. On the menu bar, click Layouts and Manage Layouts.
2. Click the Add Layout tab.
3. Enter a name for the layout and click the Add button.
4. Locate your new layout on the Layouts page and click its Edit button.
5. Create the zones you require and enable them to play the ad hoc media items you want to add.
6. Click the Save button and select Save all changes and edit Playlist from the drop-down list.
You can now add ad hoc items. The way in which you do this depends on the type of ad hoc item you want to add:

| Text | 1. On the playlist's page, click the Specials tab and enter the text you wish to be displayed.  
2. Check the **Content of this item can be customised using this Layout's Ad hoc Entry Page** box.  
3. Click the ![Add](image) button.  
4. Click the ![Edit](image) button and set the item's **Customisation Scope**:  
   - **Local** – Only for the individual subscriber.  
   - **Remote** – For all the subscribers to this channel. |
|---|---|
| Tables | You should have already created and formatted the ad hoc table you require.  
1. On the playlist's page, click the Specials tab.  
2. From the **Table Item** drop-down list, select the table you want.  
3. Click the ![Add](image) button.  
4. Click the table's ![Edit](image) button.  
5. Click the ![Save Changes and change Item Type](image) button.  
6. Check the **Use an existing Ad Hoc Item** button and select the table from the drop-down list.  
7. Click the ![Save Changes](image) button. |
| Newsfeeds | You should have already configured the newsfeed you require.  
1. On the playlist's page, click the Specials tab.  
2. From the **Newsfeed** drop-down list, select the newsfeed you want.  
3. Check the **Content of this item can be customised using this Layout's Ad hoc Entry Page** box.  
4. Click the ![Add](image) button.  
5. If you want to further configure the item's ad hoc options, click the ![Edit](image) button. |
| TV and Radio Stations | You should have already added the TV and radio stations. For radio, you must enable the layout's soundtrack.  
1. On the playlist's page, click the Specials tab.  
2. Take the action appropriate to the type of station you want:  
   - **TV** – From the **Live Video** drop-down list, select the station you want.  
   - **Radio** – From the **Live Radio** drop-down list, select the station you want.  
3. Check the **Content of this item can be customised using this Layout's Ad hoc Entry Page** box.  
4. Click the ![Add](image) button.  
5. If you want to further configure the item's ad hoc options, click the ![Edit](image) button. |

**Converting an Existing Design to Ad hoc Content:**

You can create ad hoc content after you have completed a design. To create ad hoc content in an existing design, the process is the same as in each case above. You need to disable **Automatic Ad Hoc** in the **Layout Properties** tab.
Creating Ad Hoc Pages:
When ad hoc users log on, their Home page displays the Ad Hoc Pages you create. Ad hoc users cannot access any other player user interface pages. You design the ad hoc pages to display only the text fields ad hoc users can change or the commands they are allowed to issue.

To create an ad hoc page:
1. On the menu bar, click Media and select Design Pages > Manage Ad hoc Pages.
2. Click the Add Page tab.
3. Enter a name for the page. Use a name that will be easily recognizable by your ad hoc users.
4. Click the Add button.
5. Click the page's Edit button.
6. Select the item you require from the drop-down list and click the Add button.
7. To add more ad hoc items, click the Add Item tab again. Rearrange the order of items using the  and  buttons.
8. Click the Properties tab. Add any instructive text in the User Guidance Message field and select the users you want to be able to see this ad hoc page.
9. Click the Save Changes button.

5.2 Remote Keypad Control
For convenience and ease of use, ad hoc users can control their local player using an infrared remote keypad. This enables them to change content at the touch of a button instead of having to access the player by their browser.

The remote keypad has the following controls:

- **Volume** (up and down) – Adjusts the master volume level in 10% divisions.
- **Station** (up and down) – Controls the ad hoc TV and radio stations played. The user can scroll up and down the station list.
- **Programmable buttons** (A, B, C, and D) – Each can be programmed to correspond to a specific rendezvous point or layout.

When the user presses a button, the player displays a status message at the top right of the screen.

To allow ad hoc users to control the display with the remote keypad, take these steps:
1. On the menu bar, click Layouts and select the one the remote keypad will control.
2. Click the Interaction tab.
3. For each button, check the action required:
   - **No default Button Action** – Check for the player to take no action when the user presses this button.
   - **When button is pressed Advance to Rendezvous Point** – Check to assign a rendezvous point to this button. Choose the zones you allow the ad hoc user to control.
   - **When button is pressed change to Layout** – Check to assign a layout to this button. Ad hoc users press this button to switch the display to that layout.
To allow ad hoc users to choose TV or radio stations, take these steps:

1. On the menu bar, click Media and Manage Ad hoc items.
2. Click the Add Item tab.
3. From the Add Ad hoc Item of Type drop-down list, select TV or Radio.
4. Enter a name for the item and click the Add button.
5. In the Ad hoc Item property Allowed Choices, select one of:
   - All Available TV or Radio Stations – Allows ad hoc users to select from any TV or radio station configured on the player.
   - Only Selected TV or Radio Stations – Allows ad hoc users to select from the TV or radio stations you choose.
5. Select the default TV or radio station from the Default TV or Radio Station drop-down list.

### 5.3 Additional Ad Hoc

Additional Ad Hoc features allow for greater customisation of layout content. This is particularly useful in a channel, where a network of players all play the same content.

Using additional ad hoc, multiple players in a channel can each show different content, controlled by ad hoc users locally. This allows an organisation to maintain a consistent appearance or brand image across a number of sites, while allowing local users to upload their own content and change the layouts and playlists to which they have been given access.

The content types that can be used with additional ad hoc include:

- Folder play
- Layout
- Schedule
- Schedule override
- Advance To

Folder play allows you to add a folder to a playlist and give ad hoc users permission to upload their own content into the folder. For example, different GP practices with players in the same channel could carry different local information about late night dispensing chemists.

Layouts allow the ad hoc user to select a layout for a specific time slot in the schedule. Typically, if an organisation published a channel with a layout for each department, an ad hoc user in each department could select the right layout for that location.

Schedule allows the ad hoc user to set the time when a layout should appear on the display. For example, if a lunch hour layout has been scheduled, but times vary at different locations, local ad hoc users can set their times accordingly.

Schedule override allows the ad hoc user to display one of a selection of predefined layouts and not have this interrupted by any other layout changes in the schedule. For example, this can be used to show a special TV event or display an emergency message without interruption.
**Advance To** allows the ad hoc user on-demand control in several areas, including content selection. For example, this might be useful in a foyer where the player is showing a corporate video in a continuous loop. The **Ad hoc Advance To** command allows a local user to switch to live TV if required.

The following two procedures describe:

- Setting up an ad hoc schedule override.
- Setting up an ad hoc **Advance To** command.

**Ad Hoc Schedule Override:**

To set up an ad hoc schedule override and make it available to ad hoc users:

1. On the menu bar, click **Schedules**.
2. Select the channel name and **Manage Schedules**.
3. Click the **Add Override** tab.
4. Enter a descriptive name for the override.
5. Select the audio, screen, and layout options from the drop-down lists.
6. Click the **Add Override** button.
7. On the menu bar, click **Media** and **Manage Ad hoc items**.
8. Click the **Add Item** tab.
9. Enter a name for the override in the **Add Ad Hoc Schedule Override** field and click the **Add** button.
10. In the **Allowed Choices** panel, select one of the following:
    - **All Available Schedule Overrides** – Allows ad hoc users to select from any schedule overrides configured on the player.
    - **Only Selected Schedule Overrides** – Allows ad hoc users to select only from the schedule overrides you select.
11. Select the appropriate **Customisation Scope** option:
    - **Local** – Customisation applies on the individual player.
    - **Remote** – Customisation applies on each player in the channel.
12. Click the **Save Changes** button.

**Ad Hoc Advance To Command:**

To set up an ad hoc **Advance To** command:

1. On the menu bar, click **Help** and **UI Options**.
2. Select the **User Interface Policy** as **Detailed** or **Expert**.
3. Click **Playlists** and select the layout and zone to locate the **Advance To** command.
4. Click the **Specials** tab.
5. Add a rendezvous point to the playlist and give it a name.
6. Add one or more media items to the playlist.
7. Click the **Specials** tab.
8. Select the Advance To item that has the same name as the rendezvous point you created and add it to the playlist. This causes the playlist to loop back to the start again, regardless of what may follow.

9. Add a second rendezvous point to the playlist.

10. Add one or more ad hoc media items to the playlist.

11. Add the Advance To command that has the same name as the second rendezvous point to the playlist. This causes the playlist to loop continuously through the ad hoc media items. If you want to revert back to the original media items, omit this step.

12. On the Manage Ad hoc Items page, create an ad hoc Advance To item and select the names of the two rendezvous points you have created.

13. Add those ad hoc Advance To items to an ad hoc page.

14. Log in as an ad hoc user and browse to the ad hoc page you have created.

15. Select the Advance To command that you wish to test and click the Save button. If the player is playing the playlist, it will jump to the point in the playlist under the selected rendezvous point.

5.4 Ad Hoc from Centre

The Update from Centre feature allows ad hoc users to make changes on a CMS that will be updated to the channel’s subscribers. The ad hoc users on the CMS can only change the content on the ad hoc page you create.

You can use the Update from Centre feature with ad hoc text and schedule override items. When you create an ad hoc from centre item, you set its scope as one of:

- **Local** – Default. Ad hoc text items behave as normal. Ad hoc users can log in and change the contents for each player.
- **Remote** – Ad hoc items will only be visible to ad hoc users on the CMS. Changing the ad hoc item on the CMS causes updates to all subscribers too. To restore the original schedule, select Default Schedule from the Ad hoc page.

Subscriber players may not normally check for updates often enough if the ad hoc from centre changes are frequent. Therefore, you can configure the subscriber players to check for update from centre items more frequently. On the subscriber, the Channels > Manage Subscription page offers the Update From Centre Poll Interval option. This determines how often the subscriber polls for update from centre items and changes accordingly. The subscriber player checks for normal updates and for updates from centre independently.

5.5 Managing Ad Hoc Items

The ad hoc items page allows you to create, delete, and set properties for ad hoc items. Reach that page from the menu bar by clicking Media and Manage Ad hoc Items.

To create an ad hoc item, click the Add Item tab. Select the item type from the drop-down list or select one of the other types displayed and enter a unique name for it.

To delete an ad hoc item, click the button. If the CMS does not display the item’s button, it is in use and cannot be deleted. To see which items are in use, click the button and look at the Used By Layouts and Used by Ad hoc Pages information.
When you add an ad hoc item, you can also set a range of properties, depending on the item. The CMS supports these item types:

- Advance To
- Layout
- Newsfeed
- Schedule
- Schedule override
- Text
- TV
- Radio

When you add an item, you have to select one of these **Allowed Choices** options:

- **All Available** – Permits the ad hoc user to choose any of the defined items.
- **Only Selected** – Permits the ad hoc user to choose only those items you select.

In addition, for schedule override and text items, the CMS offers you the **Customisation Scope** option. Use this to select where those ad hoc items can be customised and displayed:

- **Local** – Customisation applies on the individual player.
- **Remote** – Customisation applies on each player in the channel.

Text also has its own set of ad hoc options. Use these to control what an ad hoc user can enter in the **Default Text** and **Ad hoc User** pages:

- **Rich text** – No validation is performed.
- **Plain text** – An ad hoc user cannot customise the text colour or styling.
- **Integer between** – Enter the lower and upper integer limits (both inclusive) for ad hoc content. This option is only shown if you have set the **User Interface Policy** to **Detailed**.
- **Plain text of maximum length** – Limits the maximum length of plain text. This option is only shown if you have set the **User Interface Policy** to **Detailed**.
- **Plain text matching** – This option is only shown if you have set the **User Interface Policy** to **Detailed**.
- **Regular Expression** – The ad hoc content must match the regular expression that you provide. There are many web sites and books that provide information about using regular expressions. For example: [http://www.regular-expressions.info/javascript.html](http://www.regular-expressions.info/javascript.html).
- **Feedback Message** – Enter a message to display if the ad hoc user text does not match the regular expression you provided.
- **Default Text** – Enter the default text to use until an ad hoc user makes a change on the **Ad hoc Data Entry** page. Your default text must be compatible with the ad hoc input mode you have selected.
- **Customisation Status** – Indicates if the ad hoc user has overridden the default value or not.

### 5.6 Creating Ad Hoc User Accounts

If you want a user on a subscriber player to update ad hoc channel content, you must create an ad hoc user account for them on the subscriber. If you want a user on a CMS to be responsible for ad hoc from centre content, you must create an ad hoc user account for them on the CMS.
To creating an ad hoc user account, take the following steps:

1. On the menu bar, click **Setup** and select **System > Users**.
2. Click the **Add User** tab.
3. Enter a username and a password. By default, the CMS provides the user with the **Ad Hoc** permission.
4. Click the **Add User** button.
5. On the **Users** page, click the new account’s **Edit** button.
6. Select the other permissions the user needs. As well as the **Ad hoc** permission, options here include **Publish Channel**. If the user requires access to an ad hoc media folder, select the folder name from the **Media Folder** drop-down list.
7. Click the **Save Changes** button.

### 5.7 Ad Hoc Pages

When ad hoc users access the CMS using their browser, they only see the pages you have created for them. The CMS does not allow ad hoc users access to any other pages in the CMS user interface. The CMS displays ad hoc pages with the text fields you have allowed ad hoc users to change or the commands you have allowed them to issue. You can give ad hoc users access to the ad hoc media folder, which contains all the items that they can choose from when updating or changing content.

By default, the CMS enables ad hoc pages for all layouts when you create them. This means that when you add customisable or ad hoc items to a layout, the CMS generates an ad hoc page for that layout containing all the customisable and ad hoc items within it.

You can also create ad hoc pages that are not directly associated with a specific layout following these steps:

1. On the menu bar, click **Help** and **UI Options**.
2. For the **User Interface Policy** option, select **Detailed** or **Expert**.
3. Click the **Save Changes** button.
4. On the menu bar, click **Media** and select **Design Pages > Manage Ad Hoc Pages**.
5. Click the **Add Page** tab.
6. Enter a unique name for the ad hoc page.
7. Click the **Add** button.

#### 5.7.1 Managing Ad Hoc Pages

To view or modify an ad hoc page, follow these steps:

1. On the menu bar, click **Media** and select **Design Pages > Manage Ad Hoc Pages**.
2. Click the page’s **Edit** button.

To delete an ad hoc page, follow the same procedure and click the **Delete** button. If the CMS does not display the page’s **Delete** button, it is in use and cannot be deleted. Also, you cannot delete layout ad hoc pages, only disable them on the **Layout Properties** tab.
5.7.2 Editing Ad Hoc Pages

The edit ad hoc page lists all the items you have added to the page that an ad hoc user can change.

*Note:* Click the **Ad hoc Entry Page** link at the top of the page to navigate to the **Data Entry** page.

The CMS displays these tabs:

- **Items** – Shows the items on the page and allows you to modify them.
- **Add Items** – Allows you to add new items to the page (not shown for layouts automatically managing ad hoc pages).
- **Properties** – Allows you to change the page name, the user message, and the users allowed to change items on it.

**Items:**

To remove an ad hoc item, click its  

*Note:* This is not available on layouts that automatically manage ad hoc pages.

On pages with multiple items, you can adjust their order using these buttons:

-  – Move the item to the top.
-  – Move the item up one place.
-  – Move the item down one place.
-  – Move the item to the bottom.

**Add Item:**

To add an ad hoc item to the page, click the **Add Items** tab and follow these steps:

1. Select the item from the **Add Ad hoc Item** drop-down list.
   
   *Note:* You can have only one ad hoc **Schedule Override** item on an ad hoc page.

2. Click the  button.

3. Perform other actions on the **Items** tab. Move the item or click its  button to add a label to show next to it on the **Data Entry** page.

**Properties:**

The options on the **Properties** tab are:

- **Page Name** – Unique identifier for the ad hoc page. The CMS displays it on the **Data Entry** page.
- **User Guidance Message** – Optional. Enter a message for the CMS to display on the **Data Entry** page to help users when entering values.
- **Users allowed to Enter Data** – Select the users who have permission to view and make changes to the **Data Entry** page (users with **Layout Manager** permission can view and modify all ad hoc **Data Entry** pages).

5.8 Ad Hoc Folder Play

You can add a folder to a playlist and then give ad hoc users permission to upload their own content into that folder. For example, you might develop a layout for an education authority with a zone dedicated to showing student artwork
that is published to subscriber player units in each school: each school uploads its local artwork to the ad hoc folder so the content of the zone is unique to that school.

Your ad hoc folder must contain at least one default item that is shown until ad hoc users upload content. Even if you republish the channel, local content remains in place (unless you have removed the folder from the playlist).

To add an ad hoc folder to a playlist follow these steps:
1. On the menu bar, click **Playlists** and select the layout and zone where you want to add the folder.
2. Click the **Files & Folders** tab.
3. Click the **Add** button for the folder you want to add to the playlist.
4. Click the **Playlist** tab and, if necessary, adjust the item order.
5. Click the folder's **Edit** button.
6. Check the **Management** box.
7. Click the **Save Changes** button.

The CMS creates a subfolder in the **ad_hoc_media** folder with the same name as the folder you added in step 3. Put any default ad hoc content into that subfolder. The player will display the content in that subfolder rather than the content in the original folder. Your ad hoc users can add to or delete content from that subfolder as required. However, if you or your ad hoc users leave the ad hoc subfolder empty, the player will display the content in the original folder you added to the playlist.

### 5.9 Ad Hoc Media Folder

You designate ad hoc media folders to delimit the media folders that ad hoc users can access. Go to the **Media > Files & Folders** page to create folders and to browse the file system.

To allow an ad hoc user to access a media folder, you must add it to the playlist and then enable it for the ad hoc user. If suitable material is available in the folder, the player plays it in preference to any other. If no suitable media is available, the player plays the content of the default folder for that playlist instead.

You must create an ad hoc folder for the user to upload content to. If you see the message ‘No Media Folder has been configured for this user’, you need to designate a media folder for the user’s account. Do so by following these steps:

1. On the menu bar, click **Setup** and select **System > Users**.
2. Click the user’s **Edit** button.
3. Select the folder from the **Media Folder** drop-down list.
4. Click the **Save Changes** button.

### 5.9 Changing Ad Hoc Content

If you want to change the ad hoc content currently playing on the player, the general steps to follow are:

1. Connect to the player with your browser
2. On the menu bar, click **Ad hoc Entry**.
3. Select the ad hoc page for the content you want to change.
4. Make the necessary changes (see table below for details).
Part 5: Ad Hoc Content

5. If the player is playing the item, click the **Show Now and Save Changes** button. Your change takes effect immediately.

6. If the player is not playing the item, click the **Save Changes** button. Your change takes effect when the player next plays the item.

7. Exit your browser to leave the player.

In more detail, how you make your change depends on the ad hoc item concerned. Follow the steps for the ad hoc item you want to change:

<table>
<thead>
<tr>
<th>Text and Tables</th>
<th>Change the text scrolling across the screen or in a table:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. On the menu bar, click <strong>Ad hoc Entry</strong>.</td>
</tr>
<tr>
<td></td>
<td>2. Select the ad hoc page for the content you want to change.</td>
</tr>
<tr>
<td></td>
<td>3. Edit the text or table entry. Tips:</td>
</tr>
<tr>
<td></td>
<td>○ To remove text from the screen, delete everything in the box.</td>
</tr>
<tr>
<td></td>
<td>○ To create a line break in vertically scrolling text, press the Enter key at the location required.</td>
</tr>
<tr>
<td></td>
<td>4. Click the <strong>Show Now and Save Changes</strong> or <strong>Save Changes</strong> button.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TV Stations</th>
<th>Change the TV station showing on the screen:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. On the menu bar, click <strong>Ad hoc Entry</strong>.</td>
</tr>
<tr>
<td></td>
<td>2. Select the ad hoc page for the content you want to change.</td>
</tr>
<tr>
<td></td>
<td>3. Select the new TV channel from the drop-down list</td>
</tr>
<tr>
<td></td>
<td>4. Click the <strong>Show Now and Save Changes</strong> or <strong>Save Changes</strong> button.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Radio Stations</th>
<th>Change the radio station:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. On the menu bar, click <strong>Ad hoc Entry</strong>.</td>
</tr>
<tr>
<td></td>
<td>2. Select the ad hoc page for the content you want to change.</td>
</tr>
<tr>
<td></td>
<td>3. Select the new radio station from the drop-down list</td>
</tr>
<tr>
<td></td>
<td>4. Click the <strong>Show Now and Save Changes</strong> or <strong>Save Changes</strong> button.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Newsfeeds</th>
<th>Change the source for a newsfeed showing on the screen:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. On the menu bar, click <strong>Ad hoc Entry</strong>.</td>
</tr>
<tr>
<td></td>
<td>2. Select the ad hoc page for the content you want to change.</td>
</tr>
<tr>
<td></td>
<td>3. Select the new newsfeed from the drop-down list.</td>
</tr>
<tr>
<td></td>
<td>4. Click the <strong>Show Now and Save Changes</strong> or <strong>Save Changes</strong> button.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Media Folders</th>
<th>Manage media items (typically, still images held in a folder) showing on the screen:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. On the menu bar, click <strong>Ad hoc Entry</strong>.</td>
</tr>
<tr>
<td></td>
<td>2. Select <strong>Media Folder</strong>. The player shows the contents of your media folder.</td>
</tr>
<tr>
<td></td>
<td>3. To view a file, click its name.</td>
</tr>
<tr>
<td></td>
<td>4. To upload a new file or manage the existing files, see <strong>Uploading Content Files</strong>.</td>
</tr>
<tr>
<td></td>
<td>5. To change the order in which files play, see <strong>Folder Play Properties</strong>.</td>
</tr>
</tbody>
</table>
### Screen Layouts
Change the whole layout (this assumes you have already added an ad hoc layout to the ad hoc page):

1. On the menu bar, click **Ad hoc Entry**.
2. Select the ad hoc page relevant to the layout you want to change.
3. Select the new layout from the drop-down list.
4. Click the **ShowNow and Save Changes** or **Save Changes** button.

### Scheduling
Change the schedule for when the player makes changes to the display (for example, to coincide with meal or break times or for an after-hours event):

1. On the menu bar, click **Ad hoc Entry**.
2. Select the ad hoc page relevant to the schedule you want to change.
3. Modify the schedule using the drop-down lists and check boxes.
4. Click the **ShowNow and Save Changes** or **Save Changes** button.

If the current time is within your new schedule, the player triggers the change immediately (unless it has already begun another schedule).

If the schedule has related audio or you require silence, reprogram the audio on or off time to match.

### Advance To (on demand)
Activate events on demand (for example, to show a video selected from a list):

1. On the menu bar, click **Ad hoc Entry**.
2. Select the ad hoc page relevant to the **Advance To** command you want to invoke.
3. Select the relevant name from the drop-down list.
4. Click the **ShowNow and Save Changes** or **Save Changes** button.

---

### 5.10 Ad Hoc Theming

You can change how the user interface appears to your ad hoc users by using **Ad hoc Theming**. Ad hoc theming lets you customise page headers and the text that appears on the page.

You might use ad hoc theming to:

- Include a company logo in a page to make it consistent with a brand identity.
- Provide a translation of pages in a language not already supported on the player.

The ad hoc theme applies to ad hoc users on the CMS or on a player subscribing through a channel. You cannot include ad hoc themes in layout packages.
To access the **Ad hoc theme** page, click on **Media** and select **Manage Ad hoc Theme**. Create your theming features using the following tabs:

<table>
<thead>
<tr>
<th>Properties</th>
<th>Select the options you require:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ad Hoc Theme</strong></td>
<td>- Choose the <strong>Disabled</strong> button to retain the default appearance. Choose the <strong>Enabled</strong> button to use the theme you are customising.</td>
</tr>
<tr>
<td><strong>Header text colour</strong></td>
<td>- Click the <strong>Pick Colour</strong> button to select a different header text colour.</td>
</tr>
<tr>
<td><strong>Header background colour</strong></td>
<td>- Click the <strong>Pick Colour</strong> button to select a different header background colour.</td>
</tr>
<tr>
<td><strong>Page logo</strong></td>
<td>- Select the <strong>Alignment</strong> option for the position you want the logo to have on the page.</td>
</tr>
<tr>
<td></td>
<td>Select the logo image from the files displayed. If your logo file is not there, navigate through the folders to where it is located or click the <strong>Files &amp; Folder</strong> link to upload it.</td>
</tr>
<tr>
<td></td>
<td>When complete, click the <strong>Save Changes</strong> button.</td>
</tr>
</tbody>
</table>

**Strings**

Allows you to provide either translations or alternative text for all the headers, boxes, instructions, and warnings that appear in three ad hoc areas:

- **Homepage**
- **Ad hoc Item Edit Pages**
- **Media Folder**

The CMS displays the default text on the left. Enter your new text in the field on the right.

When complete, click the **Save Changes** button.
Part VI

Sharing Content Using Layout Packages
Part 6: Sharing Content Using Layout Packages

A Layout Package is a single file which contains all the media and control files required to fully install one or more layouts on another CMS.

You can distribute layout packages on DVDs, by memory sticks, through file servers, or sent by email.

Transferring layouts from one CMS to another is a two-step process:
1. Create the layout package on the originating CMS.
2. Upload and install the layout package on the destination CMS.

6.1 Layout Packages

The Layout Packages page allows you to create, delete, and install layout packages.

The Layout Packages tab lists all the layout packages available on the CMS. Click the button next to a layout package to take these actions:

- Delete the layout package. This only removes the layout package file (not any media or layouts you have already installed).
- Display information about the layout package content.
- Install: Copy the layouts and media contained in the package onto the CMS. If any of those items already exist on the CMS, but have different values, you are asked how you want conflicts handled (see Layout Package Conflicts for details).

Click the Create tab to display the options for creating a new layout package:

- **Name** – Unique identifier for the layout package. In the name, you can only use the characters a-z and A-Z, the numbers 0-9, or a space.
- **Description** – Optional. A description for the layout package.
- **Include Layouts** – Select the layouts you want in the layout package.

Click the Status tab to see information about layout package operations. The CMS only displays the Status tab if you have started a layout package operation or have completed one previously.

6.2 Creating a Layout Package

To create a layout package, follow these steps:
1. Finalise the layout or layouts that you will include in the layout package.
2. On the menu bar, click Layouts and Layout Packages.
3. Click the Create tab.
4. Enter a suitable name and optionally a description for the new layout package.
5. Check the box next to each layout to include in the package.

*Note:* The CMS also includes layouts referenced by Change Layout commands even if you do not select those layouts explicitly here.
6. Click the Create Layout Package button. The CMS displays the Status tab.

7. When the layout package creation completes, click the Package Filename link and follow the prompts on the pop-up screen to save the package file on your computer.

8. Send copies of the layout package ZIP file to those who need them.

### 6.3 Uploading and Installing a Layout Package

To upload and install a layout package on your CMS, follow these steps:

1. On the menu bar, click Layouts and Layout Packages.

2. Click the Browse button and navigate to the layout package file on your computer.

3. Click the Upload button to copy the file onto the CMS. The CMS displays a progress bar during upload.

4. After uploading, the CMS displays the layout package in the list.

5. Click the layout package's Install button. If items in the package have the same name as items already on the CMS, the CMS prompts you to resolve the conflict (see Layout Package Conflicts for more details).

   **Note:** Layout packages are compressed ZIP files. The CMS does not list other types of file on the layout package page.

You can also copy layout packages to and from the CMS by using an FTP client (for example, Internet Explorer) on your computer. Browse to the /HOME/package folder on the CMS.

### 6.4 Layout Package Conflicts

When you install a layout package, the CMS merges items in the package with existing items. This includes:

- Layouts
- Special items
- Ad hoc items
- Ad hoc pages
- Media files

The CMS flags a conflict when an item in the package is identical to an existing item, but has different property values. You are prompted to resolve the conflict with one of these options:

- **Do Not Copy** – The CMS will not change the existing items. This is equivalent to not copying any conflicting items or files from the layout package. The CMS installs all non-conflicting items.

- **Copy and Replace** – The CMS will replace existing items with items from the layout package. This is equivalent to the CMS overwriting the local items.

- **Copy but Keep Both Items** – The CMS renames the items in the layout package to avoid conflicts with existing items. The CMS displays the new names on the Status tab.

The CMS may offer different conflict actions for media files and layout and special items.

In some cases, selecting Copy but Keep Both Items may cause additional items to be in conflict. For example, if an ad hoc text item is in conflict and is contained in a layout that exists locally, but is identical, and you choose the Copy but Keep Both Items option, the CMS renames the ad hoc text item. This causes the layout in the layout package to be modified to reference the newly renamed ad hoc text item. This in turn causes a layout conflict, since
the local layout and the modified layout are now different. The CMS shows additional, secondary conflicts on a separate line in the **Conflict Details** section.

Click the ![Install Layout Package](image) button to proceed with the Installation or the ![Cancel Install](image) button to stop the installation process.

### 6.5 Layout Package Information

To see information about a layout package, follow these steps:

1. On the menu bar, click **Layouts** and **Layout Packages**.
2. Click the layout package's ![ ](image) button.

The CMS displays this information:

- The originating CMS.
- Layouts included in the package.
- Special Items included in the package.
- Other additional settings (such as colour items and special fonts).
- Media item files in the package.

This information may help you resolve any conflicts between items in the package and those already on your CMS.
Part VII

Channels and Signage Networks
Part 7: Channels and Signage Networks

Channels provide an easy way to display the same content at multiple locations by setting up a digital signage network of players. A collection of players that all play the same content on their screens is known as a channel.

A channel has these basic parts:
- The CMS.
- The content that the CMS publishes.
- One or more subscriber players.

When you publish to a channel, it includes all the related schedules, layouts, and media content. You should consider these factors when calculating the storage space required for a channel:
- With the exception of video files, content does not require large amounts of storage. If your layouts do not include video files, you should find 1 GB to 2 GB of space sufficient.
- If your layouts include video files, increase storage by at least 2 GB per hour of standard quality video. Allow for more if the video is high quality.
- The CMS displays the size of the channel on its Channels > Detailed Status page. Allow at least twice that on the subscriber player as it stores the channel twice: once to subscribe and again to display.

However, the channel does not include:
- Any custom fonts you have installed.
- User records, including ad hoc users.

If your content relies on either of the above, you will need to ensure they are already present on each of the subscribers.

Also consider the capabilities of the subscriber units in your network:
- Are they powerful enough to show the content? Some content may not show optimally on less powerful player models (for example, high-resolution movies or Adobe Flash items that require a fast CPU).
- What resolution are their attached screens? Ideally, to display the same content you should have screens set to the same resolution. If some screens display at lower resolution, take into account that content will be cropped.
- Do they have any additional hardware or licenses required? Subscribers can only display certain content if they are configured to do so (for example, TV channels)?

To set up and begin using a channel, follow these general steps:

1. Create the content on the CMS.
2. When your content is ready, click the Manage Channels Page link that appears at the top of each screen on your CMS. The CMS displays the Manage Channels page. Specify your channel configuration here (see Configuring the Channel for more details).
3. Click the appropriate publish button on the Manage Channels page. The CMS will not distribute changes to a channel until you publish them. See Publishing a Channel for details of the publishing options.

Repeat those steps for each additional channel you want to create (see Multichannel Publishing for more details).

You will now need to configure each player in your network in the Subscriber role, pointing them to the correct location to find the channel content to display.
Part 7: Channels and Signage Networks

**Important:** The CMS user account you specify in the subscriber configuration must have the **Subscribe Channel** permission.

After a period, the subscriber players will poll for channel content, download it, and begin displaying it on the screens they control.

Some other features may be of interest to you:

- Control the timing and circumstances of publication. You can configure the CMS to publish a channel regularly or only when you initiate publication manually. You can also specify that changed content is only published after an approval process. See **Publishing Mode and Policy** for more details.

- Add ad hoc content to your channel. This provides content that varies on a per player basis. For example, if you have players on different sites, you may wish to allow local users to display messages specific to their location. You will need to provide the users on the subscriber players with the appropriate ad hoc permissions. See **Ad Hoc Content** for more details.

- Distribute channel content using a separate Channel Content Server (CCS). You might consider adding one or more CCSs to your digital signage network depending on the configuration scenarios you need to support. See **Channel Content Servers** for more details.

  **Note:** It is recommended that the CMS and each subscriber player run the same software version. Earlier version subscribers may not be able to display content created on the CMS.

## 7.1 Publishing

The CMS provides a wide range of features for you to configure and publish multiple channels to exactly meet the needs of your digital signage network.

Refer to the topic that describes the task you wish to perform:

- **Configuring the Channel**
- **Publishing a Channel**
- **Multichannel Publishing**
- **Managing Channels**

### 7.1.1 Publishing Mode and Policy

Before you begin to configure a channel, you need to decide on the **Publish Mode** and the **Publish Policy** you will adopt:

- **Publish Mode** – Defines the method of publication.
- **Publish Policy** – Controls how the CMS allows publication of changes.

The publish mode and the publish policy interact so you should carefully consider the publication regime you require. The CMS prompts you to select the publish options when you add a channel. You can change your selection later by editing the channel configuration (see **Configuring the Channel** for details).

The CMS offers two **Publish Mode** options:

- **Manual** – The CMS only publishes the channel when you click a button on the **Manage Channels** page. You can only set a publish policy if you choose this option.
- **Automatic** – The CMS publishes the channel at the time of day or at the frequency you configure. Because it is automatic, you cannot set a publish policy if you choose this option.
The CMS offers two Publish Policy options:

- **Allow at any time** – The CMS allows any user to publish changes at any time.
- **Allow only after change complete notification** – The CMS only allows publication after you complete an approval notification.

Choosing the second option enables you to include a review and approval process in your content development and publication workflow. You have to approve changes to the channel by clicking its button on the Manage Channels page and completing the Notify Content screen, which looks like this:

![Notify Content Screen](image)

The Notify Content screen has these features:

- **Channel Name** – Confirms the name of the channel whose changes you are approving.
- **Change Note** – You must enter a note to approve the changes (the button is not activated until you do). If necessary, this field automatically expands to accommodate the length of note as you write. You can also expand it by dragging the expansion icon at the bottom right.

Click the button to confirm your approval. The CMS will now allow publication of the changes.

### 7.1.2 Configuring the Channel

To configure a channel for publication, from the menu bar click Channels and Manage Channels.

When you first access the Manage Channels page, the display looks similar to this:

![Manage Channels Page](image)

Refer to Managing Channels for a description and explanation of all the Manage Channels features.
Now, to configure the channel for publication, click the button. The CMS displays the Edit Channel page. Complete the following settings and click the button:

| **Channel Name** | Enter a unique name for the channel. This appears at the top of the page on the subscriber and in the CMS Channels Details column. |
| **Description** | Optional. A meaningful description to further identify the channel and its content. |
| **Publish Mode** | Select the mode of publication you want:  
  - **Manual** – You publish by clicking a button on the Manage Channels page. Selecting this mode enables the Publish Policy options.  
  - **Automatic** – The CMS publishes at the time you specify. Selecting this mode enables the Publish options. |
| **Publish Policy** | Only enabled if you set Publish Mode to Manual. Select the publication policy you want:  
  - **Allow at any time** – Allows the channel to be published at any time (whether it has changed or not).  
  - **Allow only after change complete notification** – Prevents a change to the channel being published until the user completes a notification. Use this as a change control mechanism. |
| **Publish** | Only enabled if you set Publish Mode to Automatic. Select the time you want the CMS to publish the channel:  
  - **at** – Publish each day at the time you choose (00:00 is midnight).  
  - **every** – Publish regularly at the interval you choose (in hours and minutes).  
  **Important:** Before choosing the timing, take into account when the CMS is publishing other channels in your configuration. Consider staggering the timings to balance the load on the CMS and on your network. |
| **Channel Server** | Select how you want to publish the channel:  
  - **The CMS/channel/1 folder** – The CMS publishes the channel to one of its own channel folders. The CMS displays the folder details on the Manage Channels page. Subscribers access the content through FTP, HTTP, or HTTPS.  
  - **The USB Flash Memory's / channel folder** – The CMS publishes the channel to the channel folder on an attached USB stick.  
  - **FTP Site** – The CMS uploads the channel to an FTP site. If you need to provide a username and password, do so in the Authentication panel. |
| **Publishing Root URL** | If you chose to publish using the FTP Site option, the CMS enables this box. Enter the URL required.  
  A valid FTP URL begins with `ftp://` followed by the host name or address and the full path to the publication location. Examples of valid FTP URLs are:  
  - `ftp://example.com/mychannel/`  
  - `ftp://192.168.0.23/channel/`  
  - `ftp://somehost/a/b/c/`  
  Note these points:  
  - If the folders do not exist on the FTP server, the CMS attempts to create them. This will fail if you do not provide a login name and password with appropriate write access.  
  - To test the setup, the CMS attempts to log into the FTP server you have defined. It notifies you if this is successful or not. |
### 7.1.3 Publishing a Channel

After configuring the channel for publication, you are ready to publish and activate it. You can add and publish additional channels later.

*Note:* If you are publishing to a USB stick, insert that into the CMS before beginning. Ensure it has the capacity to hold the channel content.

Before continuing, it is important to understand the distinction between publish and activate:

- **Publish** – When the CMS copies the channel content to the publication location you specified.
- **Activate** – When the subscribers start displaying the channel.

You can specify that activation takes place later than publication. In other words, the CMS will publish the channel but subscribers will not display it until after the date and time you specify. This is useful to ensure all subscribers start showing the channel content at the same time (rather than as soon as they can download it). For example, you can use this to allow for the difference in time it takes several subscribers to download large media files over a slow network.

To publish and activate the channel, follow these steps:

1. On the menu bar, click **Channels**.
2. Click **Manage Channels**.
3. In the channel’s **Actions** column, click the button for the publishing option you require:
   - ![Publish] – Publish and activate as soon as possible.
   - ![Publish Later] – Publish and activate later. The CMS prompts you for the date and time after which to activate.

The CMS begins the copying process and displays progress in the channel’s **State** column. If there is a problem, the CMS displays an error message. After copying is complete, how the subscriber receives the new content depends on where you chose to publish the channel:

- **CMS channel folder or external server** – The subscribers will download the new content the next time they check the channel.
- **USB stick** – Remove the USB stick and use it to load the channel content onto each subscriber.

Repeat the same process even if you have only changed the schedule. In all cases, the CMS displays the following banner if you have changed the channel contents but have not yet published it:

> Channels have changed. Please go to the Manage Channels page to see more details on required actions.
If you are not on the **Manage Channels** page, clicking the **Manage Channels Page** link takes you there. To publish the new content, follow the same steps as described above.

The **Manage Channels** page provides you with all of the features you need to add, edit, and delete channels. It also displays status information on each channel. You can also access detailed information on each channel by following these steps:

1. On the menu bar, click **Channels**.
2. Select **Detailed Status**. The CMS displays the list of channel names.
3. Click the name of the channel whose status you want to check.

The **Detailed Status** page contains this information:

- **Publisher State** – The current publication state of the channel.
- **Channel** – Channel identifier information including publication timestamp and activation details.
- **Required Version** – If relevant, indicates the minimum software version the players must be running to display the channel.
- **Size** – The size of the channel content sent so far, its total size, and the status of delivery progress.

### 7.1.4 Multichannel Publishing

CMS allows you to create and publish up to 50 channels simultaneously.

*Note:* Although schedules are unique to each channel, more than one channel can share layouts and contents.

To add a new channel, follow these steps:

1. If required, create the layout and content for the new channel.
2. On the menu bar, click **Channels** and **Manage Channels**.
3. Click the [Add Channel] button.
4. Complete the **Settings** and **Schedule** information the CMS prompts you for.
5. When you are ready to publish the channel, follow the same steps as described in **Publishing a Channel**.

To delete a channel, follow these steps:

1. On the menu bar, click **Channels** and **Manage Channels**.
2. If the channel you want to delete is the only one, configure another channel. You cannot delete the last channel on the CMS.
3. Click the [ ] button next to the channel you want to delete. This only deletes the channel schedule: the channel content is still on the CMS.

For more information about the tasks you can perform through the **Manage Channels** page, see **Managing Channels**.
7.1.5 Managing Channels

You manage the channels on your CMS through the Manage Channels page.

To understand the tasks you can perform using the Manage Channels page, this illustration shows its essential features, which are described below:

![Manage Channels Page Illustration]

The header options are:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Add Channel</strong></td>
<td>Click to configure a new channel on your CMS. The Add Channels wizard prompts you for the basic channel settings and schedule configuration (see Configuring the Channel for details).</td>
</tr>
</tbody>
</table>
| **Publish Listed Channels** | Click to publish all the channels listed in the display. Channels will not be published if:  
- They are not listed in the display (that is, the current filter excludes them).  
- Their Publish Policy requires a notification and one has not been completed after a change. |
| **Filter**           | Limit which channels are or are not displayed in the table. Enter a string in the Filter field and the CMS limits the display to the channels whose name matches that string. You can also select a filtering option (either alone or in combination with the Filter string):  
- All – Default. Displays all channels.  
- Previewed – Displays only the channels that the CMS has published to the preview location.  
- Publishing – Displays only the channels that the CMS is currently publishing.  
- Attention Required – Displays only the channels that require your attention (for example, those that have yet to be published after you have changed them). |
The table lists each channel under these headers:

<table>
<thead>
<tr>
<th>Actions</th>
<th>Click the button to perform the action indicated:</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Delete]</td>
<td>– Delete the channel.</td>
</tr>
<tr>
<td>![Edit]</td>
<td>– Edit the channel configuration.</td>
</tr>
<tr>
<td>![Notify]</td>
<td>– Notify a change. Only shown if the channel <strong>Publish Policy</strong> requires a change notification. After you notify the change, the CMS displays the ![Publish] button. Click that to undo your notification or click the ![Undo Notify] or ![Publish] button to publish the changed channel.</td>
</tr>
<tr>
<td>![Publish]</td>
<td>– Publish the channel to the preview location, /channel/preview. Configure a player to subscribe to that location to preview the content before you publish it on a live channel. The CMS displays the preview location in the <strong>Channel Details</strong> column and the preview icon in the <strong>State</strong> column.</td>
</tr>
<tr>
<td>![Publish]</td>
<td>– Publish the channel and activate as soon as possible.</td>
</tr>
<tr>
<td>![Publish]</td>
<td>– Publish the channel and activate later. The CMS prompts you for the date and time after which to activate.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Channel Details</th>
<th>Contains this information:</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Channel Name]</td>
<td>– Click the link to open the channel's detailed status page.</td>
</tr>
<tr>
<td>![Description]</td>
<td>– If provided, the additional channel description.</td>
</tr>
<tr>
<td>![Publish To]</td>
<td>– Indicates the publication location.</td>
</tr>
<tr>
<td>![Compatible Version]</td>
<td>– If relevant, indicates the minimum software version the players must be running to display this channel.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>State</th>
<th>Contains this information:</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Last Publish]</td>
<td>– Date and time the CMS last automatically published the channel or when you did so manually.</td>
</tr>
<tr>
<td>![Activate After]</td>
<td>– If you set the channel to activate later, the CMS also displays this entry to show the date and time you specified.</td>
</tr>
<tr>
<td>![Next Publish]</td>
<td>– Indicates the type and date and time of the next publication:</td>
</tr>
<tr>
<td>![Auto]</td>
<td>○ – Automatic publication on the date and time indicated.</td>
</tr>
<tr>
<td>![Manual]</td>
<td>○ – Manual publication on a date and time you choose.</td>
</tr>
</tbody>
</table>

The CMS also displays dynamic status information, examples include:

- **During publication** – Displays progress with a cumulative percentage, file, and byte count.
- **After you change the channel** – Displays this prompt:

  ![Settings edited. Please publish](https://www.onelan.com/assets/images/settings_edited.png)

- **After you change the channel and a notification is required** – Displays this prompt:

  ![Work in progress](https://www.onelan.com/assets/images/work_in_progress.png)

- **After a required change notification is completed** – Displays this prompt (hover on the ![Notification] icon to see the notification and which user provided it):

  ![Work completed. Please publish](https://www.onelan.com/assets/images/work_completed.png)
### Content Management System User Guide

<table>
<thead>
<tr>
<th>Current Schedule</th>
<th>Displays the name of the channel's schedule. Click the Manage link to open the Manage Schedules page.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid Until</td>
<td>Displays the schedule's Valid Until setting. If the CMS is not showing all the schedule entries, it displays the icon. Click that icon to reveal the additional schedule entries.</td>
</tr>
</tbody>
</table>
| Schedule Entries | Contains this information:  
  - **Name** of the layout shown for each schedule entry. Click the link to open the layout editor.  
  - The layout's canvas size.  
  - An icon showing the zones in each layout (click a zone to open its playlist): ![Zones Icon](image)  
  - If the CMS is not showing all the schedule entries, it displays the icon. Click that icon to reveal the additional schedule entries.  
  Click the Manage link if you want to edit the schedule settings. |

## 7.2 Channel Ad Hoc

Using ad hoc content within a channel enables you to allow users to show their own content on their local player while still showing the rest of the channel.

Create ad hoc content in the same way as you would a normal part of a layout. Local ad hoc users can then log into their subscriber player and change that content.

Ad hoc from centre is similar to regular ad hoc in that it allows a user to log in to change an element of the signage display quickly and easily. However, instead of the user making ad hoc changes on the subscriber player, with ad hoc from centre the user can make changes on the CMS. Consequently, the subscribers to that CMS upload the ad hoc from centre changes to the channel. When configuring those subscribers, you might want to set their polling interval to a shorter period so that ad hoc from centre updates arrive more quickly.

### 7.3 Channel Content Servers

The CMS itself is a channel content server. However, in certain situations, a better solution might be to use an external file server.

An alternative is to use an external Channel Content Server (CCS) to offload channel distribution processing from your CMS. Each subscriber playerpolls the CCS for the latest channel content in the same way it would poll the CMS directly.
How you publish your channels depends on the number of subscriber players and the network they are connected to:

<table>
<thead>
<tr>
<th>How to Publish</th>
<th>Description</th>
<th>When Would You Use This Method?</th>
</tr>
</thead>
<tbody>
<tr>
<td>On the CMS</td>
<td>You store channel files on the CMS and subscribers download them using HTTP, HTTPS (recommended), or FTP.</td>
<td>You have up to 500 subscribers in a network with no special network topology requirements.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The CMS bandwidth limiting feature is there to help as the numbers approach that limit (see <em>Firewall</em> for more details).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This method requires no extra hardware.</td>
</tr>
<tr>
<td>Using a USB memory</td>
<td>You publish channel files onto USB memory sticks. You distribute the sticks to each subscriber, which automatically reads the channel from it.</td>
<td>Your subscribers are not connected to a network or you do not want to publish the channel through a network.</td>
</tr>
<tr>
<td>stick</td>
<td>You have to perform this process every time you update the channel.</td>
<td></td>
</tr>
<tr>
<td>Using an external CCS</td>
<td>You use the CMS to publish content to an external CCS using FTP. The CCS makes the files available to the subscribers, either through HTTP, HTTPS (recommended), or FTP.</td>
<td>One or more of these factors is true:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>Access to the subscriber domain is limited for security reasons.</em></td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>Groups of content need to be physically separated from each other.</em></td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>Content needs to be locally cached to reduce network congestion or to prevent consumption of expensive bandwidth.</em></td>
</tr>
<tr>
<td></td>
<td></td>
<td>This method:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>Allows you to create the network structure you need.</em></td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>Easily ties this into your existing server hardware or web host.</em></td>
</tr>
</tbody>
</table>

When planning how to publish, you should bear in mind these network and bandwidth considerations:

- Using a CCS requires both the CMS and the subscriber to be able to connect to it through a local network or the internet.

- Using network-based publication will not work if there is a problem with connectivity or if the credentials provided by the subscriber for either the CMS or the CCS are incorrect.

- Bandwidth use depends on the layouts and media being published as well as the number of subscribers. Large media files take time to transfer and this increases the time before the subscribers begin playing the channel. However, after the subscriber downloads the media, it will only need to download new or updated items later.

- Subscribers periodically poll the publishing source for channel updates. If you do not update your channel frequently, then save bandwidth by decreasing the rate at which the subscribers check for new content. You need to balance this with it taking longer for the subscribers to display new content when you do change it.
Part VIII

System Status
Part 8: System Status

Use the Status options to access information about the system.

Select the menu item for the status information you want to access:

- **System** – Viewing the disk and CPU temperatures over time, general system status, and hardware specification.
- **Conditional Play** – Checking the items that are subject to conditional play.

### 8.1 System Status

The System status page provides details of the environmental performance of your CMS.

Select the tab for the option you require:

- **°C 24 Hours** – Viewing disk and CPU temperatures from the last 24 hours.
- **°C 30 Days** – Viewing disk and CPU temperatures from the last 30 days.
- **Status** – Viewing uptime, temperature, Ethernet, and memory metrics.
- **Hardware** – Viewing CMS processor specification and memory capacity.
- **CPU Load** – Viewing a graph of the processor loading.

**°C 24 Hours:**

Illustrates disk and CPU temperatures from the previous 24 hours on separate graphs. Green lines indicate the safe temperature range and red where the temperature is too high.

Beneath each graph, notes indicate the maximum temperature during the period and the shut down temperature. The CMS shuts itself down if the disk temperature exceeds 50 °C for more than 5 minutes.

**°C 30 Days:**

As above except covering the previous 30 days.

**Status:**

The display contains the following information (some systems do not report all items):

<table>
<thead>
<tr>
<th><strong>CMS Uptime</strong></th>
<th>How long the CMS has been running since its last restart.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Disk Temperature</strong></td>
<td>Current disk temperature</td>
</tr>
<tr>
<td><strong>CPU Temperature</strong></td>
<td>Current CPU temperature.</td>
</tr>
<tr>
<td><strong>CPU Fan Speed</strong></td>
<td>Speed of CPU cooling fan (in RPM).</td>
</tr>
<tr>
<td><strong>Case Fan Speed</strong></td>
<td>Speed of system cooling fan (in RPM).</td>
</tr>
<tr>
<td><strong>Ethernet Receive</strong></td>
<td>Total inbound network traffic (in bytes and packets) and number of errors.</td>
</tr>
<tr>
<td><strong>Ethernet Transmit</strong></td>
<td>Total outbound network traffic (in bytes and packets) and number of errors.</td>
</tr>
<tr>
<td><strong>System Disk</strong></td>
<td>How much system disk space used of how much available.</td>
</tr>
<tr>
<td><strong>Data Disk</strong></td>
<td>How much data disk space used of how much available</td>
</tr>
</tbody>
</table>
Part 8: System Status

Hardware:
The display contains the following information:

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU Make, model, and speed of CMS processor.</td>
<td></td>
</tr>
<tr>
<td>Available Memory</td>
<td>Amount of CMS main memory.</td>
</tr>
<tr>
<td>CMOS Signature</td>
<td>Support may request this value.</td>
</tr>
</tbody>
</table>

CPU Load:
The display contains the following information:

- The average percentage CPU load over the previous 10 seconds.
- A rolling graph of processor load sampled every second.

8.2 Conditional Play Status

The Conditional Play status page summarises the playlists or schedules with the Conditional Play property set.

The page displays details of the items that you have configured to play conditionally along with the result. If you have not added the required player local information for those conditions, the CMS displays an action message containing a link you can follow to add the missing name.

The rest of the page is split into two tabs, one each for Playlist Items and Schedule. Each tab displays:

- Details of the PLI name on which the item depends.
- The operation that the player executes to decide if the item plays.
- The values that the item contains and the current values in the PLI.

The CMS displays links to the required items: click the link to go to the page you need to access.
Part IX

Setup
Part 9: Setup

Use the Setup options to configure and check the operational features of your CMS.

Select the menu item for the option you require:

- **System Setup** – Configuring the administrative and infrastructure aspects of the CMS system.
- **Player Setup** – Configuring the RS-232 and interactivity characteristics you want the player to support.
- **Maintenance & Troubleshooting** – Performing backup, update, and support activities.

9.1 Help and User Options

Use the Help menu to access the CMS user interface options, page-specific help, and the user guide.

Use the Help > UI Options page to set the CMS user interface options. Those options are on these tabs:

- **My Options** – Changing user interface behaviour (these changes only apply to the user interface you see).
- **Shared Options** – Adding a title on every page of the user interface (this change applies to the user interface for all users).

When you have completed making your changes, click the [Save Changes] button to enable them.

To change the general options, select from the following:

<table>
<thead>
<tr>
<th>User Interface Policy</th>
<th>Select the display mode you want:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- <strong>Productive</strong> – Displays only the most commonly used features.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Detailed</strong> – Displays both commonly used and advanced features.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Expert</strong> – Displays commonly used, advanced, and expert features. Take care if you use this mode.</td>
</tr>
</tbody>
</table>

To change the Time & Date Display options, select from the following:

<table>
<thead>
<tr>
<th>Time Style</th>
<th>Select the time format you prefer: <strong>Locale Specific</strong> means the format matches the language option you have set on your browser.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Separator</td>
<td>A colon is the default. Enter another character to use as an alternative. The CMS ignores this setting if you have selected the <strong>Locale Specific</strong> option from the Time Style menu.</td>
</tr>
<tr>
<td>Date Style</td>
<td>Select the date format you prefer: <strong>Locale Specific</strong> means the format matches the language option you have set on your browser. Check the Show last 5 days as day name instead of date box if you want the CMS to display recent days by name (for example, 'Monday') rather than by numeric date.</td>
</tr>
<tr>
<td>Date Separator</td>
<td>A hyphen is the default. Enter another character to use as an alternative. The CMS ignores this setting if you have selected the <strong>Locale Specific</strong> option from the Date Style menu.</td>
</tr>
<tr>
<td>Month Style</td>
<td>Select how you prefer to see the month expressed.</td>
</tr>
</tbody>
</table>
To change the **Advanced** options, select from the following:

| Layout Editing | Select how you want to edit layouts:  
| --- | ---  
|  | • **Graphical Layout Editing** – Direct editing including use of drag-and-drop.  
|  | • **Non-Graphical Layout Editing** – Indirect editing by entering values. May be needed if your browser does not support direct editing.  
| Playlist Add Item | Select where you want the CMS to add new items to a playlist:  
| --- | ---  
|  | • **At Top** – Items are added to the top of a playlist.  
|  | • **At Bottom** – Items are added to the bottom of a playlist.  
|  | After the items are added, you can move them into whichever position you wish.  
| Drop Down Menu Display Mode | Select the menu behaviour you want:  
| --- | ---  
|  | • **Menu is shown when hovered over** – Menu expands when you hover your cursor over it.  
|  | • **Menu will show when clicked** – Menu expands when you click it.  

### 9.2 System Setup

Use the **Setup > System** options to configure and check the operational features of your CMS.

Select the menu item for the option you require:

- **Users** – Adding and managing user accounts.  
- **Date & Time** – Specifying time source and time zone.  
- **Network** – Setting up and testing the network connection.  
- **TV & Radio** – Setting up TV and radio stations.  
- **HTTP Proxy** – Setting up proxy server access.  
- **Security** – Configuring firewall and secure access services.  
- **Player Local Information** – Adding customised data items to the player.  
- **Reporting** – Configuring the CMS to report to the network’s **Digital Signage Manager** (DSM).  
- **Licensing** – Managing your software licenses.

#### 9.2.1 Users

Use the **Users** options to add and manage CMS user accounts.

Click the tab for the option you require:

- **Users** – Listing the users and their permissions. Click the button to delete a user (you cannot delete the current user). Click the button to change the user settings.  
- **Add Users** – Adding a new user.

The CMS displays the same settings whether you are adding a new user or editing an existing one.
To add or change a user account, complete the following settings and click the [Add User] or [Save Changes] button:

<table>
<thead>
<tr>
<th>Username</th>
<th>The name the user logs in with (for example, 'remote', or 'chef'). This must be unique on this CMS. Follow the on-screen guidance on how to compose the username.</th>
</tr>
</thead>
</table>
| Permissions | Check the boxes next to the permissions you wish to grant the user:  
  - **System Settings** – Access to the Status and Setup pages. Access to the Media page (newsfeeds and fonts only). Access to the Manage Channels page (add, edit, and delete channels only).  
  - **Layout Manager** – Access to the Media, Playlists, Manage Layouts, and Manage Schedules pages. Access to the Manage Channels page (view only except for the links to the current schedule and schedule entries). Access to the Status pages.  
  - **Publish Channel** – Access to the Manage Channels page (preview, publish and activate, and view channel details). The user also requires the Subscribe Channel permission to enable the published channel to be read by subscribers.  
  - **Ad Hoc** – Access to the Ad Hoc Entry page (not the ad hoc content design pages). The user can read, write, and modify files in the folder you select from the Media Folder drop-down list. You must select a specific folder and not All Folders.  
  - **FTP Read/Write** – Read, write, and delete files in the Media folder and all its subfolders using FTP.  
  - **Status Monitor** – Access to the System status and Manage Channels pages (view only).  
  - **Layout Editor** – Access to the Media page (tables, and colours, files & folders only). Access to the Layouts and Playlists pages of the layouts you have permitted the user to edit. Grant edit permission on the layout Properties tab.  
  - **Subscribe Channel** – Enables a channel published by the user to be read by subscribers. The user also requires the Publish Channel permission to publish the channel.  
  - **XML Control** – Access to the XML message interface allowing non-browser based control of the CMS. (Does not allow access to pages.) |
| Media Folder | Select the user's FTP home and ad hoc media folder from the drop-down list. This prevents users from accessing any folders above the one you specify when they log in through FTP or through the Ad hoc Media Folder page. |
| Password | The user's password. Repeat in the Password Confirm field.  
  **Note:** You cannot retrieve passwords. If users forget their password, you have to give them a new one. It is strongly recommended you change the factory-supplied password for the remote user. |

### 9.2.2 Date & Time

Use the **Date & Time** options to configure the time source and time zone for your CMS.

Click the tab for the option you require:

- **Settings** – Configuring the time source and time zone.
- **Status** – Checking current Network Time Protocol (NTP) characteristics.
Settings:

To configure the time settings, complete the following options then click the [Save Changes] button and reboot the CMS:

<table>
<thead>
<tr>
<th>Date and Time Settings</th>
<th>Choose the time method to use:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <strong>Network Time Protocol (NTP)</strong> – Best for accuracy but requires the CMS to have a network connection to an external NTP server.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Windows Compatible Network Time Protocol</strong> – Use if the NTP server is a local Windows server.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Local System Clock</strong> – The CMS internal clock. Only use if the CMS cannot access an NTP server. Without an external reference, the local system clock may drift.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Time Zone Setting</th>
<th>Select the time zone for the CMS to use.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Local System Clock Settings</th>
<th>If you chose the <strong>Local System Clock</strong> method, the CMS activates this display. The values shown are those current when you opened the Date &amp; Time page. Adjust the date and time to those required.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Network Time Protocol (NTP) Settings</th>
<th>If you chose one of the NTP methods, you must enter the URL of at least one NTP server (three are recommended).</th>
</tr>
</thead>
</table>

*Note:* The CMS will only synchronise to NTP server time if the NTP time and the local system time are within a few minutes of each other. If the difference is greater, reboot the CMS to synchronise times again.

Status:

Not displayed if you have chosen **Local System Clock**. Shows the latest characteristics of each of the NTP servers you have designated. This example shows the characteristics of the active time source:

<table>
<thead>
<tr>
<th>Server</th>
<th>IP address</th>
<th>Offset</th>
<th>Jitter</th>
<th>Status</th>
<th>Last event</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Time Server</td>
<td>178.254.20.157</td>
<td>-1.647</td>
<td>3.449ms</td>
<td><strong>Active time source</strong></td>
<td>sys_peer</td>
</tr>
</tbody>
</table>

9.2.3 Network

Use the **Network** options to configure, check, and test the CMS network connection.

*Note:* The CMS displays its active IP address in large text on the splash screen during the boot up process.

Click the tab for the options you require:

- **Ethernet** – Configuring IP address and DNS settings.
- **Network Status** – Checking current IP address and DNS values.
- **Tests** – Running ping, trace, DNS lookup, and TCP dump tests.
Ethernet:

To configure IP addressing, complete the following information then click the [Save Changes] button and reboot the CMS:

<table>
<thead>
<tr>
<th>Ethernet Settings</th>
<th>Select how the CMS obtains its IP address:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• DHCP – Select if the CMS will obtain its IP address from a DHCP server on your network. If the CMS cannot find a DHCP server, it defaults to an IP address of 169.254.1.1.</td>
</tr>
<tr>
<td></td>
<td>• Static – Select if you are specifying an IP address for the CMS. Enter it in the IP Address field. If you select this option, the CMS enables the Static Address Settings and Static DNS Settings fields.</td>
</tr>
<tr>
<td></td>
<td>Caution: If you are using a static address in combination with an LDAP security configuration, you must specify a valid DNS Nameserver. Failure to do so will make your CMS inaccessible.</td>
</tr>
</tbody>
</table>

| DHCP Setting | Optional. For ease of reference, enter a name for the CMS. Only available if your DHCP server supports this feature. |
| Static Address Settings | If you selected the Static Ethernet setting, enter the addresses required: |
|                   | • IP Address – Enter the IP address for the CMS. |
|                   | • Netmask – Specify the address range for the CMS subnet. |
|                   | • Default Gateway – Enter the gateway IP address if the CMS uses one. |

| Static DNS Settings | If you selected the Static Ethernet setting, enter the addresses required: |
|                   | • DNS Search Path – Enter the path needed to reach the Domain Name Server (DNS). |
|                   | • DNS Nameserver – Enter the IP addresses of up to three DNS nameservers. |

Network Status:

Displays the current network connection status and values.

Tests:

In each case, start the test by entering the host’s name or IP address and clicking the [Run] button:

| Ping Host | Ping the host. |
| Trace Route | Trace the route to the host. This can take a few minutes to complete. |
| DNS Lookup | See the host's details held on the DNS. |
| TCP Dump | Collect IP packets for the number of seconds you specify. |

9.2.4 TV & Radio

Use the TV & Radio options to enable the CMS to use TV and radio stations in playlists.

Click the tab for the option you require:

- Digital Tuner Stations – Adding and editing digital TV and radio station names.
- Streaming TV & Radio – Specifying and checking multicast addresses.
**Digital Tuner Stations:**

Click the button for the type of station you want to add:

- **Add TV Station** – Adding a TV station.
- **Add Radio Station** – Adding a radio station.

In each case, the CMS prompts you to enter a name for the station. You must enter the exact name of the station the player can receive, matching any upper or lowercase characters. Click the **Add** button to finish. The CMS then:

- Adds the TV station name to the **Live Video** drop-down menu. Access that menu on the playlist **Specials** tab for zones with the **Movie** player enabled.

- Adds the radio station name to the **Live Radio** drop-down menu. Access that menu on the playlist **Specials** tab for layouts with the **Soundtrack** property enabled.

You can now add TV or radio stations to playlists. Before adding a station, ensure that the player has the appropriate license and that it can tune into the station's signal (see TV for more on the required player set up).

The **Digital Tuner Stations** tab lists the stations you have added. Click the button to perform the action indicated:

- **Delete** – Delete the station.
- **Edit** – Change the station name. Click the **Edit** button when you have completed the change.

**Streaming TV and Radio:**

If the player cannot receive a TV signal directly, it might be able to receive it by multicast streams using the local network. The player decodes the multicast stream and displays the TV image in a zone in the normal way.

If you want to use multicast streams to provide TV to the player there are these requirements:

- The player has the appropriate license.
- There is a streaming transmit server to convert the TV signals into multicast packets.
- If your CMS and the player are on different networks, the streaming addresses must be the same.
- All routers and switches on the local network between the streaming transmit server and each player are enabled for multicast streaming.
- There is sufficient network capacity to efficiently support multicast streaming.

*Note:* There may be copyright issues involved in rebroadcasting material onto a local network.

Click the **Status** tab to display a list of stations available through streaming.

Click the **Settings** tab to specify the multicast address by following these steps:

1. In a blank field, enter the IP address on which to receive the Service Advertising Protocol (SAP) packets. Valid addresses are between 224.0.0.0 and 239.255.255.255.

2. If required, enter additional addresses in the remaining fields. You can specify up to six addresses.

3. Click the **Save** button.
9.2.5 HTTP Proxy

Use the HTTP Proxy page to set up proxy server access if the CMS needs to use one to access Internet resources. Check with your network administrator to see if a proxy is needed.

To use a proxy for accessing an Internet resource, you must perform both of the following actions:

- Set up the HTTP proxy by completing the information on the Add HTTP Proxy tab.
- Specify that the CMS must use a HTTP proxy when you setup individual Internet resources (for example, a newsfeed).

After you have configured the HTTP proxy, specify that the CMS uses it on the relevant setup page:

- Newsfeed – Setup for the individual newsfeed on the Media > Newsfeeds page.
- Reporting – Setup on the Setup > System > Reporting page.
- Software update – Setup on the Setup > Maintenance & Troubleshooting > Software Update page (Settings tab).

The CMS does not transfer a proxy configuration in a channel.

**Note:** Newsfeeds do not support use of Microsoft® NTLM authentication. We recommend changing the Windows proxy to allow Digest authentication. You must restart the CMS when you make any changes to the HTTP proxies.

To configure the HTTP proxy, complete the following information then click the Add and Restart button:

<table>
<thead>
<tr>
<th>Server Address</th>
<th>Enter the IP address of the proxy server.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Port</td>
<td>Enter the port the CMS needs to connect to on the proxy server (default is 3128).</td>
</tr>
<tr>
<td>Username</td>
<td>If the proxy server requires authentication, enter the username.</td>
</tr>
<tr>
<td>Password</td>
<td>If the proxy server requires authentication, enter the password.</td>
</tr>
<tr>
<td>Use this proxy for</td>
<td>Check the box for each resource the CMS needs to use the proxy for.</td>
</tr>
</tbody>
</table>

9.2.6 Security – General Settings

Use the Security options to configure the CMS firewall and other security services and to monitor firewall activity.

**Caution:** The CMS comes ready-prepared with default firewall and other security service settings to protect against unauthorised access. Do not change the security settings unless you have a good working knowledge of IP networking and network security. Incorrect configuration can block all access to the CMS.

The CMS firewall protects it against unwanted and potentially malicious traffic. However, the CMS also needs to accept your login and allow necessary communications. To allow and protect such access, the CMS supports a variety of secure services:

- VPN – Virtual Private Network. Allows the CMS to communicate over an encrypted path through firewalls.
- HTTP/HTTPS – Hypertext Transfer Protocol and Hypertext Transfer Protocol Secure. By default, the CMS uses HTTP with Digest authentication, which encrypts passwords. HTTPS is more secure because it also encrypts content.
- FTP – File Transfer Protocol. FTP access is controlled by password. Passwords are not encrypted. Use FTP for copying over backups and software updates.
Part 9: Setup

- **SSH** – Secure Shell. Only used to access the CMS operating system for occasional support and maintenance purposes. Access is by the master password.

You can configure each of those to match the specific security needs of your network or to conform to corporate policy on port numbering.

Click the tab for the option you require:

- **Firewall** – Examining and configuring the firewall and other security services settings.
- **Master Password** – Changing the CMS master password.
- **LDAP Expert** – Entering XML-based LDAP parameters. (Only displayed if you have set the **User Interface Policy** to **Expert**.)
- **Firewall Status** – Monitoring the detailed firewall activity report.
- **LDAP Tests** – Testing your LDAP configuration.
- **SSL Certificates** – Using customised Secure Socket Layer certificates.

**Firewall:**

The **Firewall** tab allows you to examine and configure the firewall and other security service settings.

To change your security settings, complete the relevant options then click the **Save Security Settings** button and reboot the CMS:

<table>
<thead>
<tr>
<th>Firewall Service Settings</th>
<th>IP Address Filtering – Default: Disabled. Check this box to prevent any access to the CMS except from the <strong>Allowed IP Addresses</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Allowed IP Addresses</strong> – Enter the IP addresses that can access the CMS, not forgetting to include your own. To allow more than eight IP addresses, specify a range using the standard syntax (for example, entering 192.168.1.0/24 allows access for all IP addresses between 192.168.1.0 and 192.168.1.255).</td>
</tr>
</tbody>
</table>
|                           | **HTTP Service Settings** | Authentication – Default: HTTP Authentication. For a more secure authentication method, and to enable explicit sign out from the CMS session, take these steps:  
  - Select **Form-based Authentication**.  
  - Change **Supported Protocols** to **HTTPS**.  
  - On the **SSL Certificates** tab, detail the SSL certificate to use. |
|                           | Supported Protocols – Default: HTTP and HTTPS. Select either **HTTP** or **HTTPS** to restrict access to that protocol. You cannot manage the CMS without either HTTP or HTTPS enabled. |
|                           | Bandwidth Limit – If you want to limit the bandwidth available to particular ports, specify it here (in whole numbers of mebibytes per second). This allows you to differentiate the quality of service on a per-port basis (for example, restricting bandwidth for subscriber downloads). Do not restrict bandwidth on the ports through which users log in to the user interface. |
|                           | HTTP Ports – Default: 80. Modify or add if you want your CMS to accept HTTP connections through different ports. Check the **Limit Bandwidth** box to restrict the bandwidth available to the port. |
|                           | HTTPS Ports – Default: 443. Modify or add if you want your CMS to accept HTTPS connections through different ports. Check the **Limit Bandwidth** box to restrict the bandwidth available to the port. |
FTP Service Settings

- **Service State** – Default: Enabled. Uncheck this box to disable FTP access.
- **Supported Protocols** – Default: FTP. There are no other options.
- **FTP Ports** – Default: 21. Modify or add if you want your CMS to accept FTP connections through a different port.
- **Passive Port Range** – Default: 59000-59009. Modify the Low Port and High Port values to specify a different range.
- **Transfer Rate** – Default: Limit to 10000 Kibit/s. Modify the Limit to value to specify a different transfer rate (in whole numbers of kibibits per second).

SSH Service Settings

- **SSH Ports** – Default: 22. Modify or add if you want your CMS to accept FTP connections through a different port.

Movie Player Unicast Listener Service Settings

- **Service State** – Default: Disabled. Check this box to enable the unicast listener service.
- **Listening Ports** – Specify the ports the CMS listens on.

Master Password:

The Master Password tab allows you to change the master password. You need the master password to access the CMS operating system through SSH.

*Note:* This is not the same password you use to login to the CMS through a browser.

It may be desirable to change the master password, but you must know the existing one to do so. Please contact your reseller or supplier for the master password.

To enable the new password, you must click the [Change Master Password] button and reboot the CMS.

LDAP:

See [Security – Advanced LDAP Settings](#) for details.

LDAP Expert:

See [Security – Advanced LDAP Settings](#) for details.

Firewall Status:

The Firewall Status tab displays the detailed CMS firewall activity report.

Understanding the information in that report requires a good working knowledge of IP networking and network security. In particular, note these points:

- The **Chain PLAYER-INPUT** section details the rules governing connections made to the CMS on various protocols.
- The CMS checks the IP address of incoming connections against the **Chain PLAYER-INPUT-ADDRESSES** rule set. The CMS drops connections from IP addresses disallowed by the security settings.
- The CMS checks allowed connections against the **Chain PLAYER-INPUT-PORTS** rule set. The CMS drops connections to a port disallowed by the security settings.
- The **Pkts** (packets) and **Bytes** columns show the volume of traffic accepted or rejected by each rule. An unusually high number of packets on a **DROP** line might indicate an attack on the CMS.
LDAP Tests:
Run the LDAP test to check your current LDAP settings and to receive feedback on any problems.

Recommendation: Always test any change to the LDAP settings before rebooting the CMS.

To run a test:
1. Enter the name of the target CMS user in the Test Username field.
2. Click the Test LDAP Settings button.

The test results are displayed in two parts:
- A table showing the status of each step.
- A detailed log.

When you have a correct setup, and the CMS username is valid, the LDAP test returns the Passed status. To correct any indicated problems, check the user permissions and change the associated LDAP settings.

The CMS performs the following tests and indicates any failures as well as displaying detailed log messages:

<table>
<thead>
<tr>
<th>Tests</th>
<th>Checks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bind to LDAP server</td>
<td>Configuration and Bind sections</td>
</tr>
<tr>
<td>Search for FTP user</td>
<td>FTP User section</td>
</tr>
<tr>
<td>FTP Read/Write Access</td>
<td>FTP User section User Filter</td>
</tr>
<tr>
<td>Search for HTTP user</td>
<td>HTTP User section</td>
</tr>
<tr>
<td>Find HTTP user</td>
<td>HTTP User section</td>
</tr>
<tr>
<td>Search for group membership</td>
<td>HTTP Permissions section</td>
</tr>
<tr>
<td>Ad hoc Permissions</td>
<td>Ad hoc Users section</td>
</tr>
</tbody>
</table>

SSL Certificates:
If you want to use customised SSL certificates, rather than the default certificates, follow these steps:
1. Select the Use Custom SSL certificates for the Web Server option.
2. Enter your Certificate, Key, and CA Chain values in the relevant fields.
3. Click the Save Changes button and reboot the CMS.

9.2.7 Security – Advanced LDAP Settings
The CMS Security page includes tabs to allow you to configure and test LDAP:
- LDAP Expert – Entering XML-based LDAP parameters. (Only displayed if you have set the User Interface Policy to Expert.)
- LDAP Tests – Testing your LDAP configuration.
**Caution:** Do not use LDAP to control security for the CMS unless you have expertise with LDAP implementations. LDAP is a powerful technology and enabling a misconceived configuration can make the CMS unusable.

Before beginning to configure security for the CMS using the options on the LDAP and LDAP Expert tabs, read through the guidance that follows. When you have completed your configuration, click on the LDAP Tests tab to test it before rebooting the CMS (see LDAP Tests for details).

To begin with, it is important to understand the difference between the CMS and the LDAP security models:

- The basic CMS security model prevents access to system features unless a user is authenticated and has explicit permissions.
- In the LDAP security model, a user is considered to have permission if an LDAP filter matches entries in the directory. Typically, an LDAP filter establishes that a user is a member of a group.

**Caution:** If you use LDAP, the authentication method switches to HTTP Basic authentication (passwords are not encrypted). If this is a concern, communicate over HTTPS.

What follows is guidance for completing each of the fields on the LDAP tab:

- **Configuration**
- **Fallback User**
- **Bind**
- **FTP User**
- **HTTP User**
- **HTTP Permissions**
- **Ad Hoc Users**

**Configuration:**
You must check the **Enable LDAP** box to allow the CMS to use LDAP.

You must enter the **Primary LDAP Server** hostname and port and choose the **Server Encryption**.

The **Server Encryption** types are:

- **None** – No encryption (passwords are sent in clear text) (standard LDAP port is 389).
- **SSL** – The CMS encrypts all communications with the LDAP server using SSL (standard LDAP port is 636).
- **TLS** – The CMS encrypts all communications with the LDAP server using TLS (standard LDAP port is 389).

The Certification Authority (CA) Certificate is required when SSL or TLS encryption is used. The certificate is required to be in PEM format.

**Note:** Microsoft® Active Directory® does not support LDAP over TLS and by default LDAP requires additional configuration of the Active Directory server.

**Fallback User:**
The fallback user can always login to the CMS and perform management tasks, even when LDAP authentication is not working.

Enter the username and password that you wish to use to manage the CMS in the event of problems with the LDAP setup.
**Recommendation:** Use a very strong password for the fallback user password.

**Bind:**
Select **Allow Anonymous Bind** to use anonymous binding to the LDAP server. Otherwise select **Bind using DN** and complete the **Bind Username** and **Bind Password**.

For example, the bind username is a distinguished name (DN) like: `cn=Manager,dc=yourdomain,dc=com`.

**FTP User:**
The information in this section is used to authenticate users and give them permission to gain FTP read/write access to the CMS. You will need to know how to find the user object in the directory that corresponds to the username given to FTP.

For **Scope**, select **Subtree** or **One level** depending on how you want to limit the search for the user object starting from the Base DN.

Enter the **Base DN** in the appropriate format for your implementation.

Set the **Login Username Attribute** to an attribute that will contain the username given to FTP. This is typically as described for the relevant context:
- Active Directory – Typically, the `sAMAccountName` attribute.
- Posix Scheme Directory – Typically, the `uid` attribute.

In the **User Filter** field, enter the LDAP filter that will match a user object in the directory (use `%s` where you wish the filter to contain the username of the user that is logging in).

**Recommendation:** If possible, add checks for group membership to control which users can access FTP on the CMS.

Example user filters for the relevant contexts are:
- **Active Directory** – `{(sAMAccountName=%s)(objectclass=user)(memberOf=CN=CMS ftp access,OU=Security Groups,DC=yourdomain,DC=com)}`
- **Posix Scheme Directory** – `{(uid=%s)(objectclass=posixAccount)}`

**HTTP User:**
The information in this section is used to authenticate users to use the web interface of the CMS. Permissions are set in the next section. You will need to know how to find the user object in the directory that corresponds to the username given to HTTP.

For **Scope**, select **Subtree** or **One level** depending on how you want to limit the search for the user object starting from the Base DN.

Enter the **Base DN** in the appropriate format for your implementation.

Set the **Login Username Attribute** to an attribute that will contain the username given to HTTP. This is typically as described for the relevant context:
- Active Directory – Typically, the `sAMAccountName` attribute.
- Posix Scheme Directory – Typically, the `uid` attribute.
In the **User Filter** field, enter the LDAP filter that will match a user object in the directory (use %s where you wish the filter to contain the username of the user that is logging in). Example user filters for the relevant contexts are:

- **Active Directory** – (objectclass=user)
- **Posix Scheme Directory** – (objectclass=posixAccount)

In the **Display Name Attribute** field, enter an informal name for the user for the CMS to use where required. This is typically as described for the relevant context:

- **Active Directory** – Typically, the displayName or sAMAccountName attribute.
- **Posix Scheme Directory** – Typically, the cn or uid attribute.

**HTTP Permissions:**

After a user has been authenticated to access the CMS web interface through HTTP, the CMS will check the user’s permissions.

For **Scope**, select **Subtree** or **One level** depending on how you want to limit the search for the user object starting from the Base DN.

Enter the **Base DN** in the appropriate format for your implementation.

Enter the **Filter Attribute** appropriate to your context. Example filter attributes for the relevant contexts are:

- **Active Directory** – dn
- **Posix Scheme Directory** – uid

You can set up these permission filters:

<table>
<thead>
<tr>
<th>Filter Type</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor Access Filter</td>
<td>Access to player status and system information only.</td>
</tr>
<tr>
<td>System Settings Filter</td>
<td>Access to the <strong>Setup</strong> menu and <strong>Fonts</strong> page.</td>
</tr>
<tr>
<td>Layout Manager Filter</td>
<td>Access to the <strong>Layouts</strong>, <strong>Schedules</strong>, <strong>Ad hoc Entry Page</strong>, <strong>Newsfeeds</strong>, <strong>Tables</strong>, <strong>Colours</strong>, and <strong>Files &amp; Folders</strong> menus</td>
</tr>
<tr>
<td>Layout Editor Filter</td>
<td>Access to the graphical layout editor.</td>
</tr>
<tr>
<td>Publish Channel Filter</td>
<td>Access to the <strong>Publish Channel</strong> menu.</td>
</tr>
<tr>
<td>XML Control Filter</td>
<td>Access to the XML message interface allowing non-browser based control of the CMS only. (Provides no access to menu options.)</td>
</tr>
</tbody>
</table>

Set those to LDAP filters that match the user's permissions. Use %s where you wish the users username to be written into the filter.

Typically, the filter checks that the user is a member of a group. Example permission filters for the relevant contexts are:

- **Active Directory** – (&(objectClass=group)(member=%s)(distinguishedName=CN=player monitor,OU=Security Groups,DC=yourdomain,DC=uk))
- **Posix Scheme Directory** – (&(objectClass=posixGroup)(memberUid=%s)(cn=monitor))

**Ad Hoc Users:**

Click the button to add an ad hoc user and to set the filters for them as required.
9.2.8 Player Local Information

Use the Player Local Information page to add, delete, or modify data items for customising player behaviour. Examples include the following features:

- Conditional play – Add data that the player checks to determine which playlist items or schedules to play.
- Localise HTML pages – Add data that the player uses to localise output from web pages.
- Configure a weather widget – Specify the current location to customise a weather widget display.

These examples further expand and illustrate how you might use player local information:

- Design general channel content that also allows each player to play specific content. For example, if your company has branches in different countries, you could use player local information to specify each location in ISO format. A weather widget you install checks that value and provides a localised weather forecast.
- Design general channel content but that uses conditional play to control the media and schedule for individual player units. For example, you could create the same channel content for all branches of a chain store but use player local information to control conditional play items in that content. You could play content in each store based on the profile of customers visiting that store (using conditional play for playlist items). You might also display specific opening hours for a store (using conditional play for one or more schedules).
- When you enable reporting, the player includes player local information in its reports to the DSM and you can use this for whatever purpose you wish. For example, you could use player local information for asset tracking purposes by storing the player’s address and asset tracking identifier. If there is a problem, it is easy to determine the location of the player based on DSM reports.

9.2.9 Reporting

Use the Reporting options to configure how your CMS reports status information to the DSM.

**Note:** Some features may depend on installed licenses.

You can configure your CMS to send reports to the DSM using any of HTTP, HTTPS, or VPN. However, if you want your DSM to connect to the CMS over SSH you must use VPN.

Click the tab for the option you require:

- **Reporting Settings** – Enabling and configuring reports.
- **Status** – Checking reporting states and events.

**Reporting Settings:**

To configure reporting, complete the following information then click the [Save Changes] button (you must also reboot the CMS if you change the Reporting or SSH settings):

<table>
<thead>
<tr>
<th><strong>Reporting</strong></th>
<th>Check the button for the reporting option you want:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Status reporting is disabled</strong></td>
<td>The CMS does not send reports.</td>
</tr>
<tr>
<td><strong>Report status to a DSM via HTTP</strong></td>
<td>The CMS sends report using HTTP or HTTPS.</td>
</tr>
<tr>
<td><strong>Report status to a DSM via VPN</strong></td>
<td>The CMS sends report using VPN.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Reporting Interval</strong></th>
<th>Specify how often you want the CMS to send a report. The minimum interval is 5 seconds.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>Report to DSM via HTTP</strong></th>
<th>Select whether the CMS sends reports using HTTP or HTTPS. Enter the name or network address of the DSM in the field (optionally with the required port number appended after a colon).</th>
</tr>
</thead>
</table>
Report to DSM via VPN

Enter the name or network address of the DSM in the field (optionally with the required port number appended after a colon).

Check the Allow SSH access via VPN box to allow the DSM to connect to the CMS over SSH.

Authentication

Enter the username and password for the reporter account on the DSM.

Proxy

Check the Use proxy if configured box if the CMS has to send reports through a proxy. You must have already configured the proxy (see HTTP Proxy for details).

9.2.10 Licensing

Certain features beyond the normal capabilities of the CMS are licensed. This page allows you to view currently installed licenses and features and to add new licenses.

The Licensing tab shows a summary of all installed licenses, while the Status tab shows all currently licensed features.

The Add License tab allows you to add new licenses.

Note: The CMS must be rebooted for newly installed license features to become available.

9.3 Player Setup

Use the Setup > Player options to configure the player RS-232 and interactivity settings.

Select the menu item for the option you require:

- RS-232 Outputs – Configuring and adding RS-232 items.
- Interactivity – Configuring touch screen, RS-232, and remote keypad interaction.

9.3.1 RS-232 Outputs

Use the RS-232 Outputs options to add and manage RS-232 items.

You can use the player RS-232 port, or the RS-232 adapter attached to one of its USB ports, to send RS-232 strings or RS-232 outputs to control an external, RS-232 enabled device. You do this by creating RS-232 items on the CMS.

The RS-232 item consists of one or more of these properties:

- The voltage level for either or both of the RS-232 output lines.
- An RS-232 hexadecimal control string.
- The event causing the player to execute the item.

Click the tab for the option you require:

- Items – Listing the RS-232 items already defined on the CMS.
- Add Item – Adding a new RS-232 item.
- Configuration – Accessing the RS-232 configuration options, including baud rate, data bits, stop bits, and parity.

The player can execute an RS-232 item in a playlist or automatically at one of the following events:

- Screen is muted or unmuted.
- Audio is muted or unmuted.
Part 9: Setup

- A specified layout starts or completes.

You have to specify the condition when you create the item; you cannot change it later.

**Note:** You can only create one RS-232 item for each of the conditions.

The RS-232 items are published as part of the channel and are downloaded to subscriber players. However, the CMS provides an override so you can designate an RS-232 string or configuration to use locally that is different from that defined in the channel's RS-232 item.

**Items:**
For each item, you can take these actions:
- Click the button to delete an item.
- Click the Edit button to review or modify an item's properties. Click the Update button to enable any modifications.

**Note:** If you have enabled Send RS-232 String Action for the item, the CMS also displays the Local Override section. This allows you to enable and define a local RS-232 string for the item separate from the one defined in the channel.

**Add Item:**
To create the RS-232 item, complete the following settings and click the Add button:

<table>
<thead>
<tr>
<th>Name</th>
<th>Enter a name to uniquely identify this RS-232 item.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perform Enabled Actions when</td>
<td>Specify when the player executes the RS-232 item (in a playlist or automatically at the event you specify).</td>
</tr>
<tr>
<td>Send RS-232 String Action</td>
<td>Check the Send RS-232 String Action box to enable the player to send the RS-232 string you specify. Clearing the box disables it.</td>
</tr>
<tr>
<td>RS-232 String (as Hexadecimal)</td>
<td>Enter the RS-232 string you want the player to send (in hexadecimal).</td>
</tr>
<tr>
<td>DTR (Data Terminal Read) Action</td>
<td>Check the Set DTR level box to enable the player to set the DTR line voltage to the option you select. Clearing the box disables it.</td>
</tr>
<tr>
<td>RTS (Ready To Send) Action</td>
<td>Check the Set RTS level box to enable the player to set the RTS line voltage to the option you select. Clearing the box disables it.</td>
</tr>
</tbody>
</table>

**Configuration:**
Configure the player RS-232 transmission to match the settings of the connected RS-232 equipment. To configure RS-232, complete the following settings and click the Save Configuration button:
- **Bits per Second** – Select the baud rate from 110 to 460800.
- **Data Bits** – Select either 7 or 8 data bits.
- **Stop Bits** – Select either 1 or 2 stop bits.
- **Parity** – Select the parity as none, odd, or even.

**Note:** The CMS also displays the Local Override section. This allows you to enable and define a local RS-232 configuration separate from the one defined in the channel.
9.3.2 Interactivity

Use the Interactivity page to program the player to respond to RS-232 inputs.

The player can respond to voltage changes on the following RS-232 inputs:

- Clear To Send (CTS).
- Data Carrier Detect (DCD).
- Data Set Ready (DSR).
- Ring Indicator (RI).

Click the [Edit] button to view and edit the properties for each input required:

- **Enabled** – Indicates the availability of the input for use on the player.
- **Name** – The name to use for this input when referencing it elsewhere.
- **Used By** – Indicates the zones and layouts that use the input.

9.4 Backing Up Your CMS

In case of problems, you should maintain regular backups of the media content files and settings that your CMS uses. See Backup Contents for details of what is backed up.

Use the Setup > Maintenance & Troubleshooting > Backup & Restore page to create, save, and restore backup files. You can save the files in a Local Backup on the CMS itself or create an External Backup to save the files on a USB device attached to the CMS (for example, a USB stick or external disk drive, depending on how much space your backup needs). You can also save a backup to a location on your computer. If needed later, you can restore those files and settings onto this or another CMS.

To create a backup:

1. On the menu bar, click Setup and select Maintenance & Troubleshooting > Backup & Restore.
2. If you want to create an external backup, attach a USB device to the CMS and click the External Backup tab.
3. Click the Create System Backup button. It can take several minutes for the CMS to create the backup.
4. If you want to save the backup to a location on your computer, click the backup filename then follow the prompts on the pop-up screen.
5. If this is an external backup to a USB device, when you have completed the backup process, remove the USB device.

To restore a backup:

1. On the menu bar, click Setup and select Maintenance & Troubleshooting > Backup & Restore.
2. If it is held externally, attach the USB device containing the backup to the CMS and click the External Backup tab. Alternatively, click the Browse button, navigate to its location on your computer, and click the Open button then the button.
3. Click the button next to the backup you want to restore.
4. Wait for the CMS to reboot after the restore process finishes.
5. If the backup was from a USB device, remove the USB stick.
9.5 Software Update

You can access the Software Updates page from the Setup > Maintenance Troubleshooting menu.

Use the Software Update options to check the latest update status and to configure whether the CMS performs updates automatically or not. Please contact your reseller or supplier for more information on available updates.

Note: It is not possible to install an earlier software version than the one currently installed. The currently installed version is shown highlighted.

Click the tab for the option you require:

- **Update Status** – Checking details of the last update, how the CMS checks for updates, and if any new updates are available.
- **Settings** – Configuring or disabling automatic updating.
- **Manual Update** – Performing a manual update from a downloaded file.

Caution: Never turn off the power to the CMS while it is installing an update. It can take 30 minutes to install a large update.

**Update Status:**

The display contains the following information:

<table>
<thead>
<tr>
<th>Last Update Messages</th>
<th>Describes the most recent update.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Indicates whether or not the CMS is allowed to check for updates. If it indicates it is not allowed, this is because you have either selected Turn off automatic update or have set a Download Allowed period that does not include the current time.</td>
</tr>
<tr>
<td>Last Checked for updates</td>
<td>Indicates when the CMS last checked for updates.</td>
</tr>
<tr>
<td>Update File</td>
<td>Indicates if an update is available or not. If one is, this displays details of the file if it has not yet been installed.</td>
</tr>
<tr>
<td>Update Description</td>
<td>A description of what the update listed above provides. (Not displayed if there is no update available.)</td>
</tr>
<tr>
<td>Progress</td>
<td>Contains a progress bar during a download. After a download completes, indicates that an update is ready for installation at the next reboot. (Not displayed if there is no update available.)</td>
</tr>
</tbody>
</table>

**Settings:**

To configure software updating, complete the following options and click the [Save Changes] button:

<table>
<thead>
<tr>
<th>Update Mode</th>
<th>Choose how you want automatic updating to work:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic update download and install updates</td>
<td></td>
</tr>
<tr>
<td>Check for new updates but do not download or install them</td>
<td></td>
</tr>
<tr>
<td>Turn off automatic update</td>
<td></td>
</tr>
</tbody>
</table>

| Reboot Allowed | Only activated if you have chosen Automatically download and install updates. Specify the day and time when the CMS can reboot to install an update. |
**Download Allowed**  
Not activated if you have chosen **Turn off automatic update**. Specify the day and a time slot when the CMS can download an update.

**Update Server URL**  
Not activated if you have chosen **Turn off automatic update**. If different from the default, specify the URL where the CMS checks for updates.

**Check Interval**  
Not activated if you have chosen **Turn off automatic update**. Specify how often the CMS checks for updates (in hours and minutes).

**Authentication**  
Not activated if you have chosen **Turn off automatic update**. If the update server requires authentication, enter the details here.

**Manual Update:**  
The first part of this screen confirms the version of the software currently installed on the CMS.

If you have manually downloaded an update and wish to install it, follow these steps:

1. Click the **Browse** button and navigate to the update file location.
2. Select the file and click the **Open** button.
3. Click the **Upload** button.
4. Follow the on-screen instructions.

**9.6 Reboot System**

You can access the **Reboot** page from the **Setup > Maintenance & Troubleshooting** menu.

Use the **Reboot** page to perform a controlled reboot of the CMS.

**Caution:** You can stop and restart the CMS simply by switching the power off and on. However, following a software update, you must reboot the CMS using this controlled process to ensure the update completes successfully.

Select **Yes** from the drop-down list and click the **Reboot** button.
Part X

Troubleshooting
Part 10: Troubleshooting

Your CMS requires little maintenance.

From time to time, ONELAN Limited may release software updates for your CMS. To make sure you keep your CMS up to date, you can set it to receive and install those updates automatically (see Software Update for more details).

The following topics provide more information about CMS maintenance and problem solving procedures:

- **Backing Up Your CMS** – Creating and restoring a backup of your media files and CMS settings.
- **Reboot System** – Manually rebooting the CMS.
- **Support Snap Shot** – Creating a collection of log and device data for support purposes.
- **Connection Troubleshooter** – Following a sequence of tasks to track down and correct connection problems.

### 10.1 Support Snap Shot

If you have a problem with your CMS, your support representative may ask you to create a **Support Snap Shot**. A support snap shot consists of a detailed collection of CMS logs and device setting data.

You can access the Support Snap Shot page from the Setup > Maintenance & Troubleshooting menu.

Click the Create Support Snap Shot button and follow the on-screen instructions to create the support snap shot, if you are asked to do so.

The Extras tab includes further diagnostic tools that you may be asked to use by the support representative to help diagnose and resolve problems with your CMS.

### 10.2 Connection Troubleshooter

If you are having difficulties connecting to your CMS, work through the tasks in the following table:

<table>
<thead>
<tr>
<th>Task</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>There must be network cables connecting the CMS to your PC.</td>
<td>Use either a network cable connecting your PC to your LAN and one connecting the CMS to the LAN, or a crossover cable connecting your PC directly to the CMS. Make absolutely sure that you are using a crossover cable.</td>
</tr>
<tr>
<td>If you are using a laptop, connect it to mains power.</td>
<td>If your laptop is running on battery power, and the battery is low, the networking circuits may have been shut down. You may need to reboot your laptop and the CMS.</td>
</tr>
<tr>
<td>If you are using a crossover cable, turn off any wireless networking.</td>
<td>Your laptop may have a switch to turn wireless networking on and off. Otherwise, look for an icon on your desktop or in your Control Panel (for Windows PCs).</td>
</tr>
<tr>
<td>If you are using a crossover cable, your PC must not be configured to work through a proxy.</td>
<td>In Internet Explorer, select Tools &gt; Internet Options &gt; Connections. Click the LAN settings button and clear the Use a proxy server for your LAN box. In Firefox, select Tools &gt; Options &gt; Advanced. On the Network tab, click the Settings... button and select No Proxy.</td>
</tr>
</tbody>
</table>

---

**ONELAN Digital Signage**

139
<table>
<thead>
<tr>
<th>Task</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reboot the CMS and the PC.</td>
<td></td>
</tr>
<tr>
<td>During the CMS boot sequence, press the ESC key and look for an OK message (in green) for the eth0 parameter.</td>
<td>If you see a [Fail] message (in red) for the eth0 parameter this usually means that the CMS has found nothing to connect with at the other end of the cable.</td>
</tr>
<tr>
<td>During the CMS boot sequence, press the ESC key and look for the IP address on the screen.</td>
<td>A No Cable message means that the cable is missing or faulty or that there is another device on the network with the same IP address. The address 169.254.1.1 either means that DHCP could not be found or you are using a crossover cable.</td>
</tr>
<tr>
<td>The CMS must have completed its boot sequence.</td>
<td>The screen connected to the CMS should be showing the localhost Login: prompt.</td>
</tr>
<tr>
<td>The green LEDs on all applicable network sockets should be on or flashing.</td>
<td>If applicable, check the green light (if present) is lit on the socket that the network cable plugs into on your PC, on the CMS, and any hubs or routers in the path from the PC to the CMS.</td>
</tr>
<tr>
<td>You should know the IP address of your PC.</td>
<td>To find the IP address of a Windows PC, click Start &gt; Run. Enter cmd and click the OK button. Enter ipconfig and press the Enter key. Your PC displays its IP address.</td>
</tr>
<tr>
<td>Make sure that the IP addresses of the CMS and PC are in the same sub-net.</td>
<td>You may need to consult your network administrator for further advice.</td>
</tr>
<tr>
<td>You should try to ping the CMS from the PC. (Some networks do not allow pings.)</td>
<td>On a Windows PC click Start &gt; Run. Enter cmd and click the OK button. Enter ping followed by a space and then the IP address of the CMS. Press the Enter key. After a few seconds you should see a message that includes the phrase (0% loss). The yellow LED on the network socket of the CMS should flash during the ping.</td>
</tr>
<tr>
<td>You should be able to access the CMS with your browser.</td>
<td>In the address bar of your browser, enter the IP address of the CMS and click the Enter key. When prompted, enter the username and password for the CMS. The home page of the CMS should appear in the browser.</td>
</tr>
<tr>
<td>Make sure your browser is not showing a cached version of the CMS home page.</td>
<td>In Internet Explorer, click File and select Work offline. Also, select Tools &gt; Internet Options and click the Delete… button in the Browsing History panel then press F5.</td>
</tr>
<tr>
<td>If you are using a crossover cable then you should not be prompted to dial up to the Internet.</td>
<td>If you are using Internet Explorer, and you cannot prevent the PC from dialling out for an Internet connection, install the Firefox browser on your PC and use it to access the CMS.</td>
</tr>
<tr>
<td>You should be able to connect to the CMS using FTP.</td>
<td>In Internet Explorer, in the address bar type ftp:// followed by the IP address of the CMS and press the Enter key. When prompted, enter the same username and password.</td>
</tr>
<tr>
<td></td>
<td>In Firefox, in the address bar type ftp:// followed by the username, a colon (:), the password, the at symbol (@), and then the IP address of the CMS. For example, ftp://remote:9999@192.168.1.2. You should see a list of folders, including the Media folder.</td>
</tr>
</tbody>
</table>
Part XI

Technical Reference
Part 11: Technical Reference

This section contains technical reference topics not covered elsewhere:

- Optimising Playback Performance – Enhancing the playback performance of specific media types.
- Backup Contents – Understanding which files and folders the CMS saves in a backup.

11.1 Optimising Playback Performance

You can optimise the playback performance of specific media by taking note of these points:

- The player units have no problem displaying MPEG-2 video at a reasonable rate (up to 10 Mbps). This typically uses less than half of the player processing power.
- You should resize images (especially digital photos) before uploading them onto the CMS. Ideally, resize them so that they match the size of the zone.
- Scrolling text uses relatively little processing power, provided it does not take up more than 30% of the screen area.
- Animations (typically in Flash or HTML with embedded JavaScript) have no upper limit to the processing power they require and can overwhelm the player. If this occurs, the animation will typically run slowly but other zones will continue as normal.

11.2 RS-232 Technical Reference

The pin assignment of the RS-232 9-way D-PLUG is as follows:

<table>
<thead>
<tr>
<th>Pin</th>
<th>Direction</th>
<th>RS-232 Name</th>
<th>Quiescent State</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Input to CMS</td>
<td>DCD</td>
<td>High impedance</td>
</tr>
<tr>
<td>2</td>
<td>Input to CMS</td>
<td>RxD</td>
<td>High impedance</td>
</tr>
<tr>
<td>3</td>
<td>Output from CMS</td>
<td>TxD</td>
<td>-ve voltage level</td>
</tr>
<tr>
<td>4</td>
<td>Output from CMS</td>
<td>DTR</td>
<td>-ve voltage level</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>Sig. GND</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Input to CMS</td>
<td>DSR</td>
<td>High impedance</td>
</tr>
<tr>
<td>7</td>
<td>Output from CMS</td>
<td>RTS</td>
<td>-ve voltage level</td>
</tr>
<tr>
<td>8</td>
<td>Input to CMS</td>
<td>CTS</td>
<td>High impedance</td>
</tr>
<tr>
<td>9</td>
<td>Input to CMS</td>
<td>RI</td>
<td>High impedance</td>
</tr>
</tbody>
</table>

For historical reasons, the RS-232 standard uses a variety of terminology to describe its signal status:

- Lowered = Negated = Logic 1 = -ve voltage = Off = Marking.
- Raised = Asserted = Logic 0 = +ve voltage = On = Spacing.

The CMS uses voltage level in order to describe line status since this is the only explicit identification.
Inputs have:
- Hysteresis (generally of about 0.5 V).
- A threshold level of about +1.5 V.
- An input impedance of about 5000 ohms connected to GND (defaults to a -ve voltage state with nothing attached).
- An acceptable input range of +/-15 V.

Outputs have:
- A voltage swing ranging from +/-5 V to +/-12 V (depends on hardware).
- A source current drive capability of about 15 mA (with output current limiting). This can drive LEDs or provide a voltage for contact closure applications.
11.3 Backup Contents

Back Up Your CMS describes how you create a backup for your CMS. The folders and files included in the backup are:

<table>
<thead>
<tr>
<th>Folders</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>/data/data/ad_hoc_media/</td>
<td>/data/data/config/audio_settings.xml</td>
</tr>
<tr>
<td>/data/data/channel/</td>
<td>/data/data/config/http_proxy_settings.xml</td>
</tr>
<tr>
<td>/data/data/config/ad_hoc/</td>
<td>/data/data/config/local_information.xml</td>
</tr>
<tr>
<td>/data/data/config/channel/</td>
<td>/data/data/config/player_settings.xml</td>
</tr>
<tr>
<td>/data/data/control/</td>
<td>/data/data/config/remote_setup_settings.xml</td>
</tr>
<tr>
<td>/data/data/fonts/</td>
<td>/data/data/config/schedule_log_rotate.xml</td>
</tr>
<tr>
<td>/data/data/media/</td>
<td>/data/data/config/screen_settings.xml</td>
</tr>
<tr>
<td>/data/data/package/</td>
<td>/data/data/config/software_update_settings.xml</td>
</tr>
<tr>
<td>/etc/onelan/cms/layout_permissions/</td>
<td>/data/data/config/streaming_video_settings.xml</td>
</tr>
<tr>
<td></td>
<td>/data/data/config/tv_controller_digital_tuner_stations.xml</td>
</tr>
<tr>
<td></td>
<td>/data/data/config/tv_settings.xml</td>
</tr>
<tr>
<td></td>
<td>/etc/onelan/common/user_passwords.xml</td>
</tr>
<tr>
<td></td>
<td>/etc/onelan/common/users.xml</td>
</tr>
<tr>
<td></td>
<td>/etc/onelan/cms/custom_ssl_ca_certificate.crt</td>
</tr>
<tr>
<td></td>
<td>/etc/onelan/cms/custom_ssl_ca_certificate.key</td>
</tr>
<tr>
<td></td>
<td>/etc/onelan/cms/custom_ssl_ca_chain_certificate.crt</td>
</tr>
<tr>
<td></td>
<td>/etc/onelan/cms/date-and-time-settings.xml</td>
</tr>
<tr>
<td></td>
<td>/etc/onelan/cms/dsm_reporting_password.xml</td>
</tr>
<tr>
<td></td>
<td>/etc/onelan/cms/dsm_reporting_settings.xml</td>
</tr>
<tr>
<td></td>
<td>/etc/onelan/cms/ldap_passwords.xml</td>
</tr>
<tr>
<td></td>
<td>/etc/onelan/cms/ldap_passwords_pending.xml</td>
</tr>
<tr>
<td></td>
<td>/etc/onelan/cms/ldap_settings.xml</td>
</tr>
<tr>
<td></td>
<td>/etc/onelan/cms/ldap_settings_pending.xml</td>
</tr>
<tr>
<td></td>
<td>/etc/onelan/cms/security_settings.xml</td>
</tr>
</tbody>
</table>
## Part 12: Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ad Hoc</td>
<td>An override to a display schedule, often managed locally by ad hoc users, which is restricted to a specific zone and/or content type. Ad hoc users control ad hoc content or ad hoc items, which are kept in ad hoc media folders, and displayed on ad hoc pages.</td>
</tr>
<tr>
<td>Ad hoc from centre</td>
<td>An ad hoc schedule override which is managed and sent by a remote publisher player to one or more specific subscriber players.</td>
</tr>
<tr>
<td>Advance To</td>
<td>A command in a playlist that causes the player to start displaying from a specific place in this or another playlist. A matching rendezvous point indicates the place in the other playlist</td>
</tr>
<tr>
<td>Canvas</td>
<td>The display space in which the player renders layouts.</td>
</tr>
<tr>
<td>Channel</td>
<td>A source of display content used by subscribers. Also refers to the content it contains.</td>
</tr>
<tr>
<td>Channel Content Server</td>
<td>A server storing and publishing channel content to offload processing overhead from the publisher.</td>
</tr>
<tr>
<td>Channel name</td>
<td>Identifies the channel.</td>
</tr>
<tr>
<td>Conditional play</td>
<td>A means of controlling whether content is played or not depending on the values set in the player local information.</td>
</tr>
<tr>
<td>Content</td>
<td>An item of digital media or text that is displayed in a zone as part of a playlist.</td>
</tr>
<tr>
<td>Digital signage</td>
<td>Electronic display that may show a combination of any or all of text, graphics, and still and moving images.</td>
</tr>
<tr>
<td>Digital Signage Network</td>
<td>A set of systems connected together to provide integrated management of numerous display screens.</td>
</tr>
<tr>
<td>Display</td>
<td>The overall content being shown on the screen, rather than its layout or zone configuration.</td>
</tr>
<tr>
<td>Donate</td>
<td>The process of applying a player’s configuration to a folder that the Digital Signage Manager then uses to configure other players.</td>
</tr>
<tr>
<td>Event</td>
<td>An interactive input that causes a change in the display.</td>
</tr>
<tr>
<td>Folder play</td>
<td>The ability to add an entire folder of items to a playlist and have them play in sequence.</td>
</tr>
<tr>
<td>Graphical layout editor</td>
<td>The interactive editor for creating and modifying layouts using zones.</td>
</tr>
<tr>
<td>Interactivity</td>
<td>The player can run predetermined fixed schedules in the different zones within a layout. However content can also be dictated by external stimuli such as floor pressure pads, the incorporation of a touch screen display, or changing content using a remote keypad.</td>
</tr>
<tr>
<td>IPTV (Internet Protocol Television)</td>
<td>The delivery of television services over the Internet (as opposed to traditional broadcast technology, satellite, or cable reception).</td>
</tr>
<tr>
<td>Layout</td>
<td>The combination of a background image and one or more display areas (zones) and that can be shown simultaneously on a screen.</td>
</tr>
<tr>
<td>Term</td>
<td>Meaning</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Layout icons view</strong></td>
<td>Abstract display of a layout showing only the distribution and size of its zones. The colour of each zone indicates the media it is enabled to play.</td>
</tr>
<tr>
<td><strong>Layout package</strong></td>
<td>The media and settings for a layout bundled in a ZIP file for distribution to other players.</td>
</tr>
<tr>
<td><strong>Manager</strong></td>
<td>A component of the ONELAN Digital Signage Platform. Manager is the generic term for the appliance that manages the digital signage network. Specifically, the manager is the ONELAN Digital Signage Manager.</td>
</tr>
<tr>
<td><strong>Media</strong></td>
<td>General term for the content the player displays (such as text, images, video, and newsfeeds).</td>
</tr>
<tr>
<td><strong>Media audit</strong></td>
<td>Reports indicating which media items played on the player, when, and for how long.</td>
</tr>
<tr>
<td><strong>Media folder</strong></td>
<td>Designated area on the CMS disk holding media items for adding to playlists.</td>
</tr>
<tr>
<td><strong>Media player</strong></td>
<td>A feature that provides a zone with the ability to 'play' different types of media. You can enable a zone with players for movie, HTML, text, and image media, either singly or in combination.</td>
</tr>
<tr>
<td><strong>Menu bar</strong></td>
<td>Appearing on all of the user interface pages, the menu bar provides access to the various CMS configuration and design options (such as Media or Playlists).</td>
</tr>
<tr>
<td><strong>Multichannel publishing</strong></td>
<td>A CMS configured with more than one channel.</td>
</tr>
<tr>
<td><strong>Override</strong></td>
<td>Users can override or interrupt a schedule when necessary, for example to display special instructions in the event of an emergency, or to show a special event from a TV broadcast feed.</td>
</tr>
<tr>
<td><strong>Page</strong></td>
<td>The CMS interface is made up of different pages, accessed through the menu bar. Ad hoc users have their own dedicated pages for their limited-level access.</td>
</tr>
<tr>
<td><strong>Player</strong></td>
<td>A component of the ONELAN Digital Signage Platform. Player is the generic term for the appliance that runs the screen. Specifically, the player is the ONELAN Net-Top-Box.</td>
</tr>
<tr>
<td><strong>Player local information</strong></td>
<td>Data entered on an player used to alter what is displayed according to conditions often tied to a locality.</td>
</tr>
<tr>
<td><strong>Playlist</strong></td>
<td>A series of digital media content items displayed in a zone.</td>
</tr>
<tr>
<td><strong>Properties, item</strong></td>
<td>Refers to the specific characteristics of a display item such as the font and type size of text, the format of images, or the duration of an item in a playlist.</td>
</tr>
<tr>
<td><strong>Publish</strong></td>
<td>To distribute channel schedules to multiple subscriber players for display on their associated screens.</td>
</tr>
<tr>
<td><strong>Publisher</strong></td>
<td>A device that provides content to players through channels. Specifically, the publisher is the ONELAN Content Management System.</td>
</tr>
<tr>
<td><strong>Remote keypad</strong></td>
<td>A programmable hand-held device for local control of displays, this can be used to switch between layouts, choose TV or radio stations, and adjust volume level.</td>
</tr>
<tr>
<td><strong>Remote setup</strong></td>
<td>A feature allowing a player's configuration to be applied to other players by the Digital Signage Manager through a folder.</td>
</tr>
<tr>
<td>Term</td>
<td>Meaning</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Rendezvous Point</td>
<td>This may be added to a playlist as part of an <strong>Advance To</strong> command or may be used in multiple playlists to ensure synchronisation between them.</td>
</tr>
<tr>
<td>Role</td>
<td>Describes the function of a player: one of standalone, subscriber, or publisher.</td>
</tr>
<tr>
<td>Schedule</td>
<td>A plan or timetable for displaying layouts at specific times.</td>
</tr>
<tr>
<td>Schedule entry</td>
<td>An individual action added to the player schedule.</td>
</tr>
<tr>
<td>Screen snapshot</td>
<td>A picture of what the player is currently displaying.</td>
</tr>
<tr>
<td>Standalone</td>
<td>A player that is neither a subscriber or publisher.</td>
</tr>
<tr>
<td>Streaming video</td>
<td>Video which is delivered to the end user 'live' (that is, direct from the video provider).</td>
</tr>
<tr>
<td>Subscribe</td>
<td>Players that show a schedule from a publisher subscribe to that device.</td>
</tr>
<tr>
<td>Subscriber</td>
<td>A player that accepts a channel from a publisher.</td>
</tr>
<tr>
<td>Support snapshot</td>
<td>A collection of detailed logging information used for support and problem solving purposes.</td>
</tr>
<tr>
<td>User Interface policy</td>
<td>The level of features exhibited in the menu bar and in other options (can be productive, detailed, or expert).</td>
</tr>
<tr>
<td>Zone</td>
<td>A single display area in a layout.</td>
</tr>
</tbody>
</table>
Index

A
Action buttons 18
Ad hoc 79
adding layout items automatically 29
Advance To 84, 91
and LDAP 129
and remote control 82
and security 80
and showing video-on-demand 70
automatic 80
channel content 102
content 14
controlling display 82
controlling TV or radio 83
creating as you design 80
creating pages 87
creating users upload folder 89
customisation 83
customisation scope 86
default text 86
deleting page 87
disabling layout page 87
environment 79
folder play 83
how to set up Advance To 84
how to set up schedule override 84
item types 86
layout 83
local control 79
manual 80
media 62
media folder 90
newsfeeds 90
on publisher 85
radio stations 90
schedule 83, 91
scope of update from centre 85
screen layouts 91
subscriber account 86
text and tables 90
TV stations 90
user feedback message 86
users 80
Advance To 63
and ad hoc 91
and playlists 63
and RS-232 75
and synchronisation playlists 69

comparison with Change Layout command 64
Animations and optimising display 143
Approving publishing 102
Audio 46
click on touch 75
icon 28
playing on touch 75
Authentication 124
digest 15
form-based 15, 124
HTTP 124

B
Background image 76
Backup 133
creating 133
on USB device 133
restoring 133
what is included 145
Bandwidth 124
limiting 124
per port 124

C
Change Layout 74
adding 64
and RS-232 75
comparison with Advance To command 64
Channel 12
add 107
basic steps to use 101
managing 107
parts of 101
publish 101
publishing methods 110
storage space required 101
Colour 64
adding 65
background 76
defining 64
deleting 64
modifying 64
naming format 64
opacity 65
Command buttons 19
Conditional play 24
and player local information 130
status 114
Conflicts during layout package installation 96
Crop 76
HTML 76
movie 76
Customisation scope and ad hoc 86

D
Display change method tradeoffs 74

E
Ethernet 121

F
File & Folders tab 42
File management 41
Firewall 124
    settings 124
    status 125
Folder play 34
    creating complex sequences 60
    defined 48
Font adding 65
Form-based authentication 124
    switching to 15
FTP 42
    uploading files 43
    using to copy a layout package 96

G
GPIO and RS-232 74
Graphical layout editor 29

H
Help 15
Home page features 15
HTML page 47
    and interactivity 72
    passing touch events to 73
HTTP 130
    and reporting 130
    digest authentication 15
HTTPS and reporting 130

I
Images and optimising display 143
Interactivity 29, 74
    actions 72
    and storyboards 74
    and zone displaying HTML 72
    click on touch 75
    configuring layout 73
configuring playlist 72
    events 71
how the player processes 73
playing audio 75
remote keypad 73
RS-232 73
touch screen 73, 75
touch screen icon 28
IPTV 50

L
Layout 27
    action buttons 28
    adding a soundtrack 29
    adding ad hoc items automatically 29
    colour naming 64
    configuring interactivity 73
    creating package 95
    defined 13
    delete package 95
display 28, 30
    filtering those displayed 28
    installing package 95
    interaction with playlist 72
    managing packages 95
    saving changes 31
    zones 30
Layout package 95
    copying using FTP 96
    distribution methods 95
LDAP 124
    adding ad hoc user 129
    binding 128
    configuring FTP user 128
    configuring HTTP permissions 129
    configuring HTTP user 128
    fallback user 127
    security model 127
    setting up 126
testing setup 126
Localising HTML pages and PLI 130
Logon and form-based authentication 124

M
Master password 124
Media 37
    ad hoc 62
    Adobe Flash 48
    audio 37, 46
    backup and restore 133
clocks 39
common properties 60
entering text 37
external web pages 50
fonts 65
HTML web pages 47
images 45
live video 50
multicast video 50
newsfeeds 38
on player disk 41
overview 37
players 37
players described 30
presentations 46
properties listed and mapped 52
QR Codes 41
radio 49
setting up user's folder 119
soundtrack 37
tab 52
tables 39
text 37, 45
uploading file with drag and drop 44
uploading files 43
uploading files with FTP 43
video 44
Media folder and ad hoc 89
Movie 44
crop 76
formats 76
size 76
MPEG and optimising display 143
Multicast TV 122

N
Network 121
status 121
tests 121
Newsfeed 38
and ad hoc 90
setting up proxy server 123
subscribing to 38

O
OpenType font 65

P
Player accessing by name 15
Player local information 130
and conditional play 130
and localising HTML pages 130
and weather widget 130
eamples 130
Playlist 32
action buttons 33
adding Advance To command 63
adding Change Layout command 64
adding external web pages 51
adding rendezvous point 63
adding RS-232 41
and Advance To 63
and rendezvous point 63
and RS-232 131
configuring touch actions 72
creating a sub-playlist loop 71
defined 14
examples of synchronising 69
interaction with layout 72
master 69
slave 69
synchronising 69
Port bandwidth limiting 124
PowerPoint and save as formats 47
Properties 52
advanced 52
generic 52
listed and mapped 52
Proxy server 123
Publish 101
approval process 102
approve 103
automatic 102
manual 102
mode 102
policy 102
to a channel 101
when and how 102
Publisher 102
network and bandwidth considerations 110
publishing methods 110

R
Radio 49
and soundtrack 49
configuring 121
Remote keypad 71
and interactivity 73
controls 82
Rendezvous point 63
and playlists 63
and synchronising playlists 69
Reporting 130
HTTP, HTTPS and VPN compared 130
setting up 130
setting up proxy server 123
RS-232 75
adding to playlist 41
and Advance To 75
and Change Layout 75
and hexadecimal code 75
and interactivity 73
control line inputs and outputs 75
creating item 131
GPIO 74
in playlist 131
sending and receiving 75
uses of 131

S
Schedule 23
action buttons 23
and ad hoc 91
creating 23
default entry 23
defined 13
entry 23
example 23, 25
listing all 23
override 23
Screen colour 76
Screen layouts and ad hoc 91
Security 123
and ad hoc users 79, 129
and configuration 14
and passwords 14
configuring LDAP 127
configuring LDAP FTP user 128
configuring LDAP HTTP permissions 129
configuring LDAP HTTP user 128
defaults 123
firewall 124
firewall status 125
LDAP 126
LDAP binding 128
LDAP fallback user 127
LDAP model 127
master password 125
SSL certificates 126
testing LDAP setup 126
VPN, HTTP, HTTPS, FTP, and SSH
described 123
Software 134
updating automatically 134

T
Tabbed pages 18
Tables 39
and ad hoc 90
and colour items 64
Terminology 13
Test 121
LDAP 126
network 121
Text and ad hoc 90
Time and date formats 117
Time zone 120
Touch screen 75
and interactivity 73
icon 28
TrueType font 65
TV 121
and ad hoc 90
configuring 121
multicast 122
setting up streaming 122

U
Uploading files 33
and drag and drop 44
and FTP 43
and the Uploading Files tab 43
User interface 16
action buttons 18
changing appearance 117
changing display modes 117
command buttons 19
features 16
tabbed pages 18
time and date 117
Users 118
setting up and modifying accounts 118
setting up media folder 119

V
Video 44
on demand using ad hoc 70
storage space required 101
VPN and reporting 130

W
Weather widget and PLI 130
Web page size 76

Z
Zones 29
action buttons 31
buttons on tab 31
captioning 69
defined 14
in layout 30
listing 31
master playlist 69
media players 30
moving properties dialog 32
players for 37
saving changes 31
slave playlist 69
synchronising 69